COMPUTER METHODS IN CONSTRUCTION

Christoph Motzko
Florian Binder
Matthias Bergmann
Bogdan Zieliński
Mariusz Zabielski
Robert Gajewski

Darmstadt, Warsaw 2011

"This project has been funded with support from the European Commission under the Lifelong Learning Programme. This publication reflects the views only of the author, and the Commission cannot be held responsible for any use which may be made of the information contained therein."
These manuals were developed within the scope of the LdV program, project number: 2009-1-PL1-LEO05-05016 entitled “Common Learning Outcomes for European Managers in Construction” ("Model of certification and mutual recognition of qualifications of construction managers and engineers - development of manuals for post-graduate and supplementary studies"), Stage II. The project was promoted by the Department of Construction Engineering and Management, Faculty of Civil Engineering at the Warsaw University of Technology. Partners of the project were:
- Technische Universität Darmstadt (Germany)
- Universidade do Minho (Portugal)
- Chartered Institute of Building (Great Britain)
- Association of European Building Surveyors and Construction Experts (Belgium)
- Polish British Construction Partnership (Poland)

Within this part of the project the following manuals were developed:
M8: Risk Management (130)
M9: Process Management – Lean Construction (90)
M10: Computer Methods in Construction (80)
M11: PPP Projects in Construction (80)
M12: Value Management in Construction (130)
M13: Construction Projects – Good Practice (80)

The scope of knowledge presented in the manuals is necessary in activities of managers - construction engineers, managing undertakings in conditions of modern market economy. The manuals are approved by the European AEEBC association as a basis for recognizing manager qualifications. Modern knowledge in the field of management in construction, presented in the manuals, is one of prerequisites to obtain EurBE (European Building Expert) cards, a professional certificate documenting the qualification level of a construction manager in EU. The manuals are designated for managers - construction engineers, students completing postgraduate studies “Management in construction” and students completing construction studies. Postgraduate studies are a recognized program, and graduates receive certificates recognized by 17 national organizations, members of AEEBC.

The manuals were translated by Lingua Nova translation office.

More information:
www.leonardo.il.pw.edu.pl
www.psmb.pl
www.aeebc.org
# TABLE OF CONTENTS:

## CHAPTER 1
**INTRODUCTION – LEARNING OUTCOMES** ................................................................. 7
(C. MOTZKO, F. BINDER)

## CHAPTER 2
**APPLICATION OF COMPUTER TECHNIQUES IN THE CONSTRUCTION INDUSTRY** ................................................................. 13
(F. BINDER, M. ZABIELSKI)

- 2.1 DESIGN PHASE ................................................................................................... 13
- 2.2 TENDER PHASE .................................................................................................. 16
- 2.3 CONSTRUCTION PROJECT MANAGEMENT PHASE........................................... 18
- 2.4 APPLICATION OF IT SYSTEMS IN REAL-ESTATE MANAGEMENT .................. 21

## CHAPTER 3
**COMPUTER AIDED CONSTRUCTION DESIGN** ......................................................... 23
(C. MOTZKO, F. BINDER)

- 3.1 APPLICATION OF ARCHITECTURAL SOFTWARE TOOLS .................................. 23
- 3.2 DATA FORMATS OF ARCHITECTURAL SOFTWARE TOOLS............................... 24
- 3.3 REQUIREMENTS FOR ARCHITECTURAL SOFTWARE TOOLS............................. 25
- 3.4 SELECTION OF ARCHITECTURAL SOFTWARE TOOLS ..................................... 26
- 3.5 APPLICATION EXAMPLE OF ARCHITECTURAL SOFTWARE TOOLS .................. 28

## CHAPTER 4
**COMPUTER AIDED ENGINEERING TOOLS** ......................................................... 30
(R. GAJEWSKI)

- 4.1 MODES OF REASONING .................................................................................... 30
- 4.2 CLASSICAL ENGINEERING TASKS .................................................................... 31
- 4.3 INFORMATION IN CONSTRUCTION .................................................................... 33
- 4.4 MODELLING AND SIMULATION ....................................................................... 35
- 4.5 MODELLING OF THE STRUCTURE .................................................................... 37
- 4.6 EXAMPLES OF PROGRAMMES FOR STRUCTURAL ANALYSIS .......................... 39
- 4.7 THE BASIS FOR OPTIMISATION ...................................................................... 40
- 4.8 BASIC OPTIMISATION PROBLEMS ................................................................... 43
- 4.8.1 Linear programming issues ............................................................................. 43
4.8.2 The issues of non-linear programming ........................................ 43
4.9 PROGRAMMES FOR STRUCTURE OPTIMISATION ...................... 45

CHAPTER 5
COMPUTER AIDED TENDERING .................................................... 46
(F. BINDER)
5.1 THE APPLICATION OF TENDER SOFTWARE .......................... 46
5.2 DATA EXCHANGE FOR TENDER SOFTWARE TOOLS ........... 47
5.3 REQUIREMENTS FOR TENDER SOFTWARE TOOLS ............ 50
5.4 SELECTION OF TOOLS ......................................................... 51
5.5 APPLICATION EXAMPLE OF TENDER SOFTWARE TOOLS .... 53

CHAPTER 6
COMPUTER AIDED CONSTRUCTION PROJECT MANAGEMENT .... 59
(B. ZIELINSKI)
6.1 INTRODUCTION. INFORMATION ON EPM (ENTERPRISE PROJECT MANAGEMENT) ................................................................. 59
6.2 MICROSOFT PROJECT 2007 ..................................................... 64
6.2.1 Creation of a new project ..................................................... 64
6.2.2 Creation and editing of the schedule ..................................... 66
6.2.3 Resources – creation, allocation, identification, and removal of excessive allocation ......................................................... 71
6.2.4 Resource costs ............................................................... 79
6.2.5 Final project planning step .................................................. 81
6.2.6 Project implementation tracking ......................................... 81
6.3 PRIMAVERA CONTRACTOR ................................................... 84
6.3.1 Starting work with the programme ........................................ 84
6.3.2 Defining calendars ......................................................... 85
6.3.3 Adding activities ........................................................... 86
6.3.4 Tracking of implementation .............................................. 91
6.3.5 Working with resources .................................................. 92
6.3.6 Allocation of resources and costs ...................................... 92
6.3.7 Tracking of implementation of the schedule with allocated resources ................................................................. 93
6.4 EXAMPLE (CASE STUDY) ..................................................... 94
6.5 SELECTED COMPONENTS OF PROJECT PRESENTATION ... 100
6.5.1 Microsoft project ............................................................ 100
6.5.2 Primavera contractor ....................................................... 108
CHAPTER 7
APPLICATION OF IT SYSTEMS IN REAL ESTATE MANAGEMENT ................................................................. 113
(M. ZABIELSKI)

7.1 INTEGRATED IT SYSTEMS ................................................................. 114
7.1.1 The main database ...................................................................... 115
7.1.2 The modules .............................................................................. 117

7.2 THE APPLICATION OF IT SYSTEMS ...................................... 124
7.2.1 Housing property ...................................................................... 124
7.2.2 Commercial property .................................................................. 125
7.2.3 Public utility buildings ................................................................. 127

7.3 CONCLUSIONS ........................................................................... 128

CHAPTER 8
INNOVATION AND NEW DEVELOPMENTS IN CONSTRUCTION PROJECT MANAGEMENT ................................................................. 130
(C. MOTZKO, F. BINDER, M. BERGMANN)

8.1 SENSOR-AIDED CONSTRUCTION CONTROLLING ............. 130
8.1.1 Prompt target-performance comparisons .................................... 130
8.1.2 Difficulties of data collection ...................................................... 131
8.1.3 Application of sensors ................................................................. 132
8.1.4 Challenges .................................................................................. 132
8.1.5 Controlling data .......................................................................... 133
8.1.6 Types of sensors for construction controlling ............................ 134
8.1.7 Prospects ..................................................................................... 136

8.2 SIMULATION IN CONSTRUCTION MANAGEMENT ................ 136
8.2.1 Advantages and fields of application in the construction industry ................................................................. 136
8.2.2 Simulation techniques for construction sequences .................. 137
8.2.3 Obstacles to the application of simulation in the construction industry ................................................................. 140
8.2.4 A workflow model for simulation in construction management ................................................................. 140

8.3 DIGITAL DOCUMENTATION OF CONSTRUCTION PROJECTS ................................................................. 142
8.3.1 Processing of construction information ....................................... 142
8.3.2 Aspects of the documentation of construction process information ........................................................................ 142
8.3.3 Software tools for documentation ................................................. 144
8.3.4 Range of a digital documentation ................................................. 144
8.3.5 Principal requirements of digital documentation .......................... 147
8.3.6 Technologies for documentation software .................................... 148
8.3.7 Prospects ................................................................................................. 149
8.4 PROJECT PLATFORMS ............................................................................ 150
  8.4.1 Construction project organisation ....................................................... 150
  8.4.2 Organisational aspects ....................................................................... 151
  8.4.3 Support of computer systems ............................................................... 152
  8.4.4 Functions of a project platform ............................................................ 154
  8.4.5 Requirements for a project platform ..................................................... 155
  8.4.6 Prospects ............................................................................................... 156

CHAPTER 9
BIM ................................................................................................................... 157
(F. BINDER)
  9.1 BIM TECHNOLOGY .................................................................................. 157
    9.1.1 Principles of bim ................................................................................ 157
    9.1.2 Benefits of bim .................................................................................. 158
    9.1.3 Working with bim ............................................................................ 160
    9.1.4 Trends of bim .................................................................................... 162
  9.2 BIM CAD TOOLS ..................................................................................... 163
    9.2.1 Description of bim cad tools ............................................................... 163
    9.2.2 Selection of bim cad tools ................................................................. 163

CHAPTER 10
LITERATURE ..................................................................................................... 167
CHAPTER 1

INTRODUCTION – LEARNING OUTCOMES

(C. MOTZKO, F. BINDER)

Computer methods have their roots – certainly also among other disciplines – in the construction sector. Civil engineer Konrad Zuse is considered to be one of the major pioneers in computer technologies. In 1941 it was him who developed the world’s first functional programme-controlled Turing-complete computer, the Z3. Searching for assistance with his structural calculations, he had already considered machines for automated calculations during his civil engineering studies and later formulated the necessary computer mathematics in the binary system.

The use of computer methods has fundamentally changed many processes in the construction industry. Today’s technologies for data processing, data storage and data transfer support the design, realisation and operation of buildings in various ways. In doing so, the wide range of software tools in the construction sector is hard to overlook. The application depends on the building’s life-cycle phase, the role of the parties and the processes involved.
Concerning the use of software tools during the building’s life-cycle phases, a project phase and an object phase can be distinguished (Figure 1.1.). The project is a time-limited, complex undertaking, which is characterised for the most part by the uniqueness of the conditions, such as objectives, schedule, organisation, complexity and risk. The project phase includes development, design and realisation. With the completion of the building the project phase ends and the object phase starts. An object in the construction sector is particularly characterised by its stationary location. It has to be operated, modified and ultimately demolished. Throughout the life-cycle of a building, computer methods are needed to support the tasks related to each phase.
Fig. 1.2. Project Members

The relevance of the parties involved for the application of computer systems in construction is particularly apparent in the project phase. A construction project, being a highly complex task which is based on the division of labour, comprises a multiplicity of processes to be performed in different phases and by a range of project team members (Figure 1.2.). Computer systems in construction therefore not only have to calculate the data needed for specific processes, they also have to help to communicate this data to the project members. The number of project participants, as well as their organisational structure in the project, depends largely on the types of contract the project has. All persons involved in the project will take up different roles according to their field of expertise and their standing (e.g. owner, architect, project manager, contractors, public authorities, suppliers, etc.). So project members belong to different organisations and have different points of view on the project. This unique structure of a construction project poses serious challenges for the application of corresponding software systems.
The harmonisation of the individual applications is necessary, if the use of the system in the context of the project as a whole is to be effective. The computer systems of each project partner must principally be able to process, store and transfer data specific for their role in the project, but also ensure communication with changing project partners and their systems.

The kind of data produced by the software systems is mostly defined by the processes, which are performed by the project members in the construction project (→ Manual M9 Process Management – Lean Construction). Processes can be seen as a holistic, logical and time-dependent sequence of activities for the execution of a project. Each activity needs specific input data and returns specific output data after processing. Interfaces between the single activities need to be clearly defined and must not require ineffective procedures of data transformation. However, the variety of processes related to a construction project makes a complete coordination of the software systems completely impossible. Figure 1.3. shows the processes of a construction company – as one of the project members would view it. Even within this organisation the interface problems between software systems related to specific process become obvious.

![Figure 1.3. Processes in a Construction Company](image)


As a result of the influences of the different life-cycle phases, the different types of users and the different processes, the variety of data created within the construction sector is enormous.
A rough overview can be given using the example of planning and building an office block. The project developer uses spreadsheet software to calculate the financial aspects of the project, uses desktop publishing software to communicate the project to acquiring or renting parties, uses CAD and GIS systems to visualise the project’s location and his ideas. Subsequently, engineers and architects create – in several levels of detail – all the information concerning structure and fit out of the building as well as management plans for its construction. In this phase, project members work with software, such as specific CAD tools (building site facilities, structural shell, reinforcement, formwork, heating, ventilation, air conditioning, electrical works…), various programmes for structural and physical calculations and software for the planning of schedule, cost and construction methods (Figure 1.4).

Fig. 1.4. Different Planning Focus

Systems for communication within the project are also needed. During and after the design process, permission has to be obtained from the authorities, who again work with different software systems in most cases. For tendering; all information from previous phases is entered into further systems, which support the cost estimation and invoicing process. Later, when the construction of the buildings starts, various controlling tools are needed to keep track of cost and schedule. Each project partner will thereby have another focus, so each project partner will use different data and usually also different software for the controlling processes. In a final step, all relevant information about the building is documented for future use (e.g. revitalisation) and facility management systems for the operation of the office building are set up.
This variety of data created over the course of a building’s life-cycle shows that standardised data formats for the exchange of information are needed in the construction sector. A promising approach is constituted by software which supports BIM (Building Information Modelling) formats. With BIM data formats, all data from the design and realisation phase is stored in a database related to a geometric model. All project members can access and use this data for their own specific demands and over the whole life-cycle of a building.

Learning Outcomes:

M 10 “Computer Methods in Construction” will outline computer methods for several life-cycle phases, several types of users and for several processes. In the course of this overview, the manual also focuses on new developments in computer methods for construction. Finally the BIM approach – as one of the future core areas of computer methods in construction – is discussed in greater detail.

The following learning outcomes can be achieved by referring to the following chapters:

- **Chapter 2** provides a brief overview of computer methods in construction according to specific phases in the life-cycle of a building.
  - Basic understanding of computer methods within the construction process.
- **Chapters 3 - 7** outline the aforementioned computer methods in detail. Requirements, aims, instruments and examples are given for specific tasks of computer methods in construction.
  - Basic understanding of common construction software types.
- **Chapter 8** reveals new developments for computer methods in construction. Future applications in the fields of simulation, controlling, documentation and communication are demonstrated.
  - Basic understanding of future possibilities for computer methods in construction.
- **Chapter 9** explains the system and use of Building Information Modelling. BIM is described in theory and in practice by example tools.
  - Basic understanding of BIM technology

The most important aspects of the application of computer systems in construction are pointed out within these nine chapters. However, this manual does not aim to provide a full description of all possible applications or detailed instructions for specific tools. Readers interested in these aspects should read specific literature about the various software systems.
CHAPTER 2

APPLICATION OF COMPUTER TECHNIQUES IN THE CONSTRUCTION INDUSTRY

(F. BINDER, M. ZABIELSKI)

2.1 DESIGN PHASE

Today, the process of designing buildings is dominated by computer methods. Software tools for this phase can automate repetitive calculation and drawing tasks, find new design solutions and simultaneously provide a high degree of precision. This optimisation makes the design process faster, clearer and more effective.

The starting point for computer methods in construction was structural calculations (see introduction) and, soon after, drawing facilities and geographic information systems followed. The beginnings of Computer Aided Design (CAD) lie in the aircraft industry in the 1960s. In the 1980s, these systems also made their break-through in architecture. Specialised Computer Aided Architectural Design (CAAD) software programmes started to improve the drawing process in 2D. In the 1990s, tools which provided the possibility of 3D drawing were invented and subsequently, object-oriented design systems were developed. Various sectoral planning – also the structural design – became increasingly involved in comprehensive design tools. Today these tools can create, simulate and analyse construction alternatives options for different purposes.
Design data produced by specific software tools is used throughout the life-cycle of a building – from project development through to revitalisation – and, in addition to architects and engineers, it is also used by various project members, such as the owner, the authorities and constructors. Essential input for the design phase is provided by location-related data, which is processed by GIS tools (Figure 2.1). Design ideas and the requirements of the future use of the building affect the design process which is undergone with the use of computer aided architecture tools (CAAD). At the same time calculation and simulation tools are also influenced by normative and physical constraints. Consequently, a strong interdependence between CAAD and the calculation tools exists. After processing, the design data – consisting of construction drawings and proofs – is mainly needed for authorisation, approval, visualisation and construction. This demonstrates that both data production and data communication have an enormous significance in the design phase.

There is a broad choice of products for the design phase. Starting with simple sketch tools, there is a progression to sophisticated building information modelling software. We can, therefore, designate the most important types of software tools in the design phase as follows:

- Geographical Information Systems (GIS):

  GIS systems support the design process through the preparation of information about site and geography. Collected data can be summarised and is available for the designers in real-time. Direct interfaces of the applied GIS systems ensure that access to this database is given to the corresponding design tools.
• Computer Aided Architectural Design (CAAD):
Design documents are created by CAD tools in 2D, 2½D and 3D. 2D and 2½D designs can be used for standard building designs. 3D-Software is needed for polyaxial curvatures, varying curves and dynamic structures. Drawing elements are vector-based such as points, lines, poly-lines, circles, etc. Textures simulate materials and depth. Complete building elements exist in specific libraries for the creation of models. These elements can be specified by various parameters. Linking single elements of this database forms a connected model with interdependent parts, which means that changes to one part of the model can influence other parts if necessary. Within CAAD software elevation drawings, sectional views and 3D views are generated as construction drawings. The design data from these software tools can be exported and imported by various exchange formats for further use.

• Calculation and simulation:
Calculation and simulation tools provide technical and visual parameters in the design phase. The dynamic behaviour of complex systems and processes can be modelled. Such computer methods supply a fact-based understanding of a design’s form and physics and, in doing so, sectoral planning in various dimensions are integrated. The same volumetric data model is thereby integrated into different calculation and simulation tools. Often calculation and simulation software can be used as a plug-in tool for the specific CAAD. Separate software systems usually have interfaces to CAAD tools. Progress made in software and hardware allows more and more applications of tools for the calculation and simulation design aspects of a building. Most important is structural optimisation through the finite element method (FEM) and the estimation of cost by quantity calculations. Furthermore, simulation and calculation tools are available for the purposes for illumination, acoustics, fire prevention, energy efficiency, ventilation, heating, etc.

A closer look at the specific tools of the design phase is given in chapters 3 and 4.
Traditionally, invitations for bids, specifications, bills of quantities and further contract documents have been drawn up independently and exchanged in paper form. Today, cooperating and comprehensive software tools support the complete process of tendering. Communication is almost exclusively carried out electronically between the persons and organisations involved. Documents are exchanged on specially designed web pages, by email or at least on portable data storage devices, such as DVDs, CD-ROMs or memory cards.

As early as the 1970s, the first comprehensive software tools for supporting tendering procedures were implemented. Starting with punch card systems, the development of these tools led, above all, to new forms of data exchange. Since then, with the possibilities provided by the internet, spatial barriers have also been broken down. Computers can exchange tender information everywhere worldwide in real-time. Digital signatures ensure that the binding nature of the documents can be achieved. Figure 2.2. shows the usual tendering process with interfaces, participants and data sources.

Fig. 2.2. Tender Process
Software tools support this process from the beginning with the preparation of the bill of quantities. *Since the databases store design information from a building model, specifically CAD quantity calculations, on the one hand, and that from predefined specifications, on the other hand, these basic tendering documents can be generated. Thereby, the software calculates the quantities according to the structure of the item list.* During the construction process new measurements can be filed and included, with the result that every item, as well as the total volume, is updated automatically. The specification texts align with technical norms. Digitally transferring the bill of quantities to the bidders saves time and money. A manual input of bill of quantities is unnecessary, as the whole data can be transferred in a structured form to the calculation software of the bidder. On the basis of this information, the construction company is able to calculate its bid. The bid is passed back to the customer, again digitally, by a data interface, so comparisons between all bids are possible electronically. As a result, a schedule of prices can be created by the customer’s appropriate software tools. In doing so, the bids can be evaluated by a whole catalogue of criteria. Before the contract is awarded, all modifications resulting from negotiations or changed conditions have to be included in the contract documents. Such information can easily be adapted by software tools. The commission of contingency items, cancelled items or price changes must be included as well. A digital version of the bill of quantities for the contract also supports the calculation and agreement of change orders during the realisation phase.

Websites gain importance as a result of the electronic tendering (e-tender) process. There are several platforms, which specialise in the tendering of private and public construction orders. Similar to offline tools, these websites support the whole procurement process—starting with the download of an invitation to bid through to the legally binding acceptance of a tender. In particular, public administrations and large-scale enterprises increasingly use e-tender platforms, as they benefit from the application of these systems in terms of cost and time. An example is provided by the European “Tenders Electronic Daily” (TED). Construction companies wanting to bid for contracts will have to adapt their processes to these new tendering methods.

The main types of software tools for the tendering process are listed below:

- **Preparation of specifications and bills of quantities:**
  Software tools for the preparation of specifications and bills of quantities automatically relate measurement data to the corresponding specification texts according to a given item structure. The specifications are based on technical norms and can usually be inserted as standard text blocks.

- **Costing and Accounting:**
  Software tools for costing and accounting support cost estimation and analysis. These applications are used by bidders as well as customers.
Costs can be estimated and controlled on the basis of data from the bill of quantities.

- **Comparative analysis of unit prices:**
  Software tools for the comparative analysis of unit prices are used by customers to choose between several bids. Predefined catalogues for evaluation highlight differences between single bids and support the decision process.

- **Web-based e-tendering:**
  Web-based e-tendering supports the tendering process in various ways. Websites can supply data for tendering inquiries and enable tendering documents to be requested and dispatched. The scope varies greatly depending on the provider.

A closer look at the specific tools of the tender phase is given in *Chapter 5*.

### 2.3 CONSTRUCTION PROJECT MANAGEMENT PHASE

The management of a construction project is a highly demanding challenge comprising a range of tasks. It contains all managerial functions, forms of organisation, techniques and instruments for the implementation of the project.\(^1\) The range of duties expands with the complexity of construction projects. The more detailed structuring there is within the projects, the more the amount of data rises. Tools are needed to store and process the information accumulated. Thus various types of software for managing a construction project effectively are available/used today.

The development of computer methods for project management tasks started with concepts for a mathematical, network-based analysis of large-scale projects with the aim of time and cost reduction. In the late 1950s, techniques such as PERT (Programme Evaluation and Review Technique) and CPM (Critical Path Method) provided appropriate logical methods for the computer-aided management of a project. On this basis, software tools with more and more functions for the management of projects have been developed up to now. *Thereby, a wide*

---

\(^1\) cf. DIN 69901:2009
influence is also brought by the ever-expanding potentialities of hardware and communication technologies, such as portable PCs and the internet.

Today, software tools support project managers in all of their tasks. To ensure an effective technical, economic and organisational construction project, the project management and its instruments are, above all, responsible for the following assignments:

- **Coordination:**
  A construction project has to be organised with regard to structure and process. As a purposeful communication process cannot be assumed to exist in temporary project organisations, various requirements have to be considered. The division of labour and responsibilities, as well as the exchange of information and the workflow within the project, must be planned, implemented and controlled.

- **Documentation:**
  The construction process has to be documented thoroughly and in real-time. On the one hand, records may be required due to regulations and, on the other hand, they can be used for the monitoring, controlling and accounting of construction processes. The documentation particularly concerns daily site reports, correspondence and pictorial material.

- **Controlling:**
  When managing a project, the identification of discrepancies between target and actual performance is essential to target-oriented controlling. All processes need to be monitored within a narrow timeframe to ensure effective corrective actions. Quality, cost and schedule are particularly relevant aspects.

Coordination, documentation and controlling are closely related to each other. Software tools for project management have to take account of the associated joint data use. Only by exchanging data between the tools as well as with other applications, such as design or tender software, can an effective processing of the data be ensured. Clear interfaces reduce unnecessary data collection and prevent inconsistent conclusions (Figure 2.3.).
There is currently no comprehensive software which is able to deal with all of the tasks involved in project management. Different systems are, therefore, usually applied according to the assignment. The most important types of project management software are given below:

- **Scheduling Software:**
  Construction scheduling software is applied to plan, monitor and control project progress. Buffers and the corresponding critical path can be calculated by the attribution of process durations, deadlines and the necessary relationships in light of technical and capacitive boundary conditions. Furthermore, resources can be assigned. The results are usually displayed in the form of a Gantt chart, network plan or list. By entering current data, the user is able to automatically generate appropriate target-performance comparisons.

- **Project Communication System:**
  Project Communication Systems support the coordination of a construction project by providing a joint platform to all project members for cooperation and the exchange of information. Usually, the platforms are internet-based and data access can be governed by different user authorisations and privileges. The range of functions varies greatly. Platforms are partly used only as common data storage and partly used to provide comprehensive media and workflow support.
• Digital Construction Diary:
Computerised versions of construction diaries are referred to as “Digital Construction Diaries”. Information is fed in, processed and stored digitally. Software applications therefore range from predefined text documents, e.g. templates for word processors, up to internet-based systems with complex data structures. By integrating media such as photo documentation, the cogency of the construction diary can be increased. Furthermore, pictures illustrate the current state of the construction project, and thus prove especially useful for remote project members.

• Cost Controlling Software:
Cost controlling software is based on capacity planning methods and instruments. Resources are thus assessed according to cost information, such as charge out rates of workers and equipment. Through a close link to the project’s accounting software, a comparison of budget figures with actual figures is possible. In addition, appropriate reports containing a visualisation of the processed data can be generated automatically.

2.4 APPLICATION OF IT SYSTEMS IN REAL-ESTATE MANAGEMENT

Real-estate management is a complicated process, which is constantly evolving alongside the increasing technological complexity of buildings and the development of IT systems. Additionally, higher expectations of the users, owners and investors influence the present form of management, as they are interested in increased capital revenues from property investments, as well as financial risk management connected with such investments.

Development of the market forces the application of modern IT solutions. Their application results in better quality of rendered services through, among others, shorter performance periods or elimination of calculation errors. The available software supports real-estate managers at every level of their operation.

There are many IT systems supporting real-estate management. These systems serve among others the following purposes:

• collecting and processing of information,
• supporting technical services for the property,
• spatial planning and organisation,
• accounting management,
• generation of financial statements and,
• contract management.

Technological solutions are usually available in the form of integrated IT systems which are characterised by very flexible configuration possibilities. Therefore, their functionality can be adjusted to the scope of works connected with management of a specific property.

CAFM (Computer Aided Facilities Management) is a professional tool with extensive functionality and wide scope of application. It provides permanent complex supervision of technical status (including networks, installations and devices) and the financial situation of any managed facility. Its extensive functionality and wide scope of possibilities enables management of all types of modern buildings. It is a solution used by many companies all around Europe.

Another solution often used for management of modern properties is the Building Management System (BMS). Its main functionality concerns the management of building automation.

In addition, Facilities Management, that is management of facilities which is strongly user-oriented in the real-estate management, relies largely on modern IT systems.
CHAPTER 3

COMPUTER AIDED CONSTRUCTION DESIGN

(C. MOTZKO, F. BINDER)

3.1 APPLICATION OF ARCHITECTURAL SOFTWARE TOOLS

In chapter 2 basic types of software tools for the design phase were described. This chapter goes into more detail about selected architectural tools in the design phase. The focus is on Computer Aided Architecture Design (CAAD). Applications, data formats, criteria and available products are described. As a summary a short example for the application of design tools is given.

A line between CAAD software and other tools for the design of buildings cannot easily be drawn today. Classical animation programmes, for example, are used by architects in order to present or animate drafts. At the same time, the finite element method can also be a component of CAAD software for computational proofs of building structures. Today, a standard CAAD system deploys a database with components which have specific properties, so the architect can use complete buildings components for his design instead of just visualising objects through a drawing. A major advantage is the fact that all the data relating to the building components is attached to the designed model. Thus, two spheres are usually defined. As a first sphere a geometric representation of the design can be displayed in 3D models or construction drawings. It includes all visual data such as measurements or materials. In a second sphere, additional information about the model as a whole can be analysed. This kind of information includes meta-data, such as piece lists, area calculations or cost estimations.
The design process can be monitored by CAAD systems with due regard to the given component data and distinct boundary conditions. The technical, economical as well as environmental feasibility of a design can be analysed by computer methods. For instance, the compliance of net floor area, fire regulations or construction cost can be controlled throughout the design process. Along with design control, data-provided design components of a CAAD system support automated design procedures on a parameter basis. As each component of a building design depends on particular parameters (e.g. anchor point and the measurements of a window), designs can only be varied by altering these specifications. The corresponding software tools record the development process of each object. Through the correlation of all the objects from a design with their specific development processes, a solution space for the whole building can be generated by the design tools. Subsequently, all possible solutions need to be analysed and can be ranked and, as a result, unknown design solutions are detected and an optimisation of a design with respect to various aspects is provided.

As is evidenced by the demonstrated applications of modelling, controlling and improving construction designs, CAAD tools comprehensively support the design process. Thus, architects benefit from computer methods in construction to a great extent, as the complete design data can be automatically generated, analysed and modified. By employing software tools, a significant part of an architect’s work with regard to the definition of boundary conditions and the assessment of solution possibilities is shifted. A commitment to predefined principles is no longer necessary with this computer aided design process. In fact, more and more specific solutions can be developed as a result of computer methods in architecture.

### 3.2 DATA FORMATS OF ARCHITECTURAL SOFTWARE TOOLS

Future digital building design will have to incorporate software tools from all the disciplines involved. Standardised interfaces are necessary for a smooth data transfer and, therefore, an efficient design process. Up to now there has been no common exchange format for CAAD software. Usually, Autodesk’s dxf/dwg data
format is supported by CAAD software for export or import. Amongst others things, these formats are also used for transferring data to manufacturing systems (CAM, Computer Aided Manufacturing) in the wood- and metal-working industries. Yet, software tools – except for AutoCAD – rarely work effectively with dxf and dwg files and they use internal formats for processing data, so with every export or import procedure information is lost. In particular, this makes the transfer of database information beyond geometric data difficult.

At the moment, common formats for CAAD software are developed under building information modelling (BIM) aspects (See Chapter 9), among which the Industry Foundation Classes (IFC) data model is considered the most important data format. IFC is a neutral, vendor-independent and open specification. The object-oriented file format was developed by buildingSMART (International Alliance for Interoperability, IAI) especially for exchanging data during the design process of a building. It is registered by ISO as ISO 16739.

### 3.3 REQUIREMENTS FOR ARCHITECTURAL SOFTWARE TOOLS

The purchase of a CAAD product is an important decision, as frequent changes of CAAD tools should be avoided. Yet, requirements for CAAD tools are difficult to define, as the variety of functions and products can be difficult to collate. To support a decision process regarding the application of CAAD software, only a catalogue of decision criteria can be compiled. With the aid of these criteria, but especially with due regard to the specific functional requirements – depending on user, existing IT infrastructure and purpose – software tools can be chosen.

The main criteria for the evaluation of CAAD products are discussed below:

- **Geometrical Options:**
  CAAD software tools need to be able to design parameter-based in 2D and 3D. Solid modelling as well as surface creation has to be possible in 3D space. A precise and persistent geometric positioning, therefore, must be ensured between construction elements. Furthermore, attention should be paid to capabilities for generating 2D sections, elevations, layers, visualisation and rendering.
• **Data Transfer:**
  As pointed out earlier, the exchange of design data is an essential issue for CAAD software. A wide distribution of the respective proprietary data formats helps. Additional export and import formats need to be checked. Above all, a seamless and accurate information transfer to extended design team members working with tools for CAM, calculation, or simulation, should be considered.

• **BIM Functionality:**
  Aspects of Building Information Modelling are closely related to data transfer issues. A connection to tools and data for cost estimation, scheduling and engineering analysis should exist. In this context, compliance with the IFC standard should be observed. In addition to the necessary exchange capabilities of the software, modern CAAD software should also be able to process certain BIM data.

• **Usability:**
  For fast access to the functions of CAAD software the learnability and the user interface are decisive factors and, consequently the performance of a product also depends on the tool’s usability. This means that training opportunities, software support and special software elements for handling, such as grid and navigation tools, are needed.

• **Cost:**
  The cost of CAAD software systems certainly relate to a reasonable application of these tools. In addition to the purchase cost, charges for hardware, training, support and maintenance should also be considered. The relevant software companies, therefore, usually offer various sales and license models.

### 3.4 SELECTION OF ARCHITECTURAL SOFTWARE TOOLS

There are various providers for CAAD software: as examples, selected CAAD instruments are listed in the table 3.1.
<table>
<thead>
<tr>
<th>Software</th>
<th>2D/3D</th>
<th>File Format</th>
<th>Operation System</th>
<th>BIM Support</th>
<th>object-based Options</th>
<th>Geometry Options</th>
<th>Parametrization</th>
<th>Pricing</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illustrator (1987)</td>
<td>*</td>
<td>ai</td>
<td>ai/dxf/dwg/eps</td>
<td>Windows/Mac OS/Linux</td>
<td>2D cartesian</td>
<td></td>
<td></td>
<td>768/239</td>
<td>Illustrations</td>
</tr>
<tr>
<td>Auto CAD (1982)</td>
<td>*</td>
<td>dwg</td>
<td>dwg, dx, dws, dbx</td>
<td>Windows/Linux</td>
<td>*</td>
<td>*</td>
<td>3D cartesian</td>
<td></td>
<td>1189/0</td>
</tr>
<tr>
<td>ArchICAD (1982)</td>
<td>*</td>
<td>dgn</td>
<td>atl, 3ds, c4d, dgn, dwg, dxf, eps, fact, pdf, plt, ifc, ifcxml, sgi, u3d, wrl, skp</td>
<td>Windows/Mac OS</td>
<td>*</td>
<td>*</td>
<td>3D cartesian</td>
<td>Single Objects</td>
<td>2950/0</td>
</tr>
<tr>
<td>VectorWorks (1985)</td>
<td>*</td>
<td>vwx</td>
<td>dxf, dwg, 3ds, iges, sat, hdri, iges, kml, epsdf, shape, stl, ifc, stl, skp, Art-Lantis</td>
<td>Windows/Mac OS</td>
<td>*</td>
<td>*</td>
<td>3D cartesian</td>
<td>Single Objects</td>
<td>4450/0</td>
</tr>
<tr>
<td>Allplan (1984)</td>
<td>*</td>
<td>ndw</td>
<td>dwg, dxf, 3ds, vr, ifc, wrl, u3d, 3dm, 3ds, skp, ifc, iges</td>
<td>Windows</td>
<td>*</td>
<td>*</td>
<td>3D cartesian</td>
<td>Single Objects</td>
<td>1495/0</td>
</tr>
<tr>
<td>Microstation (1980)</td>
<td>*</td>
<td>dgn</td>
<td>dwg, dxf, skg, 3dm, rev, ifc, iges, step, u3d</td>
<td>Windows</td>
<td>*</td>
<td>*</td>
<td>Polylines/Nurbs...</td>
<td></td>
<td>7378/95</td>
</tr>
<tr>
<td>Generative Components (2005)</td>
<td>*</td>
<td>incl. in Microstation</td>
<td>dwg, dxf, dgn</td>
<td>Windows</td>
<td>*</td>
<td>*</td>
<td>Polylines/Nurbs...</td>
<td></td>
<td>0/0</td>
</tr>
<tr>
<td>SketchUp (2000)</td>
<td>*</td>
<td>skp</td>
<td>3ds, dwg, dxf, fbx, obj, vrml,vs, dem, dds</td>
<td>Windows/Mac OS</td>
<td>*</td>
<td>*</td>
<td>Polylines/Nurbs...</td>
<td></td>
<td>0 – 373</td>
</tr>
<tr>
<td>3D Max (1990)</td>
<td>*</td>
<td>3ds</td>
<td>common formats</td>
<td>Windows/Mac OS</td>
<td>Polyline/Splines/Nurbs...</td>
<td>4641/148</td>
<td>Visualization/Animation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maya (1998)</td>
<td>*</td>
<td>ma/mb</td>
<td>common formats</td>
<td>Windows/Mac OS/Linux</td>
<td>Polyline/Splines/Nurbs...</td>
<td>3495/166.60</td>
<td>Visualization/Animation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revit (1999)</td>
<td>*</td>
<td>rvt</td>
<td>rvt, dwg, dxf, ddrw, 3ds, dgn, sat, gbXML</td>
<td>Windows</td>
<td>*</td>
<td>*</td>
<td>3D cartesian</td>
<td></td>
<td>5500/0</td>
</tr>
<tr>
<td>Cinema 4D (1990)</td>
<td>*</td>
<td>c4d</td>
<td>common formats</td>
<td>Windows/Mac OS/Linux</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>1500/96</td>
</tr>
<tr>
<td>FormZ (1989)</td>
<td>*</td>
<td>fmz</td>
<td>acis,sat, Art-Lantis, dae, dem, dwg, dxf, eps, fact, iges, ai, kmz, Lightwave, Lightscape, obj, pinaceti, rib, skg, step, stl, targa, zpr</td>
<td>Windows/Mac OS</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>1049/32</td>
</tr>
<tr>
<td>Rhino (19xx)</td>
<td>*</td>
<td>3dm</td>
<td>3dm, IGES, STEP, ACIS, VDA, Parasolid, dwg/dxf, 3ds, ai, obj, pov, raw, rib, STl, udo, VRML, wrl, DirectX, csv/txt, slio, zpr, GHS, WAMIT, fbx, XGL, cd, lwo, kml, ply</td>
<td>Windows/Mac OS</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>1184/232</td>
</tr>
<tr>
<td>(Grasshopper 2005)</td>
<td>*</td>
<td>3dm, sKr ipt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0/0</td>
<td></td>
</tr>
<tr>
<td>Unigraphics (NX) (1977)</td>
<td>*</td>
<td>ig</td>
<td>common formats</td>
<td>Windows/Mac OS/Linux</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>8000y/199</td>
</tr>
<tr>
<td>Solid Works</td>
<td>*</td>
<td>sddrw</td>
<td>dwf, dwg, Parasolid, iges, step, acis, stl, u3d, wrl, ifcxml, catia</td>
<td>Windows</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>9995/99</td>
</tr>
<tr>
<td>Catia</td>
<td>*</td>
<td>div/exp</td>
<td>common formats</td>
<td>Windows/Linux/Solaris</td>
<td>*</td>
<td>*</td>
<td>Polylines/Splines/Nurbs...</td>
<td></td>
<td>ab 10 000ex VAT/75</td>
</tr>
</tbody>
</table>
3.5 APPLICATION EXAMPLE OF ARCHITECTURAL SOFTWARE TOOLS

The “National Temple of Divine Providence” (Świątynia Opatrzności Bożej) is being built as a final element of the Royal Route (Trakt Królewski). Drawing attention to the bare essentials, fair-faced concrete dominates the whole structure. The nave, with its inclined pillows and curved altar wall, is particularly technologically interesting and ambitious.

The design and realisation of this complex geometry is only achievable with computer methods. Layouts of forms, reinforcement drawings as well as construction controlling are all entirely produced in computer-based contexts. The architectural design is developed through a parallel processing of freehand sketches, physical models and digital modelling. On the basis of these instruments, the architects assess the rationality, creative quality, ecology and further parameters of the solution space.

Modern construction technologies, such as modular and CNC-manufactured formwork systems, new varieties of flow and high-strength concrete or bolted reinforcement can ensure the realisation of nearly any component geometry today. The appropriate dimensioning and application planning of the formwork has to be performed almost exclusively by software tools. Elements with curved and complex shapes need special formwork elements. The layout of these forms can generally be divided into two steps. At first, a design of the formwork construction is outlined with company-specific software of the formwork supplier. Subsequently, the single components are dimensioned in another tool. This tool is connected to the manufacturer’s database, which catalogues the modular formwork components as well as further standard steel- and woodworking elements. The formwork supplier initially adapts the architects’ digital drawings using his own software tool and afterwards transfers this data manually to the dimensioning software.

---

2 Complete example with all illustrations adapted from Motzko 2010
Unfortunately, this process is characterised by redundant actions and manual interventions. The standardisation of exchange formats would significantly increase efficiency. The following illustration shows the digital collaboration between design and construction. With the help of computer methods, architects can design curved components. This data basis provides an input for the computer-aided formwork modelling. After the formwork, engineering appropriate production data is transferred to CNC machines for manufacturing. Finally, the modular formwork elements are prepared for concreting on the construction site exactly according to the realisation concept. Thus, as a result of all these software tools, the building is constructed precisely according to the architect’s ideas.

Fig. 3.2. Computer-aided Formwork Design and Building
CHAPTER 4

COMPUTER AIDED ENGINEERING TOOLS

(R. GAJEWSKI)

In this chapter, Computer Aided Engineering (CAE) tools [55] will be discussed. Progress in the field of hardware and software, observed in the recent years, allows for the application of state-of-the-art calculation tools throughout all phases of the design process, including analysis using the finite elements method, as well as synthesis with optimisation components.

4.1 MODES OF REASONING

The three basic modes of reasoning, applied also in engineering activity, are: deduction, induction and abduction. Deduction is the type of reasoning, which is consistent with the course of logical implication, aimed at reaching a specific conclusion on the basis of an assumed set of real premises. The results of deductive reasoning, if it is conducted properly on the basis of a set of premises which contains no false information, are real and cannot be undermined.

On the other hand, induction is reasoning based on the drawing of general conclusions on the basis of premises which constitute special cases. The induction method consists of conducting experiments and observations. On the basis of these, generalisations are made and hypotheses are formulated, which are then subject to verification. The induction principle allows us to go from specific cases to general statements.

The term abduction is not very popular in the Polish language. In most cases, it is associated with abduction, or medical examination performed to determine the
type and scope of body injuries and – in critical cases – the cause of death. In this type of reasoning, we know the final effect and we are searching for the causes. These three modes of reasoning are very well illustrated by the academic example of stretching of a spring. We are dealing with two “facts” – the cause, which is applying of force F, and displacement w, which is the effect. In addition, we have at our disposal the “principle” – a rule stating that application of force F results in displacement w, which is proportional to the force. The proportionality coefficient in this case is the rigidity of the spring – the more rigid the spring, the lesser the displacement.

In the case of deduction, applying the force F and knowing the respective rule, we determine the cause, or the size of displacement w. In the case of induction, we are dealing with a situation, in which two facts are known – the applied force F and the resulting displacement w, and we are searching for a rule to determine the correlation between the two. Abductive reasoning is a situation, in which we have the final result (displacement), we know the rules and we are searching for the cause. The three basic modes of reasoning, applied to the spring, have been illustrated by the table below.

<table>
<thead>
<tr>
<th>Reasoning</th>
<th>Information given</th>
<th>Information sought</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deduction</td>
<td>Cause</td>
<td>Effect</td>
</tr>
<tr>
<td></td>
<td>Rule</td>
<td></td>
</tr>
<tr>
<td>Induction</td>
<td>Cause</td>
<td>Rule</td>
</tr>
<tr>
<td></td>
<td>Effect</td>
<td></td>
</tr>
<tr>
<td>Abduction</td>
<td>Rule</td>
<td>Cause</td>
</tr>
<tr>
<td></td>
<td>Effect</td>
<td></td>
</tr>
</tbody>
</table>

### 4.2 CLASSICAL ENGINEERING TASKS

Before we discuss the five classical engineering tasks, let us re-state the definitions of two basic terms: structure and its behaviour. Structure is both a real engineering facility and the overall set of information on the facility, such as drawings, data, materials, parameters, loads, temperature. Behaviour is a way in which the structure performs its functions. It includes such information as,
deformations, displacements, tensions, distortions, cracking, corrosion, creeping and relaxation.

Let us provide a precise definition of two other terms as well – simulation and analysis. **Simulation** is a situation in which causes are applied to specific structures to observe the effects, or behaviours, of the structure. **Analysis** is a special case of simulation. We search for responses (behaviours) of structures under specific conditions (subjected to specific loads). An example here may be analysis of bridge structures under various combinations and sets of loads.

The opposite process to simulation is **diagnosis** – we know the effects (consequences), as well as parameters of the structure, from observation, and we are searching for the causes. A fungal attack has been observed in the corner of the room – what is the cause of this?

**Synthesis** is the opposite of analysis. In this process, the desirable end behaviour of the structure serves as a basis for determination (designing) of its physical parameters. The process of designing a structure is based on shaping the structure so that no values describing its behaviour are exceeded.

The last of the basic engineering tasks is **interpretation** of information. It encompasses a very broad scope of engineer’s tasks, such as: test loads, laboratory experiments, combining of research results and knowledge of the structure. The five basic engineering tasks and the modes of reasoning applied in their performance have been presented in the table below.

<table>
<thead>
<tr>
<th>Task type</th>
<th>Mode of reasoning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation</td>
<td>Deduction</td>
</tr>
<tr>
<td>Analysis</td>
<td>Deduction</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>Abduction</td>
</tr>
<tr>
<td>Synthesis</td>
<td>Abduction</td>
</tr>
<tr>
<td>Interpretation</td>
<td>Induction</td>
</tr>
</tbody>
</table>

It shows clearly that deduction and abduction are used most often. The calculation methods discussed in the later sections of this book are based on deduction. The process of designing (synthesis) or diagnosing is based on abduction, which is more difficult to computerise.
4.3 INFORMATION IN CONSTRUCTION

Construction, like other engineering fields, may be perceived and analysed from the perspective of the process of transformation of information. One of the stages of this process is very well known to everyone – when we calculate a displacement in the beam, the data on the structure (dimensions, material, load) is transformed into information on behaviour (displacement size). Apart from the two types of information, there is also the information on the structure function, which includes functional requirements, design criteria, specifications and social expectations.

The first stage of the information transformation process is formulation – which means going from the area of information on functions to the area of information on desirable behaviours of the structure. The objective of engineering design is transformation of functions (requirements) into behaviours, in accordance with the established parameters of safety, durability, stability, as well as appearance.

The second stage is synthesis. The parameters associated with the desired behaviour of the structure and the loads are transformed into spatial information on the structure, which is in accordance with the design. An example here is preliminary selection of structure foundations, as well as the type and size of load-bearing components.

The third stage of transformation of information is analysis and assessment. After gathering information concerning the structure (performance of the project), we can analyse the structure to determine its expected behaviour (response). Most often, this information concerns the internal forces and displacements (deformation) caused by loads. These values are compared in the process of evaluation with information concerning the desirable behaviours of the structure. We use known calculation methods to analyse the structure. Many of these are performed by computer software. If the evaluation results are not satisfactory, we repeat synthesis and analysis or change the formulation. This is an iterative process. Designing is an iterative combination of synthesis and analysis, taking into account the formulation. After this iteration, we can build a structure.

The fourth stage is construction – going from the structure, which is consistent with the design, to a built structure. The construction process should not end at this point. Continuous observation and measurement of behaviour of the structure built is necessary.

The last, fifth stage is monitoring of the built structure. If we are not 100% sure about the behaviour of the structure, we conduct monitoring. It provides us with information on the third type of “behaviour” of the structure – measured. It
allows for measuring of behaviour of the structure. In addition, we are able to **predict** the behaviour of the structure. Unfortunately, most often we forget about this element. Comparison of the predicted and measured behaviours of the structure may and should lead to its improvement. All five stages have been summarised in the drawing below.

**Fig. 4.1. Information flow in construction**  
Source: [55]

CAE deals with computerisation (informatisation) of engineering tasks, associated with the broadly understood construction process, i.e. transformation between the three basic types of information in construction; information on functions; information on behaviours; and, information on the structure. The next part of this book presents, in detail, the calculation methods used for analysis and prediction of behaviours of the structure. The basic optimisation rules, discussed in the final part of this book, may be helpful in the synthesis process, which is a significant component of the structure design process.
4.4 MODELLING AND SIMULATION

Modern science deals with solving of three key problems: **identification**, or getting familiar with reality, **optimisation** or finding the best solution, and development and **innovation**. The problem of identification of reality is based on searching for the best structural and functional model. Optimisation and development also require the use of models; otherwise, all we have left is the trial and error method.

According to the most popular definition, a model is a simplified representation of a fragment of reality, aimed at its better understanding. All models created can be divided into **material** and **symbolic** models. A material model is a representation which takes into account the facility in a specific scale. The scale of the material model may result in a reduction or an increase of the size of the facility. When using such models, it is necessary to apply the rules of dimensional analysis.

Symbolic models use symbolic – most often mathematical – representation to depict reality. Most often, symbolic models are divided into qualitative and quantitative models.

In science, it is said that getting to know reality is possible thanks to **theoretical** or **experimental** procedures. Experience gives a reliable basis for a theory, while the theory explains the results of experiments. Modelling and computer simulations are a new quality in science, of great significance for construction of new theories, as well as for experimental works. When working on new theories, computer simulations may aid us in the preparation of precise calculations on a very large scale and suggest new theories. On the other hand, theory provides us with equations and may be helpful in the interpretation of the results of computer simulations. In addition, computer simulations may support the analysis of experiments and aid in controlling of measurement apparatus, as well as suggest the right kind and type of experiment. The experiment, on the other hand, provides data allowing for establishment of a link between the theory and the experiment, through computer simulation. The role of computer simulations and modelling increases along with development of new generations of computer equipment, characterised by increased calculation performance, new calculation techniques and methods. There is even a periodical dedicated solely to the subject of modelling and simulation in engineering. More information on the art of modelling and analysis can be found in monographs dedicated to these problems.
Fig. 4.2. A correlation between theory, experiment and modelling

Calculation methods are located on the verge of three fields; the field of mathematics; the field of IT science; and, the appropriate scientific or engineering discipline for the problem being solved. The analysis of engineering structures, which is often based simply on solving of a system of differential equations, ordinary and partial, naturally uses the appropriate knowledge in the field of mathematics. A computer-generated solution to this problem often uses computer graphics as complementary to numerical methods and programming.

Fig. 4.3. The place of calculation-based methods
4.5 MODELLING OF THE STRUCTURE

The first stage of the modelling process – going from the physical system (facility) to its mathematical model is not dealt with in this book. These problems are discussed in detail within the framework of subjects that deal with mechanics of materials and structures (there are three: Theoretical Mechanics, Strength of Materials and Mechanics of Structures). The shift process is connected with the need for idealisation – for instance, we assume the uniform character of the modelled facility. Errors made in this regard are referred to as modelling errors. Mathematical models, which we will consider here, are ordinary or partial systems of differential equations, which often cannot be solved “manually”. This and subsequent stages of solving of exercises using the finite element method are illustrated by the drawing below.

**Fig 4.4. Stages of problem solving, using the finite element method**
Source: [54]

The shift between the mathematical model and the discrete model is provided by the finite element method. The process is known as discretisation, and an error made during the process is a discretisation error. In some cases (statics of bar structures – trusses, beams, frames and grates), the discretisation error does not occur, since the appropriate matrix dependencies constitute the precise implementation of the mathematical model.

After creation of a discrete model, a discrete solution is sought, which, in the case of static exercises, is based on solving of a linear system of algebraic
equations. An error made in this case, related to numerical calculations, is known as a **solution error**.

It is necessary to be aware of these errors when making calculations using the finite element method. The solution obtained is discrete. It is available only at certain points, so-called nodes. In the process of attaining **continuity**, on the basis of a discrete solution, thanks to interpolation, we are able to reach an estimated solution at any point. The last step is **identification** – checking whether the mathematical model solution applied is consistent with the physical system [56].

The process of solving exercises using the finite element method has been largely automated. This does not mean that software users do not have to use the **garbage in – garbage out** method. The solution result depends on data, and incorrect data provides incorrect results. The first step performed is usually discretisation, i.e., the division of an area into elements, distribution of nodes. The process is natural in the case of bar structures. For surface structures (plates, coatings, shields), the level of precision of the solution is determined by the grid applied and the type of elements used. In most programmes, the division into elements is performed automatically and the user only specifies their density. A natural division of an area is uniform. However, from the perspective of accuracy of the solution, it should not be uniform. In places in which large concentrations of stress are observed, the grid should be refined. Refining of the grid is performed automatically by many programmes, using **adaptation techniques**. Selection of finite elements, or the mathematical model, is also significant. Elements used for analysis of thin, medium-thick and thick plates are different. It is also important to apply suitable boundary conditions and external loads. An example of a solution – analysis of a thermal bridge – is illustrated by the drawing presented below.

![Fig. 4.5. Analysis of a thermal bridge using the finite element method](image-url)
4.6 EXAMPLES OF PROGRAMMES FOR STRUCTURAL ANALYSIS

In the area of CAD programmes for designing, there is fairly well defined group of programmes determining the standards. But when it comes to programmes for structural analysis, the situation is much more complicated. There is a group of simple freeware and open source programmes, which enables calculations for different types of structures to be carried out without the use of expensive commercial software. The example of such programmes on bar constructions can be EngiLab software. Its operation is very simple and intuitive.

![EngiLab Beam2D](image)

Fig. 4.6. EngiLab Beam2D

The EngiLab Beam2D programme allows two-dimensional analysis of the rod structure. Its incredible advantages are simplicity and intuitive operation. Results can be exported to a spreadsheet and then subjected to further treatment process. The programme has multiple language versions.

An example of a free programme that can be used for the analysis of heat flow can be FEMM. It is a universal programme that can be used for the analysis of many issues described by the systems of partial differential equations: the heat
flow, electrostatics, magnetism. What is more, this simple programme allows one to import files in DXF format. The following example shows the analysis of stationary heat flow in the wall barrier.

![FEMM Diagram](image)

**Fig. 4.7. FEMM**

### 4.7 THE BASIS FOR OPTIMISATION

The problem of searching for an optimum solution is a typical task of science, technical engineering and economy. In construction, we optimise structures and selection of materials so that the structure meets the standard conditions (strength, heat) and is as cheap as possible, both during construction and operations and afterwards in the process of using them. Beighfer referred to optimisation as a three-stage process of decision making. His first step is knowledge of the system analysed. The second step consists of creation of a measure of effectiveness of
the system (the objective function). The third stage is based on optimisation theory and it consists of solving the problem.

Optimisation is rooted in history, reaching as far back as the year 1000 B.C. The legendary founder and the first queen of Carthage, Dido (Elissa) had to solve the task of finding the optimum curve describing the city wall outline of specific length, to encompass the maximum city area within. The intuitive solution, applied by Dido – a circle – was the right one, but the formal proof of correctness of this solution was established many centuries later. A rectangle of dimensions of 2x6 has the area of 12 and the perimeter equal to 16, a square with the perimeter of 16 has the area of 16, and a circle of the same perimeter 16 has the largest area of 20.38.

Fig. 4.8. The first optimisation task

The modern optimisation theory was created on June 4th, 1694. At the time, John Bernouli formulated the problem of brachistochrone (from Greek – brachistos means the shortest, while chronos means time) – finding a curve of fastest descent of a point mass under gravity force. The solution to this problem is a cycloid.

Optimisation methods were developed mostly during the Second World War. It was the period of the emergence of the first numerical solutions to optimisation problems. In 1947, Danzig proposed the simplex algorithm for solving of linear programming. Research on non-linear programming issues began in the 1950s, when Kuhn and Tucker formulated their conditions. The difference between these two types of problems is illustrated by the drawing 4.9.
At present, solving of optimisation problems is conducted numerically in an iterative manner, which is illustrated by the drawing below.

---

**Fig. 4.9. Linear and non-linear optimisation task**
Source: [53]

---

**Fig. 4.10. Numeric optimisation**
Source: [53]
4.8 BASIC OPTIMISATION PROBLEMS

4.8.1 LINEAR PROGRAMMING ISSUES

We will discuss the basic optimisation problems and modes of solving these. In linear programming (LP) problems, both the objective function and the limitations are of linear nature. Using LP, it is possible to model and solve many optimisation tasks, such as the optimum selection of the production assortment. Having limited means of production at our disposal and knowing the consumption standards per product unit, it is necessary to specify, which products should be manufactured and their quantity, in order to maximise profit from sales. Another optimisation task, which can be modelled using the LP, is the problem of mixtures, i.e., determining the correct mixture composition to obtain a product containing the proper ingredients, while the costs of purchase of raw materials are minimum. Linear programming may also be used to select technological processes.

Other problems which can be addressed by linear programming include transport issues. These are based on the preparation of a plan of transport of a uniform product from several sources to several locations, so that the total transport costs are as low as possible. The transport issues include closed (balanced) issues, in which the total supply is equal to the total demand. If this is not the case, we are dealing with open (unbalanced) tasks. These can become balanced tasks, if we introduce a fictional manufacturer or recipient. Another class of transport issues are transport and production tasks, in which the suppliers of goods are not warehouses, but manufacturers. These issues are generalised as the issue of manufacturing location. The issue of minimisation of empty runs is also a transport issue. Distribution problems, aimed at the allocation of resources to minimise the costs or time of performance of tasks or to maximise the effects – the quantity or value of products - can be solved in a similar manner.

4.8.2 THE ISSUES OF NON-LINEAR PROGRAMMING

Even the simplest optimisation problems – such as selection of cross-sections of bars in a truss, which cannot be determined statically, so that for a given load, its mass is minimum – are non-linear problems. It turns out, however those simple tasks, both linear and non-linear, can be solved using the Solver tool and a spreadsheet.
If we do not select „Apply a linear model” in the options, we are able to solve non-linear programming tasks.
4.9 PROGRAMMES FOR STRUCTURE OPTIMISATION

Among the programmes for optimisation, the most interesting group is the programmes designed to optimise shape. An example of such a programme is RESHAPE. The following diagram shows the optimisation of the plates shape (thickness), so that the first natural vibration frequency was equal 2500 Hz.

Fig. 4.13. Optimisation of the plate shape
CHAPTER 5

COMPUTER AIDED TENDERING

(F. BINDER)

5.1 THE APPLICATION OF TENDER SOFTWARE

The general use of software tools during the tender phase is outlined in chapter 2.2. Selected instruments and aspects significant for tendering are described more precisely in the present chapter. Web-based tools as well as offline tools are specified. Due to divergent national tender regulations, no list of software tools can be given. In fact, the focus is on functional issues. In this context, individual software products are given as examples. The chapter also underlines the major importance of data exchange formats for tender software tools. Finally, an application example for a single tool is provided.

Compliance with standards and regulations is highly important to the application of tender software and, in particular, public tender law, privacy policies and relevant technical standards have to be satisfied. Especially within the European Union, directives 2004/18/EG and 2004/17/EG have to be complied with. Furthermore, technical standard specifications depend on national amendments. Relevant data can be obtained on CD-ROM / DVD or on the internet. The data can be loaded into the tender software and used immediately by architects and engineers. The creation of a bill of quantities is usually based on such patterns. Additional text modules can be defined according to individual experience or specific project requirements. During the compilation process, the tools can automatically check the technical compatibility of chosen features and characteristics, which prevents the creation of an incorrect combination of items within the bill of quantities. Further support regarding quantity calculations, allocations of cost units and connections to cost groupings is given by tender
tools, which results in a close relationship between tools for cost estimation and computer aided architectural design (CAAD). Data processed with these tools can usually be imported to tender software, too. In addition, the inclusion of price data from other sources, such as central internet databases, is necessary in some cases.

The aforementioned functions demonstrate a high level of automation in the generation of a bill of quantities. Nevertheless, project and contract specific issues, in particular, impose enormous demands on standardised software tools. Thus manual adaptations by engineers and architects are usually still required. Today, support for the award of a contract is mainly given through specialised internet portals. On these web sites construction orders can be announced by owners as well as companies trying to find a suitable subcontractor. After a successful application for the project, the bidder is able to download the contract documents (bill of quantities, drawings, terms etc.). Often the downloaded data can be loaded into the bidder’s software tools directly for continuing processing. After pricing, the bids can be quoted on the platform.

Using the internet for this so-called electronic tender (e-tender) is considered to be sophisticated, especially regarding data protection, as confidential data is transferred and saved on exposable servers and special e-commerce laws have to be followed. Yet, a distinct increase in use is observed, as these modern information and communication technologies can greatly accelerate and harmonise the tendering process.

5.2 DATA EXCHANGE FOR TENDER SOFTWARE TOOLS

Software tools for tendering are used in different phases and by various project members. Each tool usually processes its task independently and accesses discrete data banks and, consequently, interfaces are needed for an efficient application of tender software.

Various techniques exist, mainly as a result of nationally-driven efforts. The International Construction Information Society (ICIS) regularly examines relevant developments in its reports: one example of which, the interface of GAEB (“Gemeinsamer Ausschuss Elektronik im Bauwesen”: Joint Electronic Committee for Civil Engineering and Building Construction), will be described
below. It represents a notable example of the development of tendering tools for the German market.

The introduction of the current GAEB XML standard allows for the complete digital tendering of construction. The core component STLB ("Standardleistungsbuch": Standard Specification System), a database-oriented text system for a standardised specification, serves with billing units and contractual accords as a basis for communication. Tools for CAAD, calculation, cost estimation and control as well as construction documentation and construction information systems can be used for common construction works. An accounting system is also connected to ensure a fast and verifiable digital billing of construction costs.

Technically the GAEB XML standard supports digital signatures for authentication as well as digital time locks, which prevent the opening of bids prior to the end of the tender floating period. There are predefined exchange protocols for all necessary data transfers, on the one hand between the different project members and, on the other hand, between the different project phases. Thus, data can be processed by the relevant interfaces from the level of an owner up to that of a manufacturer and from an invitation to bid up to an invoice. Data can, therefore, be directly exchanged between individual software tools as well as saved to and loaded from the required data resources, such as models, catalogues or calculations. The components and structure of the GAEB DA XML interface are pictured in Figure 5.1.
GAEB uses W3C’s open Extensible Markup Language (XML) for its protocols. The corresponding schemata can be obtained by the GAEB. As a result of this, the interface is considered to be easy to implement and to extend, which has led the GAEB standard to become widely used. Similar interfaces have also been developed by other organisations. Reports and web pages from ICIS provide an appropriate overview.

---

3 W3C: World Wide Web Consortium, certifies internet standards
4 http://www.icis.org
5.3 REQUIREMENTS FOR TENDER SOFTWARE TOOLS

Software tools for tendering are available with a highly varying range of functions. On the one hand, there are a lot of tools providing solutions for selected tasks, but, on the other hand, there are some products, which are able to support the complete process. Thus, the choice of tool for the tender phase is heavily dependent on the planned role of the software and the existing IT infrastructure. Potential criteria for main tendering functions are listed below:

- Compliance with tender and e-commerce regulations:
  Only software tools which comply with technical and legal regulations can be applied reasonably within a construction project. For the tender process, a strict confidentiality, distinct deadlines and strong commitment usually have to be ensured. Such requirements must also be satisfied within the scope of e-commerce. Various technologies, for example in the areas of digital signatures, digital time locks and encryption, exist for an implementation of them. European directives and national laws should also be considered when applying tender software to these technologies. Coincidently, all changes, innovations and reforms must be entered in the system. Tender software, therefore, always needs to incorporate appropriate updating possibilities.

- Integrated Workflow Support:
  The support of predefined processes and workflows is considered an important requirement for tender software. Due to strict regulations, the tender process is clearly described. Thus, workflows can support the processing within the software. Such functions increase the operating speed and ensure compliance with regulations. Using individual software components for the whole processing, an overall system for workflow support should be applied and connected with each tool.

- Subsidiary Functions:
  Depending on the task, subsidiary functions can be extremely helpful for an effective tender processing. Various functions are supported by modern tender software systems. Basically, item-based search and filter functions are considered as important tools for most types of application. Yet, other functions such as liquidity planning or document management functions should also be taken into account when choosing a relevant tool.
• Linking and Compatibility:
The previous description of the data exchange during the tender phase shows that the linking of various tools is necessary. This means that applied software products must be compatible with each other. Due to switching project partners, standard interfaces should be supported by the respective tools. Modern tender systems can, for example, be dovetailed into the processing of web platforms or combined with CAAD and cost estimation software. Thus, bills of quantities or construction accounts can be generated without manual intervention.

5.4 SELECTION OF TOOLS

Various types of software tools for the tender phase are introduced as examples below. The German software market is cited as an example here and, consequently, the selection focuses on tools supporting EU-wide tenders.

• Standardleistungsbuch-Bau (STLB-Bau), GAEB (http://www.gaeb.eu):
The standard specification system „STLB-Bau” is the most comprehensive collection of current, neutral and compliant tender texts on the European market. Several million technical specifications for common construction works are provided by this database. It is used for an automated generation of bills of quantities and ensures an explicit understanding from all parties concerned regarding the defined output. For public procurement this specification system has been mandatory in Germany since 1998. The “STLB” is prepared by the GAEB (“Gemeinsamer Ausschuss Elektronik im Bauwesen”: Joint Electronic Committee for Civil Engineering and Building Construction) and published by the DIN (“Deutsches Institut für Normung”: German Institute for Standardisation).

• ARRIBA Planen, RIB Software AG (http://www.rib-software.com):
“ARRIBA Planen” is a comprehensive software tool for the tender, costing, controlling and accounting of construction works. Certified by various standards (e.g. GAEB-XML) and recommended by the appropriate government agencies, this software is used by approximately 80% of the internationally active German contractors and nearly all major purchasers. It supports multilingualism with a full compatibility with all data and ensures an individual, task-related customisation of the
modularly-structured software. The main modules of “ARRIBA Planen” include functions such as the estimation of project cost, quantity calculations, the automated generation of bill of quantities, the invitation and comparison of bids, contract awarding and controlling, as well as construction supervision. Several resources help to integrate the system into the existing ICT infrastructure with regard to data transfer and workflow. Thus, connections to other necessary applications such as scheduling, operational accounting and tender databases can be established.

- **ARRIBA.net, RIB Software AG (http://www.rib-software.com):**
  “ARRIBA.net” is an internet platform for the complete electronic tender process. Due to the product’s high integration ability, documents can be transferred on this website without media disruption. The platform provides comprehensive features ranging from advanced information through to the commission of construction works. Functions include, for example, the structuring of tender documents, batch administration, management of bidder lists, controlling of tender workflows and forms, monitoring of deadlines as well as search and report tools. All national and EU-wide tendering procedures are supported according to the respective German regulations. Legal compliance is ensured by certified signature components and encryption systems. Tamper-proof tender records can, therefore, be generated, saved and exchanged. Specific role concepts and rights management guarantee respective users account control.

- **Allplan BCM, Nemetschek (http://www.nemetschek.eu):**
The software tool “Allplan BCM” comprehensively supports the tendering and accounting process of construction works from cost estimation via offers and orders through to billing. Features include, amongst others, CAAD based quantity calculations, automated generation of bills of quantities, several methods for cost estimation and modules for analytical price comparisons. Due to multilingual in- and output options, the software can serve for international projects. An excellent connection to other tools is achieved through certified interfaces and various exchange formats, which means that an effective cooperation between all parties involved within the project is possible. In this area, GAEB interfaces, as well as a bidirectional connection to the proprietary CAAD tool, are considered as key components. Additionally, interdisciplinary work is supported by workflow systems offering a schedule and assignment plans.
• Tenders Electronic Daily (TED), European Union (http://ted.europa.eu): “Tenders Electronic Daily” is a platform for tender announcements. It is maintained by the Office for Official Publications of the European Communities (OPOCE). As an online version of the Supplement to the Official Journal of the European Union (OJEU) it is needed for public notices on contracts, which have to be tendered EU-wide. Users can search and download invitations to bid. The website ensures international use through multilingual contents. In the long term, the public procurement regulations will be standardised within the EU. Several projects, in particular the PEPPOL (Pan-European Public Procurement Online) project, pursue a harmonisation of tender regulations, as well as the implementation of appropriate software systems.

• Electronic Marketplace (eMp), Deutsche Bahn AG (http://e-combau.noncd.db.de/) 
The electronic marketplace (“eMp”) of Deutsche Bahn AG serves as a comprehensive tender platform for construction and service projects within the entire railway group. Deutsche Bahn AG announces and presents all its construction related tenders – such as construction works, construction design, construction management, as well as health and safety – on this website. Bidders can search for appropriate tenders, download the specification documents and launch their bids. Regarding workflow, bidders receive status messages within the system. In particular, the submission protocols are disclosed automatically to each bidder. Applied e-commerce technologies, especially encryption and signature components, comply with prevailing regulations and, therefore, ensure that essential legal obligations are met. Bidders have to pay for the complete use of this tender platform. A registration on the electronic marketplace of Deutsche Bahn AG is subject to a yearly charge of approximately 200 Euro at the moment.

5.5 APPLICATION EXAMPLE OF TENDER SOFTWARE TOOLS

The multipurpose hall “Ratiopharm Arena” for the cities of Ulm and Neu-Ulm in Germany is being designed, built and operated as a public private partnership
project by the German construction company Max Bögl GmbH & Co. KG. By 2011 the first events, such as concerts and basketball games, will take place in this location. For a construction cost of about 28 million Euros it will accommodate 9000 visitors (Figure 5.2.).

Fig. 5.2. Multipurpose Hall Ulm (Animation by © ColorPoint)

The whole project is planned and controlled with the help of RIB’s new iTWO software. RIB iTWO is a 5D-ERP software solution developed particularly for the construction sector. Based on building information models (BIM), the tool provides a continuous support throughout all phases of a construction project, which means that the appropriate functions of its predecessor system ARRIBA are integrated. In this way, the tender phase can still be considered the core of RIB’s software, but the new tool also has many additional capabilities. Since 2010, Max Bögl has realised a company-wide changeover towards iTWO. The “Ratiopharm Arena” is one of the first major projects within which Max Bögl has worked with iTWO’s modern quantity surveying features.

For clash detection, all CAD documents, from structural work to interior completion, are loaded into a consolidated model. The respective CAD data formats are adjusted appropriately, thus the designs can be produced by various CAD tools. Finally, the new generated building model is automatically analysed by clash detection methods (Figure 5.3.).
The calculation of quantities and cost by iTWO is also based on the 3D model generated. Compliance with national and international standards, such as the German “Vergabe- und Vertragsordnung für Bauleistungen (VOB)” and the British “Standard Method of Measurement for Building Works (SMM7)”, an exact ascertainment of appropriate data is accomplished (Illustration 14). Additionally, detailed quantities of equipment or auxiliary supplies, e.g. formwork, are calculated according to given construction technologies and schedules. The information is combined with the bill of quantities and further construction specifications according to appropriate rules to provide a comprehensible basis for calculation.
With the help of the building information model, the compilation and processing of tender documents becomes faster, easier and – most notably – more transparent. Documents, such as bills of quantities and price comparisons, are generated automatically. As a result of this, all advertised construction works can be understood by the project members based on the model (Figure 5.5. and 5.6.).
Regarding the required information processing, predefined workflows ensure a centrally controlled exchange of information within the project. Thus, the software can consistently store essential data for the long term and ensures reusability for future projects. Cost estimation, therefore, has the capabilities to draw on the cost catalogues of completed projects. At the same time, the stored information can also be used for acquisition, submission and negotiations with subcontractors and partners.

During work preparation and construction, the project team benefits from the connection of the 3D model with scheduling and resource components. **5D** models constructed in this way ensure the direct controlling of performance, cost, resources and liquidity. Future values can be forecasted based on simulations. All target values are available from previous design phases, stored in iTWO’s building information model. Thus, iTWO forms a basis for prompt target performance comparisons.
Future developments of RIB will integrate model-based tools into the construction processes to an even greater degree. Based on iTWO, RIB plans a closer connection to SAP ERP, interfaces for the use of machine data as well as an expansion of communication capabilities within the system. The outlined example of Max Bögl’s “Ratiopharm Arena” shows that – with software like this – the construction sector is finally able to take a significant step towards the advantages of a “digital production”.
CHAPTER 6

COMPUTER AIDED CONSTRUCTION
PROJECT MANAGEMENT

(B. ZIELIŃSKI)

6.1 INTRODUCTION. INFORMATION ON EPM (ENTERPRISE PROJECT MANAGEMENT)

The development of civil engineering makes new, particular demands of software which assists management processes in this field. One of the symptoms of this phenomenon is a departure from single-user work, to network systems outfitted with project servers. Of course, this applies to large businesses, which manage many investments at simultaneously, often spread out territorially to a large degree. The solution applied in such a situation is EPM (Enterprises Project Management) systems.

Enterprises Project Management (EPM) constitutes a solution which integrates processes, people, organisational strategy, and technology, in order to provide genuine quality both to stakeholders, as well as organisations. Another definition is … EPM, or managing organisational projects is a methodology which combines standard project management processes and support tools in order to achieve the goals of the organisational project.

There are many programmes which support the planning and scheduling of a variety of undertakings available on the global market. Examples include, among others, Planista, PowerProject, Proficy Scheduler (manufacturing scheduling), Tymwise, Aurora (from the Stottler Henke Company), WhenToWork, KappixDroster, P2Ware, Microsoft Project, and Primavera Contractor. On the European market (and not only there) the leading products are undoubtedly those
of Microsoft and Primavera. This is why we shall concentrate on their two main (desktop) products – MS Project and Primavera Contractor.

The tools which make this possible are made available by, among others, Microsoft. These include Microsoft ® Office Project Professional, Microsoft ® Office Project Server, and Microsoft ® Windows SharePoint Technology.

![Single-Host Topology](source: [46])

Table 6.1. EPM Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows 2003 Server with Service Pack 1 or newer</td>
<td>The Microsoft Project Server and Microsoft SharePoint Services hosting server must be based on (at least) the Windows 2003 operating system</td>
</tr>
<tr>
<td>Microsoft® SQL Server 2000 with Service Pack 3 or newer or Microsoft® SQL Server 2005</td>
<td>The database management system for Project Server 2007 and Windows SharePoint Services 2007</td>
</tr>
<tr>
<td>Microsoft® SQL Server 2000 Analysis</td>
<td>Provides OLAP services, which are</td>
</tr>
<tr>
<td>Services</td>
<td>required by Portfolio Analyser from Project Server 2007</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Microsoft® Windows SharePoint Services 2007</strong></td>
<td>Gives access to workspace for every project published on Project Server, in order to manage information in the form of documents, risks, and other data lists</td>
</tr>
<tr>
<td><strong>Microsoft® Office Project Server 2007</strong></td>
<td>A server application which enables management of the project environment, in order to ensure communication between stakeholders of the project, enabling access to the central data warehouse for information on projects, etc. Microsoft® Project Server is, in essence a Web server with an engine which handles Web pages of anyone who has a stake in access to the data and accesses it via web browser.</td>
</tr>
</tbody>
</table>

### Client side

| **Microsoft® Office Project Professional 2007**    | A desktop client who enables the project manager to create and edit project timetables. Project layouts are stored in the Project Server 2007 database. |
| **Microsoft® Office Project Web Access 2007**      | Enables specific stakeholders (team members, resource managers, among others) who use web browsers to enter data and view the timetables and reports regarding the project portfolio. |
| **Microsoft® Office 2003 or 2007**                 | Used to create auxiliary documents, such as the project charter, specification of products, and others. |

In small and medium sized construction companies, there is (usually) no need to invest in such complex (and expensive) solutions as EPM. This is why we shall focus in this book on single-user work (without a project server and the other elements of its infrastructure). Microsoft products have a dominant position on the market, hence, our interest in them here. Slowly (with great difficulty), software from the company Primavera is becoming successful. The “counterpart” to the Microsoft Project software (the single-user version) is the programme Primavera Contractor.
One must remember, however, that an enterprise “on the road to success” will, in due time, have to change the way it manages its project portfolio and adopt (in terms of management computer systems) the use of a complete network structure. Of course, the road to a complete network structure begins with a configuration based on a single server, which will have all the database components installed. Usually a single-server installation will be scaled. It will support local authentication, instead of using Active Directory. Because of this, it is worth considering (in light of future developments) the procedure of introducing a system based on project servers, presented in figure 6.3.

Fig. 6.2. EPM Implementation and Deployment Methodology and Workflow
Source: [47]
A methodological aid to management processes (most often) is a collection of guidelines of project management, PMBOK® Guide (Project Management Body of Knowledge), published (four times now [48]) by Project Management Institute (PMI). This document is widely known and recognised as a collection of good management procedure (not the methodology of project management !!!). In figure 6.3, a model of project lifecycle management is presented (based on the PMBOK® Guide).

![Project Management Life Cycle Diagram](image)

**Fig. 6.3. Project Management Life Cycle**
Source: [48]

Processes are constructed out of tasks, for which (for each) the following can be defined:
- **Objectives** – provided by tasks.
- **Procedure** - speaks of how to utilize IT solutions in order to achieve the goals of each procedure.
- **Prerequisites** – data and presets required for the proper carrying out of tasks and support of procedures.

Microsoft Project and Primavera Contractor contribute to areas of knowledge such as:
- Time management – in terms of creating and supervising the timetable.
- Cost management – in terms of supervising costs.
- Human resources management – in terms of creating and handling resource use profiles.
- Communications management – in terms of (based on data regarding execution) accountancy of the project; reports and forecasts based on the earned value method.
- Market management – in terms of a (primitive) PERT analysis.
At the same time, it must be understood what place single-user versions of the programmes Microsoft Project and Primavera Contractor have in the management system. Contrary to the opinions of some “experts”, these programmes only enable one to set timetables (the full cycle, starting with entering the task list, through resource management, to drawing up the baseline plan), tracking the execution of tasks (in their full scope), as well as the documentation of the project (complete with export and import of data to other programmes) [49]. An especially important element is the availability (in both programmes) of tools carrying out the Earned Value Method [50].

6.2 MICROSOFT PROJECT 2007

Microsoft Project 2007 is a tool which enables the user to, among other things, schedule, as well as follow and evaluates the execution of any type of project, and, in the version based on a project server (Microsoft Project Server 2007), the execution of EPM tasks.

6.2.1 CREATION OF A NEW PROJECT

Of course, in order to create a new project, one must first launch the Microsoft Project 2007 programme. We perform this task analogically to how it is performed in the remaining programmes of the Microsoft Office Pack. Directly after launching Microsoft Project 2007, the Gantt Chart\(^1\) view is displayed. We begin work on the project with its description. In order to perform the tasks of this phase, one must (look at the table below):

<table>
<thead>
<tr>
<th>Problem</th>
<th>Mode of implementation/ Menu commands</th>
</tr>
</thead>
</table>
| Create the project file | • Using Project Guide Toolbar and Project Guide Task Pane  
• Creating a new project by using the new command from the File menu.  
• Using an existing Project Template or one from Existing Projects. |
| Determining the Start and Finish Dates of the Project | Open the Project Information Dialog Box:  
• From Project menu, choose Project Information.  
• Choose Project Start Date (if in Schedule from: |

| **Project Start Date** has been designated) or **Project Finish Date** (if in Schedule from: **Project Finish Date** has been designated). | • In the (respective) fields **Start date/Finish date** enter the appropriate dates. |
| Determining the calendar of the project | From the **Calendar** list, an appropriate calendar must be chosen:  
• Standard  
• 24hours  
• Night Shift. |
| Other attributes of the project | **Priority** (on a scale of 0 – 1000). Default value 500. The appropriate choice will allow for effective management of available resources. |

Microsoft Project (like every programme belonging to this category) is equipped with a calendar, which presents a chosen set up of working days and non-working days, organisation of the working week, year (and fiscal year), as well as the organisation of an individual working day.

When referring to calendars in MS Project 2007 we use the following terms:

• **Project Calendar** – the basic calendar used by the project.
• **Base Calendar** – a calendar, which can be used as the project calendar, and/or task calendar, determining the default working time and non-working time for a set of resources.
• **Resource Calendar** – a calendar determining the working time and non-working time for a single (specific) resource.

All of the options described can be viewed and otherwise edited (depending on needs) in the **Calendars** window, which can be viewed by choosing **Options** in the **Tools** menu.

The programme user can, using the appropriate dialog boxes:

• Create New base calendars containing the default working hours, default hours for specific resources (resource groups), hereinafter referred to as resource calendars and task calendars.
• View and edit working days and working time in any calendar.
• Edit task and resource calendars.

Changes made in the fields of the **Calendar** window and confirmed by clicking on **Set as Default** will result in setting the values as default, hence available directly after (each) running of MS Project. In practice, it often happens that the set default values of working time are unsatisfactory – in such a case one must
use the dialog box run with the command Change Working Time available in the Tools menu. This allows for modification of the default settings of the calendar. One can also create one’s own calendar (from the ground up, or permanently modifying the default calendar). To achieve this, an appropriate creator can be used, for example, Project Guide, selecting the Define general working times link (the creator allows one to adjust the calendar, in five steps) or creating it from the ground up, modifying the available project calendar.

### 6.2.2 CREATION AND EDITING OF THE SCHEDULE

Having a project description ready, we can begin work on the schedule. It is one of the most vital elements of the process. It requires a great deal of essential knowledge not only about connectionist methods, but also an excellent knowledge about the technology and organisation of construction work. It should be said immediately that tasks performed at this stage of creating the schedule have a fundamental significance towards further work on the project.

The starting point is the assumption that we have a set list of tasks and sub-tasks, as well as control points, from which we must create an organised structure, called a schedule.

In practice a task list can be created „top – down”, meaning, first determining and entering main tasks, later filling the list with sub-tasks or “bottom – up”. In the second case, we enter all tasks and sub-tasks; next we organise them in order to create the project structure. In both cases we must, due to the needs of the reporting and task completion evaluation systems, enter control points. We can, of course, import a task list or copy one from another file. First tasks must and their completion time must be entered. We carry this out in the Gantt Chart view.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Mode of implementation/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding tasks</td>
<td>• Entering a name of a given task in the Task Name field in the Entry table in the Gantt Chart view</td>
</tr>
<tr>
<td></td>
<td>• Copying tasks from other schedules.</td>
</tr>
<tr>
<td></td>
<td>• Importing task lists from Microsoft Excel and Microsoft Access.</td>
</tr>
<tr>
<td>Creating a summary and determining</td>
<td>In order to create a summary (a hierarchal structure) one must:</td>
</tr>
<tr>
<td>the task completion time</td>
<td>• Create milestones (duration 0), according to the needs of the project.</td>
</tr>
<tr>
<td></td>
<td>• Create summary tasks.</td>
</tr>
<tr>
<td>Recurring task</td>
<td>In order to create a recurring task, one must:</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• From the Insert menu, select the Recurring Task command.</td>
</tr>
<tr>
<td></td>
<td>• Determine the execution attributes:</td>
</tr>
<tr>
<td></td>
<td>− Task name;</td>
</tr>
<tr>
<td></td>
<td>− Duration;</td>
</tr>
<tr>
<td></td>
<td>− Range of occurrence – enter a start date for the first occurrence of this recurring task;</td>
</tr>
<tr>
<td></td>
<td>− End After (type number of occurrence, for instance 9) or</td>
</tr>
<tr>
<td></td>
<td>− End By (enter the date you want to recurring task to end);</td>
</tr>
<tr>
<td></td>
<td>− Under Calendar for scheduling this task select the calendar if you want to Apple calendar to the task or select None.</td>
</tr>
</tbody>
</table>

Task completion time (changing the contents of the Duration field):

• For milestones equal 0.
• For tasks – depending on previously agreed conditions. Elapsed time – for tasks carried out „all the time” (adding the letter “e” before the time unit (for example, eday).
• For summary tasks, time is not given; it is composed of those of its component tasks (sub-tasks).

Entering units in the Duration field, both their full and abbreviated names can be used. The fact that directly after entering the task name the completion time displayed is 1 day?, is because of the default settings on the Schedule table, available in the Options window in the Tools menu. In some cases, in order to make work easier, the default time value can be changed. Caution: in order to give up the default indicator of task completion time as estimated, one must de-select the option New tasks have estimated durations in the Schedule table. Whereas in the case of a single task one can open (double-clicking the task name) a dialog window Task information and in the Advanced table enable or disable the Estimated field.

The next stage of work on the schedule is the creation of project phases. In Microsoft Project phases are represented by summary tasks. Sub-tasks are displayed with an indentation, below summary tasks. It can be assumed that each phase should end with a milestone.
6.2.2.1 CREATION AND EDITING OF INTERDEPENDENCE (RELATIONS) BETWEEN TASKS

The created (and saved) task list is not a schedule yet. It is just the basis for its creation. The process of creating interdependencies between tasks is composed of four phases:

1. Creating a summary.
2. Creating relations between tasks.
3. Editing tasks and created relations, in order to fulfil all of the demands of the project.
4. Determining a critical path.

Yet before we begin the construction and editing of relations, let us find out what the different types are. In the case of Microsoft Project the basic, default type of relation is the **Finish-Start (FS)** relation. This means that the succeeding task begins directly upon completion of the preceding task. Between them, by default, there are no delays and we say that on such a relation the limitation **As Soon As Possible** is imposed. In the case of scheduling “from finish date” the limitation imposed will be **As Late as Possible**. The last entered concept belongs to the limitation category (we will get into these in great detail later). In practice, a relation may contain a lead – when the successor begins, before the predecessor is complete, or a lag – when the successor begins with a delay in relation to the predecessor’s completion.

<table>
<thead>
<tr>
<th>Description</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>No relation</td>
<td><img src="image" alt="No relation" /></td>
</tr>
<tr>
<td>Finish – Start (FS)</td>
<td>![Finish – Start (FS)]</td>
</tr>
<tr>
<td>Start – Start (SS)</td>
<td>![Start – Start (SS)]</td>
</tr>
<tr>
<td>Finish – Finish (FF)</td>
<td>![Finish – Finish (FF)]</td>
</tr>
<tr>
<td>Start – Finish (SF)</td>
<td>![Start – Finish (SF)]</td>
</tr>
</tbody>
</table>
6.2.2.2 CONNECTING TASKS

The relationships described above in connection with the (organised) task list are the basis for creating a schedule. The process of connecting tasks can be carried out using a few basic methods.

1. We can connect all tasks, at the same time creating between them the default relation of FS. In order to do this we must:
   a. Select All tasks intended to be connected by the Finish – Start relation.
   b. Click the Link Tasks button on the standard toolbar, or Press Ctrl+F2; you can also select the command Link Tasks from the Edit menu.

All of the previously selected tasks will be connected with the FS relation. If we were to need to undo the created relationships for some reason, we could click the Unlink Tasks button or press Ctrl+Shift+F2, or select the command Unlink Tasks from the Edit menu. From a practical point of view, there are many approaches to the creation of relationships. In the Task information dialog window, using the Predecessors table, we can indicate a Predecessor or predecessors (since every task can have multiple predecessors) of the task being analysed.

2. The last method discussed in this part is the connection of tasks through dragging. The relationship is created in the following way; we indicate the bar of the task which is the predecessor; and, next, clicking and holding the left mouse button, we drag the indicator to the bar of the task which is the successor. An FS relationship is created (by default).

The schedule created can be a starting point for further work, the essence of which shall be modifying select qualities of individual tasks.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Mode of implementation/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing relationship types between tasks and removing connections</td>
<td>• Double click on the relation between tasks in order to open the Task Dependency dialog window and choose the appropriate relationship from the Type drop down list or&lt;br&gt;• Select the relation, and on the standard toolbar click the Unlink Tasks button or press Ctrl+Shift+F2 or&lt;br&gt;• In the Task Information dialog window, use the Type drop down list in the Predecessors table.</td>
</tr>
</tbody>
</table>
### Adding a lead or a lag

- Double click on the relation between tasks in order to open the **Task Dependency** dialog window and, in the **Lag** field, entering the appropriate the appropriate time of the lag (using a „plus“ sign) or the lead (using the “minus” sign).
- In the **Task Information** dialog window, use the **Lag** field in the **Predecessors** table.

### Splitting tasks

- In order to **Split Task**, in the **Gantt Chart** view, click the **Split Task** button on the standard toolbar, and drag the mouse cursor, observing the contents of the **Split Task** information window, to a new location.
- In order to be able to split tasks while executing a project you must choose **Split in-progress tasks** in the **Schedule** table in the **Options** window.

### Task Drivers

- Select task,
- Click the **Task Drivers** button or
- From the **Project** menu, choose the **Task Drivers** command. As a result, a window will open, the “contents” of which depend on the situation (the type of task selected).

### Limitations

- Select the task which is to have a limitation set.
- Double click the name of the task in order to open the **Task Information** window.
- Activate the **Advanced** table.
- From the **Constraint Type** drop down list, select the appropriate limitation. The date of the limitation may be entered from the calendar available in the **Constraint Date** field.

### 6.2.2.3 LIMITATIONS IMPOSED ON TASKS

Until now, creating an example schedule, we spoke solely of a situation in which the successor task should be executed immediately after the predecessor task. We also mentioned that the default limitation imposed in this case is – As soon as possible. Microsoft Project also makes a number of other types of limitations available. They could be divided into three groups:

- **Highly flexible** – these are not dependent on a specific date. This group contains: **As Soon As Possible** as well as **As Late As Possible**. The
programme can change the start and finish time of the task, but not its duration.

- **Inflexible** – the programme has a limited freedom in the start or finish date changing process. The limitation date is determined. This group contains: *Start No Earlier Than*, *Start No Later Than*, *Finish No Earlier Than*, *Finish No Later Than* – set date.

- **Highly inflexible** – limitations strictly tied to a specific date. The task must begin or finish on the set day. This group contains: *Must Start On* and *Must Finish On*.

Introducing limitations is an action related to the specific structure of tasks within the project. There are no general rules here which can be applied to all projects. Because of this, care must be taken, and, as usual, restraint in using them.

### 6.2.2.4 CRITICAL PATH

The crowning achievement of the work that goes into creating a schedule is designating the tasks which directly influence the completion time of the project. They are called critical tasks, and compose the critical path. In Microsoft Project the **Gantt Chart Creator** is responsible for designating the critical path. In practice, a situation may arise in which the critical path is composed of tasks with a Slack different than zero. The size of Slack, which is a criteria used to designate critical tasks, can be determined using the **Tasks are critical if slack is less than or equal to ... days** option, available in the **Calculation** table (**Tools** menu, **Options**).

### 6.2.3 RESOURCES – CREATION, ALLOCATION, IDENTIFICATION, AND REMOVAL OF EXCESSIVE ALLOCATION

Creating schedules, we answer the question of what is to be done and when. Now we must answer another question – what levels of resources are to be used to complete the designated tasks and how?

#### 6.2.3.1 TYPES OF RESOURCES

The Basic value contributed to the project by resources is work. We distinguish between the following groups of resources:

1. **Work resources** (renewable) – these include people and equipment, using time to measure their involvement in the project. In the case of every resource assigned to a task, work is the number of man hours/machine hours required to
complete it. The total work of the task is the sum of the work of all resources assigned to it.

2. **Material resources** (non-renewable) – resources consumed during project completion (materials, energy, etc.), using consumption, measured in concrete physical units, to measure their involvement in the project. Materials can have a specified fixed or fluctuating rate of consumption.

3. **Cost** – this type of resource makes it possible to determine how work or costs will be allocated during the project’s life-cycle.

Detailed information regarding a resource can be obtained by double clicking on its name or clicking the **Resource Information** (Shift + F2) button, on the standard toolbar. As a result, the **Resource Information** dialog window will be displayed.

### 6.2.3.2 ASSIGNING RESOURCES

In order for the resource list created to be used during planning and following the execution of the project, it must be related to its tasks. This operation is called assigning (allocating) resources. The engagement of the resource is measured in allocation units. Allocation units represent the resource time percentage assigned to the task.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Mode of implementation/ Menu commands</th>
</tr>
</thead>
</table>
| Creating a resource list     | • Manual entry of data regarding resources (especially their names and maximum available „amount‟) into the appropriate table (view).  
• Adding a resource based on an e-mail address book.  
• Drawing data on resources from an MS Excel calculation sheet or other source (such as a database, for example, from MS Access).  
• Using the Active Directory. |
| Assigning resources          | • **Entry** table, **Resource Names** field.  
• In the **Gantt Chart** view, double click on the task name and in the **Task Information** dialog window activate the **Resources** table and allocate resources, marking the % of their engagement as well.  
• If many resources are allocated (simultaneously) to one task or (simultaneously) one resource is allocated to many tasks we use the **SHIFT** and/or |
6.2.3.3 TYPES OF TASKS AND USE OF RESOURCES. FORMULA DESCRIBING THE WORK OF THE RESOURCE

The default method of creating a schedule in Microsoft Project is drawing it up using effort driven scheduling. This means that depending on the number of units of a resource added or removed the task completion time changes. When we increase the resource allocation of a task, it decreases the amount of work expected to be done by the resource.

Selecting the type of task can take place in the Tools, Options dialog window, Schedule table. It is obvious that what is determined here will influence the entire project (all tasks). If the Set as Default button is clicked, the choice will concern all projects being carried out on this computer. Whereas when we intend to make a change in terms of a single task, we should select it (in the case of several tasks – use Ctrl to select the tasks), next, display the Task Information dialog window (in the case of several tasks - Multiple Task Information). Activate the Advanced table, next, in the Task type field, and choose the appropriate element from the drop down menu.

<table>
<thead>
<tr>
<th>Type of task</th>
<th>Description</th>
</tr>
</thead>
</table>
| Fixed Units (default) | Adding resources to a task shortens its completion time, but it does not change the degree of use (Project does not calculate it) of the resource. If the Effort driver option is disabled, Project calculates the completion time of the task, as long as there is a change in the amount of resources allocated to it, and calculates the resources allocated to the task, when its completion time changes. This happens according to the following rules:
  • If we change the completion time, the amount of work also changes, whereas the units of allocation shall remain unchanged.
  • If we change the amount of work, the completion |
time changes as well, whereas the units of allocation shall remain unchanged.

- If we change the amount of units, the completion time changes as well, whereas the amount of work remains unchanged.

**Fixed Duration**

The more resource units are allocated to a task, the less work has to be done by each resource allocated. This is because MS Project calculates the use of resources assigned to a task when they change, but it does not calculate the completion time of the task when resources change, and does not calculate resources when the task completion time changes. If the option ‘according to work put in’ is disabled, then Project does not calculate resource use in the task or the task completion time, when the resources allocated to the task are changed. This happens according to the following rules:

- If we change the number of units, this also changes the amount of work, whereas completion time remains unchanged.
- If we change the amount of work, the number of units also changes, whereas the completion time remains unchanged.
- If we change the completion time, the amount of work changes as well, whereas allocation units remain unchanged.

**Fixed Work**

Adding resources causes work to be divided between allocations and task completion time shortens. This happens according to the following rules:

- If we change the completion time, the amount of units changes as well, whereas the amount of work remains unchanged.
- If we change the number of units, completion time will change, whereas the amount of work remains unchanged.
- If we change the amount of work, the completion time changes as well, whereas the number of units remains unchanged.

Understanding the scheduling process of resource work is vital to being aware of the problems tied to removing their excessive allocation, as well as optimisation.
of the schedule. When the work resource (our considerations do not pertain to material resources) is allocated to a task, at first Project allocates the resource based on the task schedule. In doing so, it applies the following rules:

1. When we allocate a resource to a task, Project schedules the work of this resource from the moment when the task begins, to the moment it is complete with equal intensity.
2. (By default) Project allocates work only when the resource is (according to its calendar) available. This means that work is not allocated during work-free time, during holidays, vacations, etc. In other words, the task schedule reflects the work time according to the resource calendar.
3. If there is a task calendar assigned to the task; MS Project (by default) schedules work only in those timeframes which comply with the availability of the resource according to both the task and resource calendar.
4. The amount of work allocated on any given day is the ratio of the number of work hours determined for that day in the appropriate calendar to the unit number of the resource allocated to the task. The programme performs the calculations described directly after allocating the resource to the task. It calculates both initial task start dates, as well as their initial duration. Of course, we can modify these allocations and their calculation results. Changes introduced can pertain to:
   - Delays in starting work of a given resource in relation to the start date of the task, at the same time allowing other resources to begin work in accordance with the task start schedule.
   - A break in workflow due to introducing the splitting of the task.
   - Project allocates work uniformly spread out. We can, by changing the work schedule profile manually, change the resource’s engagement in different phases of completing the task. In order to do this we can use predefined work schedules (profiles).
   - If there is a resource of excessive allocation (over-allocated) in the schedule, we can add a balancing delay to one of the allocations.

When allocating a resource to a task we must at least identify the resource being allocated. Project then attributes it with the default values related to it. Many resources can be allocated to a task. The fields in which we enter this information can take on a form as seen below. We reach the view by choosing the Split command from the Window menu. The view displayed contains the Gantt Chart in the upper panel, and the Task Form in the lower one.
6.2.3.4 ALLOCATION OF MATERIAL RESOURCES

Experience tells us that materials can be calculated as resources of:
1. **Fixed consumption** – a numerical value is entered in the Max. Units field and regardless of how much time the task takes to complete, consumption (the Work field) will correspond to the number of units entered.
2. **Fluctuating consumption** – in this case material consumption depends on how much time the task takes to complete. In the Units field one should enter consumption, next, a slash (/), and, finally, a unit of time (for example, 4m/d). In such a case, Project, in the Work field, will calculate the consumption of material depending on the length of the project that the resource has been allocated to.

6.2.3.5 COST RESOURCE

The Cost resource gives a chance to determine how work or costs shall be allocated during the project’s life span. For example, we wish to budget the cost of a unit of memory used in the life cycle of the project. In order to do this we must:

- Create the resource in the Resource Sheet.
- Set the resource type as Cost.
- Double click on the name of the resource or the Resource Information button (on the standard toolbar) or press Shift+F2. In the Resource Information dialog window mark the Budget field.

This way we create the resource of Cost. In the resource sheet one should notice that most fields are inactive – Project does not allow the introduction of any information regarding this resource.

6.2.3.6 IDENTIFYING THE OVER-ALLOCATION OF RESOURCES

Due to the scope and purpose of the handbook we shall limit ourselves to a few basic and most commonly used methods of identifying over-allocation. These are:
2. Review of the Resource Graph.
4. The Over-allocated resources report.
6.2.3.7 REMOVING OVER-ALLOCATION OF RESOURCES

The over-allocations detected must be removed, but this is not a process independent of others. Removing over-allocation has an important influence on the schedule; this should be taken into account when doing so. We call the process of removing over-allocation balancing resources. It must be remembered that if the schedule has a flexible finish time (hence, it was created from the date of starting the project), MS Project will attempt to level the over-allocation by shifting the finish date of the project. The programme will attempt to introduce a balancing delay.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Mode of implementation/ Menu commands</th>
</tr>
</thead>
</table>
| Automatic levelling of over-allocation | • Save the current state of the project.  
• Indicate the task/tasks which are to be leveled.  
• From the Tools menu, choose the Level Resources command.  
• Set the conditions of the leveling.  
• Click the Level Now button. |
| Manual levelling of over-allocation | • Increasing the amount of resources over-allocated.  
• Changing the task execution schedule.  
• Determining the amount of work in overtime.  
• Changing the relationships between tasks.  
• Changing the detail level of the project and removing resources allocated in less important tasks.  
• Replacing the over-allocated resources with resources which are not.  
• Changing the calendar, allowing to increase the number of working days during the time of executing the project or prolonging the working day.  
• Decreasing the amount of work assigned to the resource.  
• Changing the use profile of the over-allocated resource. |

This method is the basis for automatic levelling of over-allocated resources, and its result can be a shift in the finishing time of the project schedule. The possibility of delaying the task is decided by whether or not it possesses reserves of time. If the tasks are connected, the programme checks existing relationships.
between tasks. The goal of this is to ensure that the improvement of one task does not negatively impact another which is related to it.

In the case of schedules constructed from the finishing date, introducing a balancing delay does not, in fact, make sense.

Before we begin levelling resources, we should take into account the following factors:

- The basic factor which determines the success or failure of optimisation is a very good knowledge of the schedule and entire project on the part of the person performing the optimisation.
- Tasks in the schedules constructed based on the project finish date (found in the Project Information window) do not have time reserves, so they cannot be delayed, unless instead of a path, a critical path has been defined for them (a series of tasks for which the total time reserve is equal in value and other than zero). In the case of schedules based on a critical path we are left with manual levelling of resources. It could seem that MS Project, when shifting tasks, takes into consideration their order (apparent in the logical structure of the project). This, however, is not the case. This can lead to misunderstandings; one must maintain caution.
- Automatic levelling may cause serious changes in the schedule. Hence, if the schedule is very complex or we want to limit the scope of changes then we should level only one resource at a time, followed by conducting an inspection of the effects of the operation.

It would be ideal if every over-allocation could be removed using only the methods described in this chapter of the tools. Situations do arise, however, in which, despite one’s best efforts, over-allocation cannot be levelled. In such a situation the only solution is a detailed analysis of its causes and taking particular remedial measures and, in extreme cases, even modifying the schedule.

As a result of operations performed, MS Project will change resource allocation. Working with the Gantt schedule is very effective. Using the Resource Use view allows us, in turn, to focus on resource conflicts. We must remember, however, that the operation must be thoroughly thought out, so that it does not influence other elements of the project negatively.

We can also input additional resources, using the Resources table of the Task Information dialog window. It is enough, in such a case, to indicate the task, and then input the name and unit number of the new resource. The programme automatically performs the task of allocating it. We can also, abandoning precision, increase the amount of resources assigned to the project – using the Resource Sheet view directly.
6.2.4 RESOURCE COSTS

Up to this point we have not considered the costs of the project. These are made up of planned costs (budget) regarding work, meaning employee wages, equipment fees (cost of use), fixed costs, and material costs. The problem is important not only due to the need to fix the price of the project. It must be known that the planned costs and their execution constitute the foundation of one of the basic methods of overseeing and prognosticating project execution – the Earned Value Method.

6.2.4.1 WORK RESOURCE COSTS

In general, knowledge of project costs allows its manager to:

1. Accurately estimate the project budget.
2. Precisely appraise the scope of deviation from planned values in the budget as well as determining the causes of these deviations.
3. Determine the investment risk of the project.
4. Determine the earning capacity of the Project.

The work resource costs in MS Project are composed of wages, costs of use, and fixed costs. Work with each of these elements requires a peculiar approach.

6.2.4.1.1 SALARIES AND COSTS OF USE

Information on resource costs can be entered as follows:

1. Display the Resource Sheet.
2. Double-click on the resource name. A Resource Information dialogue box will be displayed.
3. In the Resource Information window, it is necessary to activate the Costs table. It is used to enter, review or modify cost information for a given resource.
4. Create a cost table for a resource. The Resource Information, Costs window provides the following options:
   a. Obtaining information on costs of a given resource by filling out the fields Standard Rate, Overtime Rate and Per Use Cost.
   b. It is possible to indicate rate changes depending on time. To this end, we use the Effective Date field, allowing for specification of the date of introduction of the new rate. In each table, it is possible to enter 25 rate modifications. Changing the rates, it is not necessary to enter amounts. For instance, it is possible to enter: upon increase +15%, upon decrease -12%. The programme will make the appropriate calculations on its own.
c. If a resource is allocated to various tasks, it is possible to establish various cost rate tables for different tasks. Bookmarks A, B, C, D and E are used for this purpose. This is due to the fact that apart from the basic task rates, a resource can have four other rate values assigned, for instance, for playing other roles in the project.

d. In the Cost accrual field, by selecting the appropriate option from the drop down list (Start, Prorated, End), it is possible to specify the mode of payment for work (the mode of calculation of the resource cost).

5. After entering the rates, click on OK. The rates will be allocated to resources, and Microsoft Project will make the appropriate calculations (by multiplying the resource rate by its involvement in the task, and then adding up the partial costs obtained and adding the remaining costs).

Using the specific rate values, the programme multiplies them by the duration of appropriate tasks (that is, those tasks, to which specific resources are allocated) and adds up the partial results. In this manner, we obtain the cost settlement. In order to review the project costs, we can use the Cost table. It can be displayed (instead of the Entry table), by choosing in the View, Table menu the Cost item. It is also possible to check the resource cost in the project. To this end, the Cost table may also be used, but it is displayed in the Resource Sheet view. Another problem is settlement of costs of a resource, which performs various tasks in the project, at varying rates. In such case, it is necessary to indicate in the programme which rate is to be taken into account each time.

6.2.4.1.2 COSTS OF MATERIAL RESOURCES

We are dealing with two types of material consumption – fixed and variable. In the first case, we have a specific amount of materials for the entire task. In the second case consumption is determined by the task duration. In order to determine the material resource costs at a fixed consumption rate, it is necessary to:

1. Enter the Resource Sheet view.
2. Make sure that the Entry table is displayed. To do that, it is necessary to select the Table command from the View menu and make sure that the Entry item has been marked. If not, mark it.
5. Make sure that the Material item has been selected in the Type column for the resource indicated.
6. In the Material label field, enter the material measurement unit.
7. The resource unit price is to be entered in the Std. Rate field.
8. If additional costs are borne in association with a given material resource, such as rental of an unloading machine or other charges, enter these in the Cost/Use field. In the case of variable consumption, we enter the resource consumption rate per task completion time unit.

No calendars can be assigned to material resources.

6.2.4.1.3 FIXED COSTS

A fixed cost is an established cost of a task or resource, which does not change over the task duration time or quantity of work performed by a resource. In the Fixed Cost field, enter the appropriate value, and in the Fixed Cost Accrual field, select the calculation mode from the drop down list.

6.2.5 FINAL PROJECT PLANNING STEP

We finish the planning process – all tasks and relationships between them have been defined, resources have been allocated and leveled, the critical path has been established. The project file has been saved. It is necessary to „close” the project by making a snapshot of its status. From the time of saving, we consider the project to be ready for implementation.

To save the baseline plan, it is necessary to:

1. From the Tools menu, select the Tracking, Set Baseline command. The Set Baseline dialogue box will open.
2. Specify the conditions of baseline saving and click OK.

Saving can be controlled in the Project Statistics for …window.

6.2.6 PROJECT IMPLEMENTATION TRACKING

Sooner or later, the implementation of every project begins. After it is adapted to the new conditions – if necessary – its implementation must be tracked. The first thing that needs to be done is creation of a baseline plan – a baseline plan is the image of the final project, saved prior to the commencement date. It should be assumed that the baseline plan will serve as a reference point in the process of assessment of the project implementation. The project implementation can be tracked:

1. Through tasks.
2. Through resources.
3. Using the progress line.
Moreover, at any point during the project lifecycle, it is possible to modify or restructure the baseline plan, if the users agree that the changes that have emerged enforce such decision. The saving of many baseline plans may prove useful, particularly in the case of long-term projects, or those in which the tasks or costs specified in the schedule have been modified substantially, making the data in the initial baseline plan inadequate. In practice, it is possible to save eleven different baseline plans.

**Attention:** if it is necessary to modify the existing baseline plan, changes can be introduced, after which the baseline plan is to be saved again, as described above. If changes pertain only to selected tasks (or one task), it is necessary to choose the **Selected tasks** option in the **Set Baseline** dialogue box.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Updating of tasks. Use of the **Update Tasks** window | • Using of the appropriate buttons on the **Tracking** toolbar.  
• The **Update tasks** dialogue box, available in the **Tools, Tracking, Update tasks** menu. It is possible to enter data on: **% Complete**, **Actual Duration**, **Remaining Duration**, **Actual Start/Finish Date**.  
• The **Task information** dialogue box, accessible after double clicking the task name in the Gantt Chart view or by indicating the task and clicking (on the standard toolbar) on the **Task Information**. The **Percent complete** field, in which we enter the percentage values of completion of individual tasks, is available in the **General** table. |
| Project updating. Using the **Update Project** window | • **Update work as complete through** – allowing for marking of the entire work planned as completed until the established status (condition) date.  
  – (**Set 0% - 100% complete**; selection will allow for specification of the percentage value of work performed between 0 to 100% on the basis of the date in the field **Update work as complete through (date)**). Tasks that have not been started are set to value 0; completed tasks – to 100%, and for tasks that are in progress, the programme calculates the completion value in % and sets this value as **Complete %** |
- **Set 0% or 100% complete only** – using the option **Set 0% or 100% complete only**, we make sure that tasks commenced, which are to be completed until the status date, are marked as 100% complete, and those that are not commenced prior to the status date, are marked as not completed (0%).

- **Reschedule uncompleted work to start after ...** changing the non-completed work schedule to be commenced at a (new) established date.

**Assessment of the level of completion of project tasks**

- **Tracking and Work tables.**
- The **Tracking Gantt** chart
- Progress lines.
- **Earned Value Method**

**Updating through resources (work)**

- The **Work table**
- The **Task Use view**
- The **Resource Use view**.

Since we are dealing with a plan delivered for implementation, a baseline is saved for it. Other fields are a result of a simple calculation:

\[
\text{Work according to baseline plan} - \text{Actual work} = \text{Remaining work}
\]

and

\[
\% \text{ Complete work} = (\text{Remaining/according to baseline plan}) \times 100\%
\]

and they do not require an additional description.
6.3 PRIMAVERA CONTRACTOR

6.3.1 STARTING WORK WITH THE PROGRAMME

We start work by using the options provided in the start-up window Primavera.
Welcome. What would you like to do?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of a new project</td>
<td>Click on <img src="image" alt="Create New..." /> A new project wizard is launched.</td>
</tr>
<tr>
<td>Opening (launching) of an existing project</td>
<td>Click on <img src="image" alt="Open Existing..." /> The Open Project window is open. Select project and click on <img src="image" alt="Open" />.</td>
</tr>
<tr>
<td>Opening (launching) of the most recent project edited</td>
<td>Click on <img src="image" alt="Open Last" /></td>
</tr>
</tbody>
</table>

It is possible to enforce omission of the start-up window by marking option Don’t show this Window again. In such a case, we open a project by clicking on Ctrl+O. The project will open in the Activity Workspace.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Creation of a new project, containing no activities | File, New – The Create a New Project wizard is launched, which requires the following information:  
  • Project ID – a code of a maximum of 20 characters;  
  • Project Name;  
  • Planned Start date, which is the earliest date any un-started activity will be scheduled to commence and an optional Must Finish By date.  
  • Resource Rate Type. Each resource may have five different rates. This is where the default rates are selected but may be changed after a resource has |
### 6.3.2 DEFINING CALENDARS

Primavera Contractor provides three categories of calendars:

- **Global** – these are available for all projects and resources.
- **Project** – these calendars are only available to the projects they are created for and may only be created for the project when that project is open.
- **Resource** – A Resource calendar may be assigned to one or more resources, which in turn may be assigned to an activity in any project. Resource will be scheduled according to a Resource calendar when the Activity Type is set to Resource Dependent. Otherwise the activity is scheduled according to the Activity Calendar.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning of the Default Project Calendar.</td>
<td>A calendar is assigned to new tasks using the Project Properties form. To this end: select from the Project, Project Properties …, menu the Default table.</td>
</tr>
<tr>
<td>Creating, copying, editing or deleting a calendar</td>
<td>In the Dictionaries, Calendars … menu, select Global, Project or Resource and click on to create a new calendar, to modify an existing one or to delete an existing calendar</td>
</tr>
<tr>
<td>Change the name of an existing calendar</td>
<td>Dictionaries, Calendars …, select Global, Project or Resource, double-click on the description and then modify the calendar selected.</td>
</tr>
</tbody>
</table>
6.3.3 ADDING ACTIVITIES

An „empty” schedule is to be filled with activities. Creation and specification of sequences of detailed and summary activities will be discussed according to the following division:

- Understanding **Activity Codes**.
- Creating **Detailed** Activities (in this chapter).
- Adding the logic (relationships).

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting the Auto-numbering Defaults and other default values for new activities</td>
<td>In the Project, Project Properties … menu, select the Default table. Use the Auto-numbering Defaults workspace fields.</td>
</tr>
<tr>
<td>Adding of new activities</td>
<td>Indicate a new row and press <strong>Insert</strong>, right-click and select the <strong>Add</strong> command or click on <img src="image" alt="Add" /></td>
</tr>
<tr>
<td>The Activity Details form</td>
<td>It can be displayed in the lower window panel, selecting in the View menu the commands <strong>Show on Bottom, Activity Details</strong>.</td>
</tr>
<tr>
<td>Copying of activities in Primavera Contractor</td>
<td>Indicate the appropriate activity and use the (known) <strong>Copy and Paste</strong> commands.</td>
</tr>
<tr>
<td>% of completion of activity</td>
<td>In the <strong>General</strong> table of the Activity Details form, use a drop-down list <strong>% Complete Type</strong> (Physical, Duration, Units).</td>
</tr>
<tr>
<td>Milestones</td>
<td>In the <strong>General</strong> table of the Activity Details form, use a drop-down list <strong>Activity Type</strong> (Task Dependent, Resource Dependent, Level of Effort, Start Milestone, Finish Milestone).</td>
</tr>
</tbody>
</table>

6.3.3.1 ACTIVITY DURATION TYPE

**Duration Type** options affect how the schedule calculates until one or more resources are assigned to an Activity. The following duration types can be distinguished:

- **Fixed Units** – this option is used when the amount of work required to finish an activity is constant.
- **Fixed Duration and Units/Time** – this Duration Type disables the User Preferences, the Calculations table, option **Recalculate the Units**, ...
Duration, and Units/Time for existing assignments Based on the activity Duration Type:
- (Option 1) – is used when the Duration of an activity should not change when Resources are added or removed or Units/Time change.
- (Option 2) – a change in the Duration will change the Units; however, the Units/Time will remain constant.

- **Fixed Units/Time** – this option is used when the same numbers of people are required to complete an activity regardless of the activity duration.

- **Fixed Duration & Units:**
  - (Option 1) – is used when the Duration of an activity should not change when Resources are addend or removed or Units/Time change.
  - (Option 2) – A change to the Duration will change the Units; however, the Units/Time will remain constant.

6.3.3.2 ACTIVITY TYPES AND MILESTONES

We have the following activity types at our disposal:

- **Task Dependent** and **Resource Dependent Activity** have durations and will only calculate differently when one or more resources are assigned to an activity.

- **Level of Effort** – there is no equivalent in the MS Project. It allows for control of the commencement and completion dates. No limitations can be imposed upon these tasks.

- **Start Milestone** and **Finish Milestone** – in the programme (unlike in MS Project), there is a difference between the start milestone – associated with the project commencement date, and the finish milestone – associated with the completion date.

6.3.3.3 ACTIVITY INFORMATION– THE LOWER PANEL

<table>
<thead>
<tr>
<th>Table</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The form provides data on:</td>
</tr>
<tr>
<td></td>
<td>• Activity ID and Activity Description</td>
</tr>
<tr>
<td></td>
<td>• Project – the project name (non-editable)</td>
</tr>
<tr>
<td></td>
<td>It also displays the activity attributes, available in the Project Properties form, such as:</td>
</tr>
<tr>
<td></td>
<td>• Activity Type, Duration Type, % Complete Type, Activity Calendar, WBS and Primary Resource.</td>
</tr>
<tr>
<td>Status</td>
<td>In the Status table, it is possible to enter/edit the</td>
</tr>
</tbody>
</table>
following data:

- **Durations**
- **Status** – actual dates can be provided (Actual Dates) for commencement and completion of activities, as well as % Complete
- **Constraints** – activity constraints can be imposed
- **Labor Units** – displaying the labor hours (units)

**Summary**

The form (table) presents activity information. The type of information displayed - **Units, Costs, Dates** – is selected by marking of the appropriate option in the Display …

**Resources**

Resources can be allocated to tasks and the appropriate information is displayed

**Expenses**

Expenses can be added and edited here

**Notebook**

The table allows for adding and editing notes on activities

**Steps**

This function allows for division of activities into sub-activities known as **Steps**, used during the implementation of project tasks (equivalent to sub-tasks completed)

**Codes**

The form allows for creation and assigning of project codes

**Relationships**

These tables are used to add activity predecessors and successors, which can also be edited

---

**6.3.3.4 ORGANISATION OF ACTIVITIES USING THE PROJECT WBS**

WBS is used to group and summarize activities according to a hierarchical structure. The project is divided into workspaces managed, based on such attributes as phases or stages, sub-systems, processes, business areas or locations. The structure is defined by the Project Manager, since none of the programmes discussed implements these functions on its own. The Primavera Contractor is equipped with the **Activity Code** function, similar to the **Custom Outline Codes** in the MS Project. This allows for grouping of activities

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation and edition of the WBS node</td>
<td>It is possible to use the Add, Delete, Copy and Paste commands to create, delete, copy and paste nodes</td>
</tr>
<tr>
<td>Assigning of WBS nodes to tasks</td>
<td>Creation of activities at the available WBS structure</td>
</tr>
</tbody>
</table>
# CONSTRUCTION MANAGERS’ LIBRARY

## 6.3.3.5 ADDING RELATIONS

The process of creating (adding) relations to activities created allows for the creation of a logic describing the project implementation in detail. We are dealing with two types of such logic:

- **Relationships (Dependencies or Logic or Links between activities).**
- **Imposed Constraints** to activity start or finish dates.

As for relations, there are two types of these:

- **Hard Logic**, also referred to as **Primary Logic**, are dependencies that may not be avoided.
- **Soft Logic**, also referred to as **Sequencing Logic, Preferred Logic** or **Secondary Logic** may often be changed at a later date to reflect planning changes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic in the toolbar chart display</td>
<td>Drag the mouse cursor from one task to another</td>
</tr>
<tr>
<td>Opening the Activity Details form</td>
<td>Predecessors and successors can be added to activities and removed in the Relationships table, in the Predecessors and Successors workspaces</td>
</tr>
<tr>
<td>Adding and deleting of relations using the Edit Relationship form</td>
<td>Double-click on the line of relationships between tasks. The Edit Relationship form will be opened.</td>
</tr>
<tr>
<td>Assign Predecessor and Assign Successor forms as appropriate</td>
<td>• Selection from the Edit, Assign, Predecessors … or Edit, Assign, Successors, or • Clicking on Assign buttons in the appropriate</td>
</tr>
</tbody>
</table>

---

**Table**: The WBS node separator

<table>
<thead>
<tr>
<th>The WBS node separator</th>
<th>From the Project menu, display the Project Properties form, table Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBS categories</td>
<td>WBS categories are created using the Settings, Categories … menu commands, the Project Phase table, and assigned to WBS nodes by inserting the Project Phase column in the WBS working space</td>
</tr>
</tbody>
</table>
workspaces of the **Activity Details, Relationships** form

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying the <strong>Predecessor</strong> and/or <strong>Successor</strong> columns</td>
<td>Double-clicking on the predecessor or successor cells to open the <strong>Assign Predecessor</strong> and <strong>Assign Successor</strong> forms</td>
</tr>
<tr>
<td>Creation of a chain or automatic connection of activities using the</td>
<td>Indicate activities to be connected and right-click with the mouse button. Select the <strong>Link Activities</strong> command from the context menu</td>
</tr>
<tr>
<td>commencement – completion relationship</td>
<td></td>
</tr>
</tbody>
</table>

### 6.3.3.6 CONSTRAINTS

Constraints are among the most significant components that organise the network of activities (schedule). The minimum numbers of constraints that are applicable to the Primavera Contractor are:

- **Start On or After** (also known as the „Early Start” or „Start No Earlier Than”) is applicable, when the activity commencement date is known and there is no predecessor to it. The Primavera Contractor will calculate the earliest activity commencement time according to this date.
- **Finish On or Before** (also known as the „Late Finish” or „Finish No Later Than”) is applied, when the latest completion date is specified.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specification of the first (Primary) and subsequent (Secondary) constraint using the <strong>Activity Details</strong> form</td>
<td>In the <strong>Details Form</strong>, activate the <strong>Status</strong> table</td>
</tr>
<tr>
<td>Specification of constraints using columns</td>
<td>The following columns can be displayed:</td>
</tr>
<tr>
<td></td>
<td>• Primary Constraint</td>
</tr>
<tr>
<td></td>
<td>• Primary Constraint Date</td>
</tr>
<tr>
<td></td>
<td>• Secondary Constraint</td>
</tr>
<tr>
<td></td>
<td>• Secondary Constraint Date</td>
</tr>
<tr>
<td>Adding notes on constraints and other activity information</td>
<td>It is possible to add the <strong>Notebook</strong> table to the <strong>Activity Details</strong> form.</td>
</tr>
</tbody>
</table>
### 6.3.4 TRACKING OF IMPLEMENTATION

The main (basic) progress monitoring steps in the Primavera Contractor are as follows:

- **Saving a Baseline schedule**, also known as **Target**. This schedule holds the dates against which progress is compared.
- Recording or marking-up progress as of a specific date, often titled the **Data Date, Status Date, Current Date** and **As-Of-Date**.
- **Updating** or **Statusing** the schedule with **Actual Start** and **Actual Finish** dates where applicable, and adjusting the activity durations and percent complete.
- Comparing and reporting actual progress against planned progress and revising the schedule, if required.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving, deleting and specification of the baseline plan (Baseline)</td>
<td>From the <strong>Project</strong> menu, select <strong>Baselines</strong>, to open the <strong>Baselines</strong> form.</td>
</tr>
</tbody>
</table>
| Progress recording | • Activity Lifecycle  
  – Actual Start Date Assignment of an In-Progress Activity;  
  – Percent Complete (Default % Complete, Activity % Complete, Retained Logic and Progress Override).  
• Updating the schedule  
  – Updating activities  
  – Scheduling the Project  
  – Comparing progress with baseline. |
| Retained Logic and Progress Override | From the **Tools** menu, select **Schedule (F9)** and in the **Schedule** form, click on [Advanced...] to open the **Advanced Schedule Options** form. |
| Status date (Current Data Date) and project schedule (Scheduling) determination | Open the **Schedule** form by:  
  • Selecting in the **Tools** menu the **Schedule** command, or  
  • Press **F9**, or  
  • Clicking on [ ] |
6.3.5 WORKING WITH RESOURCES

So far, we have been working with the schedule without resources assigned. It is time to deal with resources as well. In order to use the resources in the Primavera Contractor, it is necessary to:

- Create resources in the **Resource Workspace**.
- Apply the Resource Calendars, if resources have special timing requirements.
- Assign resource to Activities and review the resource Leading.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Opening of **Resource Workspace** | • From the **Dictionaries** menu, select **Resources**, or  
• On the **Directory** toolbar, click on ![Resources](image)
| Creation of resources        | • Indicate the schedule line and press **Ins (Insert)**  
• From the **Edit** menu, select **Add**, or  
• From the context menu, select **Add**, or  
• Click on ![Add](image)
| Editing of the **Resource Calendar** | To open the calendar form, **Calendars**, in the  
**Dictionaries** menu, select **Calendars**. |

Resources are divided into

- **Individual Resources** – single persons, often responsible for implementation of specific tasks.
- **Group Resources** – groups of people (e.g. of the same specialization).

Another division is into:

- **Input Resources** – such as individual persons, groups of people, equipment, materials, and funds.
- **Output Resources** – the project products remaining in a relationship with input resources.

6.3.6 ALLOCATION OF RESOURCES AND COSTS

Resources represent two main components assigned to activities. These are:

- **Quantity** in terms of **Work** in hours or the quantity of **Material** required to perform the task.
- **Cost** calculated on the basis of **Resource Unit Rate** * **Quantity**. The **Resource Unit Rate** is described in terms of **Price/Unit**.
Each resource or cost has the same four fields for Costs and Units: Budget, Remaining, Actual and At Completion. Relations between these changes, depending on whether a given activity is: Not Started, In-Progress or Complete.

- When an activity is Not Started and % Complete is 0, then:
  - Budget can be linked with Remaining and At Completion, and a change in one may result in changes in the remaining two; they are equal and
  - Actual assumes the value of 0.
- When an activity has been marked as started and it is in progress, and % Complete is between 1% and 99%, then:
  - Budget is disconnected from Remaining and At Completion; to reflect progress, the At Completion value is compared with the Budget and
  - At Completion = Actual + Remaining and it is connected with % Complete, and a change of one value will result in change of the remaining values as well.
- When the activity is done (Complete) and % Complete is 100%, then:
  - Remaining is set to 0 and
  - At Completion = Actual.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specification of Units/ Time Format and allocation of resources</td>
<td>In menu Edit choose command User preferences … to open the User preferences form, and then activate Time Units and Calculations</td>
</tr>
<tr>
<td>Specification of Default Duration Type and Default Activity Type</td>
<td>Default values are set in the Project Properties in the Defaults table</td>
</tr>
<tr>
<td>Allocation of resources to activities</td>
<td>Indicate activity, to which a resource is to be allocated, and choose the Assign command from the Edit menu. In the open Assign Resources form, indicate the appropriate resource and click on Assign</td>
</tr>
</tbody>
</table>

6.3.7 TRACKING OF IMPLEMENTATION OF THE SCHEDULE WITH ALLOCATED RESOURCES

Tracking of a project with resources takes place in two different steps:

- Dates, duration times of activities and relations can be tracked using methods described in chapter 6.3.4.
• Resources, unit prices (hours and units) and costs can be calculated in Primavera Contractor on the basis of % Complete or imported from spreadsheets and databases.

It is absolutely necessary to keep in mind that the Baseline Project is a complete copy of the project, containing relations, resources and costs allocated (prices).

6.4 EXAMPLE (CASE STUDY)

A similar, simple schedule with the same features will be described using the software that is of interest to us. It is necessary to take into account that this is not a full implementation, but only a demonstration of selected basic features of software. Persons interested in finding out more should refer to the appropriate literature [47,49,51,50].
### Step 1: Project Description/Selection of the Schedule Building Mode

MS Project, unlike Primavera Contractor, does not provide a startup window. Starting work, it is necessary to specify the “main” features of the project in the window `Project Information for ...`.

When we click on `Create New ...`, a new project wizard is launched (Create a New Project).

<table>
<thead>
<tr>
<th>Step</th>
<th>Microsoft Project 2007</th>
<th>Primavera Contractor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="Project Information" /></td>
<td><img src="image2" alt="Primavera Welcome" /></td>
</tr>
<tr>
<td></td>
<td>Creating a new calendar</td>
<td><img src="image3" alt="Create a New Project" /></td>
</tr>
</tbody>
</table>
Task list and summary

Relations
Regardless of the mode of definition of the critical path, the appropriate Wizard is launched in MS Project (Gantt Chart Wizard), which leads us through its creation.

Selection of the method of specification of critical tasks (included in the critical path) is possible in the window Critical Activities. Depending on the method selected, automatic specification of critical tasks (critical path) takes place.
Over allocated resources (Resource Graph View)

The resource graphs (Resource Graph View) show that in the exemplary schedule, some resources are over allocated. The topic of elimination of over allocation is not included in this manual. However, it is necessary to comply with the basic rule – the baseline plan cannot be saved, if any resource allocated to any task has been over allocated.

Baseline plan

MS Project allows you to save many (up to 11) baseline plans. They can be compared using View, Gantt Chart with many baseline plans.

In the dialogue box Settings, Categories, Primavera Contractor allows you to define your own baseline plans apart from those “offered” by the producer.
Further baseline plans are created in the window **Project, Baselines**. Their application depends on the baseline plan’s category and the user’s needs.

<table>
<thead>
<tr>
<th>Tracking of implementation</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The window <strong>Update Tasks</strong> allows you to input data on execution of individual tasks in all the aspects that are interesting for the designer.</td>
<td></td>
</tr>
<tr>
<td>The window <strong>Project Update</strong> allows you to update a project in accordance with two basic rules:</td>
<td></td>
</tr>
<tr>
<td>• Complex update of project tasks.</td>
<td></td>
</tr>
<tr>
<td>• Schedule change (also) in the process of its execution.</td>
<td></td>
</tr>
<tr>
<td>Preview (and presentation) of the overall assessment of the execution is possible with the <strong>Gantt Chart – tracking</strong> available in the View menu.</td>
<td></td>
</tr>
</tbody>
</table>

Determining the way of marking the progress of the task execution (**Percent Complete**) can be defined in the **Status** chart – in the bottom panel. You can choose such options as: **Physical, Duration, Units** (default: **Duration**). The update of the execution progress of individual operations is possible in the bottom panel, in the **Status** chart. It is possible to determine not only the duration of operations, but also the dates of beginning/finishing the operations or work units of resources.

(In a sense) the option **Update Progress** is an equivalent of the **Update Project** (from MS Project). Its application allows you to update the operations’ execution to the established **Data Date**. After clicking the **Apply** button the schedule is automatically updated.
6.5 SELECTED COMPONENTS OF PROJECT PRESENTATION

Working on a schedule, regardless of its size and destination, ends with creation of the appropriate documentation. Depending on the recipient, it can assume two forms:

- Managerial documentation, addressed to the management of the organisation – containing information on financial issues (all information, allowing for assessment of the state of implementation and forecasts concerning further implementation of the project).
- Documentation containing technical data on implementation – such as breakdowns presenting the material completion of the project.

Regardless of the recipient, documentation can be divided into the following groups:

- Tables.
- Views.
- Reports.

In each group, it is possible to:

- Use objects provided in the software.
- Modify (customise) the available objects.
- Create new objects as needed.

Particularly useful in this regard is work with other programmes, such as Microsoft Office Excel, Word and PowerPoint (not discussed in this manual).

6.5.1 MICROSOFT PROJECT

6.5.1.1 NETWORK VIEW

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presenting the project using the Network Diagram</td>
<td>• From the View menu, select Network Diagram… or • Click on on the View toolbar.</td>
</tr>
<tr>
<td>Removal of tasks in the Network Diagram view</td>
<td>• Right-click on the appropriate box and select Delete Task from the appropriate menu</td>
</tr>
</tbody>
</table>
In the menu, choose **Edit, Delete Task**

- Drag the cursor from the predecessor to the successor or
- Double-click the connection between boxes and use the options in the **Task Dependency** dialogue box

**Formatting of Boxes**

- From the **Format** menu, select the **Box** command or
- From the **Format** menu, select the **Box Styles** command
- Right-click on the appropriate box and select the **Format Box …** from the context menu

Clicking on the **Network Diagram** button will result in opening of a window that allows for selection of the network diagram presentation mode.

![Network Diagram](image.png)

**Fig. 6.4. The Network Diagram view**

The organisation of display of the **Network Diagram** view may be changed using the **Format, Layout** window options.
Fig. 6.5. The Layout dialogue box
Fig. 6.6. The Format Box allowing for selection of the standard of presentation of a single activity (task)

Fig. 6.7. A Box Styles dialogue box, allowing for definition of task presentation features
6.5.1.2 FILTERS

Filters are tools allowing for selection only of information that is of interest. Like any other group of objects, they can be divided into:

- Standard – supplied by the software manufacturer
- Customised (edited by the user).
- User filters.

Particularly significant are auto filters (AutoFilter), which have specific practical implications.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Launching of auto filter | • Click on the button or
|                          | • In the Project menu, select command Filtered for …, Autofilter                                   |
| New filter creation      | • In the Project menu, select command Filtered for …. More Filters. Clicking on the New button in  |
|                          | the dialogue box that opens, Filter Definition In …, create a new filter or                      |
|                          | • Click on Edit and edit the existing filter, or                                                  |
|                          | • Copy the existing filter using the button                                                       |

Fig. 6.8. Result of launching of auto filter (with the Start list being unfolded)
The rules of use of an auto filter are same as in the Microsoft Excel programme. 

![More Filters dialogue box](image)

**Fig. 6.9. The More Filters dialogue box, allowing for filter selection**

### 6.5.1.3 VIEWS

In general, views can be divided into simple (Single View) and complex (Combination View). Like in the case of filters, it is possible to:

- Use ready views.
- Edit an existing view.
- Create a new view.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Use of the view available in the programme | • From the View menu, choose the appropriate view of the task or  
                                              • From the View menu, choose the **More Views** command or  
                                              • Click on the right command on the **View toolbar**                                             |
| Edit the existing view            | • In the **View, More Views** window, indicate the filter and click on **Edit** button              |
| Create simple views               | • From the View menu, choose the **More Views** and                                                  |
| Create complex views | in the **More Views** dialogue box, click on **New** and in the **Define New View** window, select the **Single View** option.  
  • On the **View** toolbar, click on **More Views**. Click on **New** and in the **Define New View** box, select the **Single View** option.  
  • From the **View** menu, choose the **More Views** and in the **More Views** dialogue box, click on **New** and in the **Define New View** window, select the **Combination View** option.  
  • On the **View** toolbar, click on **More Views**. Click on **New** and in the **Define New View** box, select the **Combination View** option. |

**Fig. 6.10. The More Views dialogue box**

**Fig. 6.11. The dialogue box allowing for view type selection**
When working with simple views, it is necessary to prepare and save a data set (in table form) earlier. In the case of complex views, it is first of all necessary to prepare views that can create a specific combined view. It should be kept in mind that the views created are available only with the project, for which they have been created. To make them accessible from other projects, it is necessary to launch the **Organizer** (the **Organizer** button in the **More Views** window or the **Organizer** command from the **Tools** menu). It can be used to copy objects created in a project to the GLOBAL.MPT, which stores all settings and objects of the project.

![Organizer dialogue box, the Views table](image)

**Fig. 6.12. The Organizer dialogue box, the Views table**

### 6.5.1.4 PRINTING

Like in any other window-type application, in Primavera Contractor, three commands are used:

- **File, Page Setup** …
- **File, Print Preview**
- **File, Print**… or Ctrl+P.

Due to the versatility of the commands listed, these will not be dealt with in this manual.
6.5.2 PRIMAVERA CONTRACTOR

6.5.2.1 ACTIVITY NETWORK VIEW

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Project presentation using the Activity Network View | • Choose View, Layout, Open … or  
• Select the View, Show on Top, Activity Network from the menu or  
• Click on on the Activities toolbar. |
| Adding and deleting activities in the Activity Network view | • Use and buttons or  
• Select the Add or Delete commands from the Edit menu |
| Adding, edition or removal of relations | • Drag the cursor from predecessor to successor or  
• Use the Predecessor and Successor bookmarks in the Activity Details form |
| Formatting of Activity Boxes | • From the View menu, select Activity Network, Activity Network Options … or  
• Right-click in the Activity Network area and make selection in the Activity Network Options …. context menu |

Clicking will result in opening of the Open Layout window, allowing for selection of the network diagram presentation mode.
Fig. 6.13. Two selected examples of the Activity Network view

Fig. 6.14. The Activity Network Options dialogue box. On the left, the Activity Network Layout table, and on the right - the Activity Box Template.
6.5.2.2 FILTERS

Filters are tools allowing for selection only of information that is of interest. Like any other group of objects, they can be divided into:
- Standard – supplied by the software manufacturer
- Customised (edited by the user).

It is necessary to keep in mind that a drop down list of filters or auto-filters, known from Excel and Project, is not available in the programme.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| All operations performed with filters require opening of the Filters form | • Click on the button or  
• From the View menu, select Filters … or  
• Right-click in the column area and select the Filters… command from the context menu |
| New filter creation | • Click on the button in the Filters window and create a new filter or  
• Copy an existing filter by clicking on , and then (if necessary), modify the filter using the dialogue box that opens when clicking on |
Fig. 6.15. The Filters dialogue box, allowing for selecting of the appropriate filter

A new filter will appear in the User Defined area of the Filters window.

6.5.2.3 VIEWS (LAYOUTS), GROUPING AND SORTING OF ACTIVITIES

Views are functions similar to the views of MS Project. They can be edited, saved in memory and re-used at any time. Grouping and sorting of activities allows for organisation of data according to such parameters as dates, resources or user-defined Activity Codes. The option is similar to Grouping in MS Project.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Method of completion/ Menu commands</th>
</tr>
</thead>
</table>
| Re-formatting of grouped and sorted activities by opening the Group and Sort form | • Click on ,  
• From the View menu, select the Group and Sort command or  
• Right-click and select the Group and Sort command from the context menu |
| Creation and edition of Layout | • From the View menu, select the Layout, Save As… command or  
• On the Layout toolbar, click on Save As…. |
6.5.2.4 PRINTING

Many users are only willing to accept printed documents. The Contractor provides two basic tools for printing:

- The **Printing** function – allowing for printing of the currently displayed data (In current Layout). The print settings used for the individual Layout are stored along with it.
- The **Reporting** function – allowing for printing of reports regardless of the current view (Layout). The programme provides a number of pre-defined reports; however, these will not be discussed in this manual.

As in any other window-type application, in Primavera Contractor, three commands are used:

- **File, Page Setup …**
- **File, Print Preview**
- **File, Print…** or **Ctrl+P**.

Due to the versatility of the commands listed, these will not be dealt with in this book.
CHAPTER 7

APPLICATION OF IT SYSTEMS IN REAL ESTATE MANAGEMENT

(M. ZABIELSKI)

Real estate management is a process based on decision-making and on activities aimed at ensuring the appropriate economic and financial management of real estate property, as well as ensuring security of its use and proper operation, including day-to-day administration. The tasks of the manager include maintaining property in a non-deteriorated condition in accordance with its designation. This is a broad scope of activities, which may be increased or decreased depending on the scale of management or the type of the property. Implementation of the tasks listed is assisted by technological solutions in form of integrated IT systems, which are available on the market. These are characterised by high flexibility of configuration, which allows for adaptation of their functionality to the scope of works associated with management of a specific property. Among other things, their application allows for

- Maintaining records of property, including information on management of space, technical and financial condition,
- Maintaining records of users and tenants of premises,
- Technical management of the property through planning of renovations and investments,
- Management of the documentation,
- Quick completion of orders,
- Automatic calculation of charges for rent and utilities,
- Accounting,
- Quick generating of financial reports.

The software available on the market is constantly being improved. An ideal IT system should assist the manager in completion of all tasks in all spheres of activity.

---

5 Art. 184. item 1 of the Act on real estate management of August 21st, 1997
The subsequent sub-chapters contain the characteristics of the integrated IT systems with a precise description of the available modules, underlining their abilities and usability. In the further part of the study, IT systems used for management of specific property will be presented.

7.1 INTEGRATED IT SYSTEMS

Among the solutions available on the market, which support management of property, a great majority are integrated IT systems. This group includes: Archibus, Coswin, Manhattan Real Estate, ADA, Mieszczanin, Granit and Honeywell EBI.

The structure of an integrated IT system is based on specialist modules, which are responsible for implementation of individual functions (e.g. settlement of charges for the media or planning of renovation or investment projects). Usually, they share a common database. Application of this solution results in the information being introduced only once, reducing the possibility of making a mistake.

Undoubtedly, another advantage of the database is the fact that in this case, there is no necessity to send copy or transfer data, since it is already available in all modules of the integrated system. This allows for a substantial increase in the pace and effectiveness of the manager’s work. It is one of the main advantages of implementing integrated IT systems. Its implementation brings other benefits as well, which include:

- More effective management;
- Improvement in the quality of work;
- Increased attractiveness of the services offered; and,
- Greater client satisfaction.

The module-based structure itself has a substantial advantage, as it allows for any development of the application along with the growth of the enterprise. When it becomes necessary to add some graphics to the reports, such systems can be fully integrated e.g. with the AutoCAD software.

---

7 AutoCAD - Autodesk company software used for computer-aided design in the 2D and 3D environment.
Implementation of an integrated IT system forces the property manager to meet the basic requirements with regard to the computer and network infrastructure and training of the staff in specialist software management. Compliance with these requirements is associated with certain expenditures, which, nevertheless, should pay off over the long-term perspective. An example of a general model of an integrated IT system to support real estate management has been presented in Figure 7.1.

![Integrated IT System Diagram](image)

**Fig. 7.1. An exemplary model of an integrated IT system designated to support real estate management**  
Source: own diagram

### 7.1.1 THE MAIN DATABASE

All information entered in the system from individual modules is stored in the main database. It is used to record data necessary for all calculations, statements, reports and charts. A high class system should store such information as:

- Detailed data on property;
- Identification data on lessees;

---

8 T. Bąkiewicz, R. Kawecki, M. Szczubelek, op. cit., p. 30
• Data describing the premiums paid, depreciation and amortisation rates etc;
• Scanned document images, photographs and video films;
• Correspondence history;
• Stock records, assets and payroll records etc;
• Archive files; and,
• System configuration parameters, such as user rights, access passwords etc.

The main database must be stored on a specially secured server. Access to information should be granted only to users having the appropriate rights. The system administrator, who is responsible for the system security, should grant the access rights. The administrator assigns the scope of user rights to individual users depending on their function in the enterprise. This is of great significance, as it is necessary to avoid situations in which, for instance, a person responsible for technical management of property has access to financial data of the enterprise which should be accessible solely to employees in the accounting department.

In line with good IT practice, a system of this kind should be subject to archiving and protection to prevent destruction or takeover of stored data. To this end, it has in-built or installed security software - a firewall\(^9\) and an anti-virus system\(^10\).

It is equally significant to perform backups of the database. Depending on the strategy applied, a backup should be performed every day or – collectively – at the end of each week. At least two updated backup copies should be made, one of them stored at the headquarters of the enterprise, and the other in a more secure location, such as a bank safe.

Loss of all information stored in the main database would be a disaster to the enterprise, and data takeover by third parties may, in the best case, lead to termination of the contracts. Every property manager must be aware of the consequences of loss of personal and business information of the enterprise. Therefore protection of this data as well as of the entire integrated IT system is a priority.

\(^9\) A firewall – a network component, designated to protect the system against unauthorized access.

\(^10\) Anti-virus system – a system, which ensures protection against malware causing damaging or removal of files.
7.1.2 THE MODULES

Modern integrated IT systems usually consist of several or even several dozen functional modules. The number of these depends strictly on the type and scope of activity conducted. Therefore, the decision to purchase an appropriate system should be preceded by precise analyses, aimed at clear specification of the mode of use of the IT system to achieve the real estate management tasks, eliminating those components, which would only be an unnecessary expenditure.

The next part of this study describes modules of the integrated IT system, presented in figure 7.1. It should be underlined that these are only some of the modules available on the market, which have been selected because they are of key significance for real estate management.

7.1.2.1 TECHNICAL MANAGEMENT OF PROPERTY

As has been mentioned earlier, the main tasks of the manager include maintenance of a non-deteriorated condition of the property in accordance with its designation and reasonable investment\(^\text{11}\). These are tasks that require careful preparation and constant supervision. Assistance in their performance is ensured by a specialist module, allowing for precise planning and implementation of renovation or investment projects.

The IT system allows for collection of information on prices of materials and availability of contractors, and on the basis of this data, for creation of a schedule to calculate the estimated cost of performance of the works planned (the so-called cost estimate). It is recommended that it provides the possibility of recording the documentation established during their implementation (e.g. agreements and annexes, orders and offers).

This module reminds the user of the warranty deadlines for the works performed and devices and equipment installed and it provides information on the necessity to conduct inspections.

7.1.2.2 COMMERCIAL PROPERTY

According to the legal provisions in force, purchase costs or creation of fixed assets are not categorised as taxed costs as they are borne, but gradually, through their use conditions, in form of depreciation write-offs. Subject to this principle are only the so-called fixed assets and intangible assets. From the perspective of real estate management, the first group includes buildings, structures, premises constituting separate property, as well as machines and devices (such as

\(^{11}\text{Art. 184. item 1 of the Act on real estate management of August 21st, 1997}\)
computers), for which the expected period of operation is longer than one year. The second group consists of: the right of perpetual usufruct to land, a cooperative ownership title to commercial premises. From the perspective of real estate management, the first group includes buildings, structures, premises constituting separate property, as well as machines and devices (such as computers), for which the expected period of operation is longer than one year. The second group consists of: the right of perpetual usufruct to land, a cooperative ownership title to commercial premises, a cooperative ownership title to residential premises, as well as the right to a single-family house in a housing cooperative.

An ideal IT system, responsible for fixed assets and intangible assets, should provide real estate management support in:

- Recording of these;
- Creation of monthly breakdowns of depreciation write-offs;
- Conducting of analyses of depreciation and amortization;
- Reminding of the full depreciation dates; and,
- Establishment of the property tax charges and payments for perpetual usufruct of land.

7.1.2.3 RENT CHARGES

The rent amount depends on many factors, such as the location, area and technical condition of the premises. The rent usually includes:

- The basic charge;
- A share in the joint property;
- The renovation fund; parking spaces; and,
- Additional charges due to property tax or perpetual usufruct.

Determination of the rent charge amount requires the manager to perform many precise calculations, which, luckily, can be done by the dedicated IT system. Its application allows the manager to save time and to avoid calculation errors, while the rich scope of functionality enables the manager to take advantage of the following additional features:

- Calculating charges at any time;
- Issue of invoices; booking of payment in traditional or electronic format or using bar codes;
- Supervision of payment deadlines;
- Assigning of premiums and rent rates to the designated area, such as the entire housing settlement, a building, or individual premises;
- Creation of monthly reports and statements;
• Archiving of data containing information on rates, charges and payments; and,
• Export of amounts charged to the financial and accounting module.

The system has many other features, not listed above. This is due to the fact that its functionality is so extensive that it is simply impossible to discuss all of its aspects here. The above selection includes the most significant of them.

7.1.2.4 UTILITIES

Periodical calculation of amounts payable for water supply, power, heating, gas and other charges is virtually impossible without dedicated software. Due to substantial complexity of the settlement mode, this process should be fully automated. Therefore, a module has been created, which constitutes a part of the integrated IT system, allowing for the most complicated and untypical calculations. The basis for its operation is the possibility of selecting various algorithms of settlement, depending on the premises, building or settlement.

Some systems offer special calculators, allowing the user to define the mathematic and logic formula, which can be assigned to specific settlement units of individual utilities\(^{12}\).

The special module should also allow for gathering of data on real meters, metering points and documents with meter reading data. This will allow the manager to create reports on the history of a given measurement point for a given period.

The software available on the market also allows for automatic settlement of metering points for the selected settlement period, calculating the absolute and relative consumption, average consumption per person or premises and calculation of the payment balance\(^ {13}\).

Finally, the users of the premises are informed about the settlement of the utilities and the obtained results are booked automatically.

7.1.2.5 FINANCES AND ACCOUNTING

Managers, often acting in the name of the owners of property, maintain financial and accounting records. Thus, they are obliged to produce reports, depending on the number of venues managed. To introduce automation of this task, a system was established, which generates the records quickly on the basis of data entered, limiting the possibility of errors occurring. The system functionality allows the manager to establish the condition of finances, including revenues and costs at

\(^{12}\) T. Bąkiewicz, R. Kawecki, M. Szczubełek, op. cit., p. 43.
\(^{13}\) http://www.2plus2.pl/media.html
any time during the turnover year, as well as to generate various lists, such as statements of accounts or accounting documents.

The module enables the preparation of taxation data, as well as the full scope of VAT records independent of the booking periods. It also allows for analyzing receivables and liabilities, as well as financial plans and indicators.

In a situation where tax law is amended, the task of the system administrator is to introduce updates to allow the users to work with a product, which has been properly adapted to the new legislation.

The main advantage of this solution is the possibility of elimination of the necessity to repeat the same tasks, in particular, in the case of repeated entry of data. This limits the probability of errors, resulting in an increase in effectiveness and speed of work.

### 7.1.2.6 PAYROLL AND HUMAN RESOURCES

The main task of an IT system that manages HR and payroll issues is to perform all tasks aimed at calculation of remuneration, which are then booked in the individual employee files and on contra accounts in the financial and accounting module, described above\(^\text{14}\). The system also supports:

- Management of staff by enabling entry of employee data;
- Calculation of remuneration for any time period;
- Preparation of employee certificates;
- Maintenance of register of absences of a given employee;
- Control of employee attendance.

### 7.1.2.7 DEBT COLLECTION

The person responsible for real estate management faces many challenges. These include, in particular, collection of debts.

The basic function of a good debt collection module of an integrated IT system is the possibility of analysis of debt with the option of selecting any criterion, such as the number of months of the amount of debt. On this basis, the property manager may decide to begin the debt collection procedure.

Usually, the procedure starts with sending of a call for payment, asking the user to settle the debt. In this case, the system should allow for an automatic generation of a letter, containing information on settlement of individual debt components and interest rates, calculated by a special mechanism. The document generated in this way is then sent to the debtor (the entire correspondence history is saved in the main database).

If both parties want to solve the problem and reach agreement, the time of the proceedings by writ of payment may be extended. Otherwise, the matter is designated for court proceedings, and in this case, the system supports the manager by recording the overdue amounts, as well as the history of proceedings by writ of payment.

7.1.2.8 ELECTRONIC PAYMENTS

One of the most time-consuming procedures in real estate management is manual booking of bank statements. To speed up this process, a specialist IT system has been created, in which payments for premises made via a bank or cash register transfer are immediately entered in the financial and accounting module in individual detailed accounts of lessees (settlement account) and, at the same time, in the appropriate synthetic accounts.\(^{15}\) Apart from its time-saving features, the system eliminates errors associated with data entry and reduces the rate of the so-called unrecognized payments.

7.1.2.9 MANAGEMENT OF DOCUMENTS

A very significant module of the integrated IT system is the module designated for management of electronic documents (e-mail, faxes, and scanned documents). This functionality allows for segregation of documents according to a selected criterion, such as the type of property, tenant or date.

The system described must have the option of archiving with the possibility of quick search for the documents needed. This will allow the manager to read documentation whenever necessary.

The document management software also allows for registration of documents in paper format. This significantly reduces the time needed to search for these.

Use of this module enables low documentation maintenance costs saving of searching time, remote access, quick transfer of messages, as well as a high level of confidence in information being delivered.

7.1.2.10 WAREHOUSE MANAGEMENT

IT systems support the operations of the property manager in many fields, including the duties associated with maintenance of a warehouse. A dedicated module enables management of many warehouses, allowing for defining of any assortment in the system (material index). Its functionality also allows for:

- Entry and booking of material turnover documents;

\(^{15}\) http://www.granit-software.pl/Standard/H.Elektroniczny obrot płatniczy/
- Review of the assortments stocked in warehouses with the possibility of sorting according to any key (e.g. date, name, symbol, warehouse);
- Support in creation of documentation of receipt and issue of goods from the warehouse; and,
- Management of stock-taking activities.

7.1.2.11 THE ADDRESS INFORMATION DATABASE

The property manager should make sure to establish communication with the owner, the inhabitants and the lessees. To this end, it is necessary to maintain an appropriate database containing address data. The information stored in this database should allow for any form of contact with a selected person.

The functionality of the integrated IT system allows for collection of data from the address database to any module found in it. This facilitates and reduces the time of filling out of forms, applications and many other documents that used to require manual data entry.

7.1.2.12 A REPORTING SYSTEM

An ideal IT system, which supports the work of a property manager, must allow for registration and management of reports. The problems raised in these reports may concern may aspects of day-to-day real estate management. Therefore, it’s appropriate classification is of significance.

The module provides the manager with access to many functions, which are designated for collection of incoming reports and their management throughout the subsequent phases of handling. From the perspective of the manager, it is also significant that the system allows for: designation of available contractors, creation of reports on task performance, searching for report completion data and its confirmation, as well as maintenance of a file of closed cases.

7.1.2.13 A WEB PORTAL

Nowadays, it is difficult to imagine the functioning of a company without a professional web portal. In many cases, it plays the role of a virtual office, serving as a specific „business card” of the company. A web portal is usually a web page or a set of web pages, enabling the use of many applications, information services or resources of the company.

Application of this solution in real estate management allows for substantial reduction of costs and faster information flow. The owner or the lessor, without leaving their home, may check the following at any time using their computer:
  - Detailed data on the property (area, number of tenants);
• Monthly breakdowns of charges;
• Current charges;
• A breakdown of all payments made; and,
• Information on settlement of utilities.

A Web portal makes communication between the manager and the owners or lessees much easier. It allows for delivery of all documents in electronic format, including forms, applications, requests, calls or notifications. The system also allows for asking questions or sending reports concerning problems. The manager, as well as the owner and the lessees, may at any time provide answers to questions asked by other parties. The entire correspondence is filed and stored in the main database.

The rich scope of functions offered by a Web portal allows the manager to:

• Create a bulletin board containing information on e.g. opening hours of the office, contact phone numbers or the planned renovations;
• Publication of applicable legislation and regulations;
• Sending of group information, e.g. to inhabitants of the entire building or lessees in a single building; and,
• Addressing information to individual recipients, e.g. documents initiating debt collection procedures.

This solution gives the manager substantial freedom, since they can check information from any place in the world, including:

• Information on property (address, type, area, legal status and many others);
• Information on agreements (e.g. commencement and termination dates, rent charges);
• Financial status;
• History of selected correspondence
• The attendance of employees at the company.

Access to special functions of a Web portal is possible only for authorised and authenticated users. This means users who have confirmed their identity by entering a unique login and a password which is only known to them. This activity must be performed both by the manager and by other employees of the office, as well as by any cooperating parties. Each of the users has specific access rights, set appropriately for each account by the system administrator. For instance, a lessee of a given venue, logging into the portal, has only access to information associated with their property, without the possibility of viewing any other data.
7.2 THE APPLICATION OF IT SYSTEMS

The example modular integrated IT system, which we described in the previous chapter, consisted of the main database and modules, which are fixed regardless of the type of property managed. However, the specific features of every property make it necessary to apply individual solutions by adding new modules and increasing the functionality of those already used. Therefore, this chapter will focus on the special features of complex IT systems dedicated for management of:

- Housing property;
- Commercial property; and,
- Public utility buildings.

7.2.1 HOUSING PROPERTY

IT systems designated for management of housing properties are associated with the specific character of properties of this type. These will be presented using the example of systems to manage housing cooperatives and tenants’ associations. A person responsible for management of a housing cooperative is obliged to maintain, apart from the basic register of property, a register of members and a breakdown of contributions and shares. Generating and updating these registers without use of IT systems would be a loss of time. Therefore, managers of housing cooperatives are eager to use state-of-the-art IT solutions. The systems available on the market, apart from maintaining of registers mentioned above, support the completion of other tasks, which are typical mainly for housing cooperatives, such as; indexation of housing contributions; maintenance of a register of costs and revenues for each property; maintenance of member accounts; procedures for allocation of apartments for those on waiting lists; and, generation of financial statements (according to the selected criterion, such as the building, the settlement or the entire cooperative), as well as analyses and reports. From the perspective of management of tenants’ associations, it is significant that the IT systems available on the market allow for:

- Generation of annual economic plans, which the manager is obliged to perform;
- Generation of annual statements of activity of the manager;
- Maintenance of records of costs and revenues for each tenants’ association; and,
- Quick generation of individual and global financial statements.
The appropriate modification of the structure of the example model of an integrated IT system, presented below, or modification of functionality of individual modules, offer many possibilities with regard to support of operation of a housing cooperative, as well as a tenants’ association.

7.2.2 COMMERCIAL PROPERTY

Commercial property is aimed at generating profit. Property of this kind includes office, shopping, service, recreation and storage facilities. In special cases, commercial property includes apartment buildings, constructed by a developer to generate profit from the sale of apartments and commercial premises.

The high level of competition in the commercial property market forces the managers to use modern solutions. The application of these results in greater professionalism of services, e.g. by shortening of the time of performance of tasks or elimination of accounting errors.

The available software supports the commercial property managers in all aspects of their work. Good integrated IT systems, depending on the scope of works, should consist of modules allowing for e.g.:

- Supporting the creation of the real estate management plan, and in the further perspective, its updating;
- Technical management of the property thanks to maintenance of the appropriate documentation, reminders of warranty deadlines and dates of periodical technical inspections;
- Management of costs of e.g. insurance, security or cleaning;
- Management of area designated for lease, through its registration (e.g. according to trade, level or area) and history of lease;
- Automatic calculation of property tax;
- Professional management of tenants through management of lease agreements and calculation and charging of correct amounts;
- Registration of payment history;
- Maintenance of a database on turnovers of lessees and the number of clients and generating of the appropriate reports;
- Complex management of agreements associated with placement of devices and advertisement within the leased space area;
- Detailed settlement of charges for utilities (power, heating, water, gas);
- Efficient management of document flow and recording (correspondence, agreements, letters, applications and other documents must be appropriately segregated, which should be enabled by the system functionality);
• Preparation of financial statements, allowing for determination of the current financial status of the property;
• Analysis of revenues and costs according to the selected criterion, such as location, lessee or area, and assessment of effectiveness based on this data;
• Forecasting the future financial condition of the property and the associated budgeting for the coming years;
• Implementation of debt collection procedures using the software integrated with modules responsible for the registry of payments, finances and accounting and management of the documentation;
• Complex planning of investments through assistance in creation of documentation and schedules, selection of materials and contractors, specification of financial means and a forecast of potential advantages;
• Quick generation and handling of orders by the introduction of new functionalities in the reporting system module; and,
• Constant access to all information which is significant from the perspective of the property being managed.

From the perspective of management of commercial property, it is interesting to apply the IT systems to management of the so-called intelligent buildings. Since these usually include office buildings of class A or state-of-the-art shopping centres, hotels and sports facilities, they require state-of-the-art management technologies\(^\text{16}\). One of the solutions offered by software manufacturers is the CAFM (Computer Aided Facility Management) class system. It ensures the complex and constant supervision of the technical condition (including the network, installation and equipment) and the condition of finances of the property managed. The very rich scope of functionality and possibilities offered allow for management even of the most modern buildings. Therefore, this solution is used by many enterprises throughout Europe.

A CAFM class system is also distinguished by access to a general database (updated regularly) and 24-hour support of the system management (a hotline and a technical service). For those who are just considering purchasing, special standards have been established to enable the effective implementation and integration with processes that are associated with the property being managed\(^\text{17}\). The disadvantages of the solution include high costs and a relatively long implementation time.

\(^{16}\) M. Bryx (ed.): Wprowadzenie do zarządzania nieruchomością, Poltext, Warsaw 2010, p. 183.

Another solution, used very often for management of state-of-the-art commercial property, is the BMS (Building Management System). Its main purpose is to manage the automatic functions of the building to ensure a high level of comfort and reliable functioning of the facility while limiting the energy consumption. The BMS system allows for control of alarm systems, access and fire protection control, as well as heating, ventilation and air-conditioning and the lighting system\textsuperscript{18}.

7.2.3 PUBLIC UTILITY BUILDINGS

Public utility buildings are general access buildings, such as office buildings and shopping centres, mentioned in the previous chapter, as well as public administration buildings, schools and universities, hospitals, student dormitories, bus stations, buildings for worship. Despite the variety, available software allows for effective management of any of these building types. It would not be feasible to present a detailed description of each type of building, since they share many common features. Regardless of whether a given system is applied to manage a state administration building or a school dormitory, it should allow for:

\begin{itemize}
  \item Gathering of data on the property using descriptive, numerical and graphic information;
  \item Visualisation of the entire property, indicating the networks, installations and devices (this functionality is not contained in any of the modules described in the previous chapter; therefore, a manager, who wants to use this application, would have to develop the integrated IT system proposed by adding the appropriate module);\textsuperscript{19}
  \item Support in making decisions with regard to the planned renovation activities;
  \item Registration of large quantities of electronic and paper format documents;
  \item Creation of any reports and lists with the option of selection of some or all venues;
  \item Automatic calculation of charges for utilities;
  \item Quick generation and management of reports, using the system described in the previous chapter, expanded to include additional functionalities, e.g. the orders being sent simultaneously to the system and to the e-mail and cellular phone using an SMS;
  \item Minimisation of unnecessary expenditure
  \item Efficient management of resources in the warehouses; and,
\end{itemize}


\textsuperscript{19} M. Bryx (ed.), op. cit., p. 184.
• A review of unused space and support in its management. The system must allow for generating of the so-called reserve list, containing phone numbers of persons waiting in a queue e.g. for a vacancy in a student dormitory.

There is a multitude of applications of IT systems in management of public utility buildings. Only a part of these was listed above, but on this basis, it is possible to conclude that without the use of the appropriate software, professional management of property of this kind would not be possible.

7.3 CONCLUSIONS

The possibilities and benefits associated with application of IT systems in real estate management are numerous. They may include time savings and elimination of errors, associated with creation of documents or performance of calculations, mentioned above. Application of solutions of this kind often increases the comfort of use of the property while reducing the cost of its operation. It is worth mentioning that there is also the possibility of simultaneous management of many facilities, often located in different cities or even countries.

In order to meet the expectations of the users, IT systems must be adapted to the scope of work performed by the manager. Selection of the appropriate software is of key significance for its effective use.

On the IT market, there are many professional programmes to support property management, such as Archibus, Coswin, Manhattan Real Estate, ADA, Mieszczanin, Granit or Honeywell EBI (or other national level software applications).

It should also be mentioned that in the management of facilities of various types, IT solutions that are applied have sometimes been designated not only for management of property, but also management of the entire company. Examples of these include ERP (Enterprise Resource Planning) systems used for planning of resources of an enterprise. A solution of this kind is offered e.g. by SAP ERP Corporate Services, in which the module responsible for supporting real estate management is only a part of the aforementioned system.

There are also CMMS (Computer Maintenance Management Systems), devised to support traffic at manufacturing companies. The rich scope of their functionality includes functions aimed at real estate management.
Summing up, it should be stated clearly, that even most advanced and developed systems were created only to support the manager in performing his tasks, but they can never entirely replace the manager.
CHAPTER 8

INNOVATION AND NEW DEVELOPMENTS IN CONSTRUCTION PROJECT MANAGEMENT

(C. MOTZKO, F. BINDER, M. BERGMANN)

8.1 SENSOR-AIDED CONSTRUCTION CONTROLLING

8.1.1 PROMPT TARGET-PERFORMANCE COMPARISONS

The comprehensive monitoring and controlling of construction processes is considered an integral element of a results-oriented project realisation phase (Manual M9 Process Management – Lean Construction). Appropriate information produces an awareness of project status and work task performance, which fundamentally determines the project’s success according to its value for decision-making. Construction processes, therefore, have to be documented in terms of schedule, cost and quality aspects. On the basis of this information, an analysis of discrepancies between target and actual values can be conducted. Thus, potential for optimisation will be taken into account, as construction management is able to reveal the causes of incidents which have occurred and can trigger corrective measures. An active controlling process requires strong emphasis to be placed on an up-to-date data basis. Hereby, the industrial practice is marked by respective deficits especially concerning the time intervals of data
collection and analysis. A one-month cycle, which is usual on most construction sites, does not enable an effective construction process controlling in most cases. The cycle time rather depends on the kind of construction work and the contractual conditions. Even real-time information processing may be necessary in some cases, for example, the mounting of precast building components with a narrow time frame.

**Fig. 8.1. Misguided controlling timeframe**

*Figure 8.1.* shows the results of a misguided monitoring and controlling timeframe. Indefinite incidents prolong the construction of a specific building component, which was planned to be finished after one week, for one more week. The reasons for the costly delay cannot be revealed at this point, as a controlling is only conducted monthly. In fact, the problematic construction processes have been completed by the time the gathered information reaches the decision makers. A basis for decision making concerning necessary corrective intervention, therefore, becomes impossible and appropriate decisions are made intuitively or reactively instead. This example demonstrates that the time intervals of target-performance comparisons have to be shortened for the purpose of effective controlling, which means that the timeframe has to be adapted according to the conditions of the project and construction process.

### 8.1.2 DIFFICULTIES OF DATA COLLECTION

Actual data from the construction site is required for target-performance comparisons to be produced. Above all, the construction progress is significant. An ordinary site measurement cannot supply appropriate data, as collected data lacks an exact time reference and a continuous recording. Additional data
collection is, therefore, necessary, but necessitates a significant time commitment from supervisory personnel, which leads to corresponding cost and limits accuracy and the frequency of relevant information. As a result, the requirements of the on-site controlling system cannot be met.

8.1.3 APPLICATION OF SENSORS

As data collection methods have, up to now, been unable to provide an adequate data basis for effective construction control or monitoring, research today is concentrated on new technologies. A designated target is the development of tools for the evaluation of construction progress and the real-time controlling of construction processes. A strong basis for decision-making and communication can be formed through the use of easy to handle and objective tools for automatic data collection.

With regard to other industries, sensors are thought to be a particularly promising approach. Sensors can be defined as devices that directly or indirectly measure physical conditions and convert this information into a signal which can be read by an observer or by an instrument. There is a huge range of such devices and their application varies substantially. Ordinary thermometers and highly sophisticated GPS receivers are referred to as sensors.

The advantages of sensors for the collection of construction process data derive from the possibility of continuous and automatic collection, as well as from the digital process ability of their output. Furthermore, sensor data is highly objective and the detection ranges can usually be adjusted exactly to the particular needs of the construction processes.

8.1.4 CHALLENGES

Construction sites challenge sensor devices in several ways. Environmental influences, such as mechanical load, dust, humidity or extreme temperatures, can take their toll on all applied instruments. In addition, adaptation of sensor systems to the different outdoor and indoor environments is considered to be difficult. The power supply, as well as the data connection of the construction sensors, becomes complicated. This problem is further aggravated by the dynamic on the construction sites. The structure of a building changes rapidly during construction and so do the types and locations of the resources required, thus sensors often need to be moved or calibrated, as new components shield measuring instruments. When combined with the complexity of the construction process, the application of sensors usually has to be planned project-specifically.

The challenges for sensor systems on a construction site have hampered their application up to now. Yet, sensor technology is advancing, with devices
becoming more precise, robust and cheaper. As a result of this, the data collection with sensor systems is becoming profitable for more and more areas. As a consequence of these challenges, the devices have to be specially adapted to the variability of the construction environments and processes.

### 8.1.5 CONTROLLING DATA

The raw data collected by sensors is, in most cases, not directly usable for construction process control. Sensors receive and send signals, yet this data alone has no value for control. Only when sensor data is contextualised to a construction process, does it become valuable information for the decision makers.

Thus, the acquisition of information for construction control cannot only be conducted by sensors. In fact, further processing of the data is required. Figure 8.2. shows the significant steps in this process.

![Fig. 8.2. Processing of Controlling Data](image)

At first conditional data regarding the construction process has to be collected by sensors. For this purpose it is necessary to calibrate the applied devices according to the significant data generated by the process. The main objective must be a limitation of data collection to the required controlling data.
Subsequently, structured information has to be extracted from the collected unstructured sensor data. Out of the devices’ data stream relevant events for the construction controlling have to be automatically filtered by appropriate software systems. Within this process, the tools relate the sensor data to the context of the construction process according to predefined parameters. Finally, the controlling information has to be prepared for the decision-makers, and this leads to the consolidation and visualisation of the data which has been collected. Usually, dashboards with capabilities for drill down and roll up are used, which means that the information can be arranged according to each user’s requirements.

### 8.1.6 TYPES OF SENSORS FOR CONSTRUCTION CONTROLLING

There are various types of sensors, which can be applied to construction controlling. The devices can be categorised as position sensors, object sensors or imaging sensors (Figure 8.3):

**Fig. 8.3. Categories of Construction Controlling Sensors**

- **Position sensors:**
  Position sensors are used for the localisation and tracking of equipment, workers and material during construction related production and logistic processes, inside or outside construction sites. In this context, position is usually used as an indirect parameter. Based on the asset’s location or
motion profile, the construction process in progress can be detected in real time.

A variety of technologies are used to provide appropriate position information. On a case-by-case basis, the choice of system is determined by the environment and the required accuracy of the positioning. These factors, in turn, depend on the site conditions and the traced construction processes. For example, the Global Positioning System (GPS) can only be used outdoors, while other positioning systems based on technologies such as Ultra-Wide-Band (UWB), Wireless Local Area Network (WLAN) or Radio Frequency Identification (RFID) also function in an indoor environment.

- **Object sensors:**
  Object sensors are attached directly to specific equipment or construction components and collect object-based data during production processes. Innovative wireless technologies provide applicable solutions for the transfer of the collected sensor data. Requirements for transmission systems of this type include an appropriate wireless band, an appropriate wireless range, minimal power consumption and standardised interfaces.
  
  The data gathered may include various measurement results, such as oscillation, pressure or temperature. Object sensors, therefore, control quality aspects for the most part. However, information gathered can also be used to control the construction progress.

  At the moment, efforts are especially being made to collect data from formwork elements. Such devices can, for example, measure oscillation during concrete vibration, the pressure of green concrete during concreting or the temperature of concrete during hydration.

- **Imaging sensors:**
  Imaging sensors gather visual data on the complete construction site or special parts of it during all construction processes. These devices include, for example, photo, video and laser scanning technologies. In order to contextualise the collected data within the construction process, either the position of the sensor must be known or the picture content must be electronically evaluable. In the first case, an imaging sensor system can consist of a customary digital camera and an accurate positioning system. In the other case, pictures can be taken without a positioning system, although special software systems are required for the detection of the picture content.

  With both systems the data gathered from the imaging sensors can be transferred onto a 3D building model. For this purpose the images are superimposed onto the 3D model. Thus, when complementing the collected image data with process relevant information, such as time and
further attributes, a comprehensive model for construction controlling can be created.

8.1.7 PROSPECTS

The three device categories outlined above indicate that sensor systems will gain increasing acceptance in construction controlling. On the one hand, there is an immense demand for appropriate data collection technologies and, on the other hand, a constant improvement and price decline in sensor and evaluation systems can be observed.

A comparison with other industries indicates a lot of potential to increase the necessary process transparency of sensors. Thus, concepts of automated process monitoring will also greatly enhance construction controlling. The performance of appropriate production systems – especially on-site – will, therefore, benefit directly from the collected data.

The current efforts of construction companies demonstrate that the sector depends on automatic data collection systems to compile required data bases. At the moment, more and more equipment is provided with sensors for various purposes (e.g. earth moving equipment with GPS, formwork elements with RFID, etc.). In the future, sensor data will become a highly significant information source for construction control.

8.2 SIMULATION IN CONSTRUCTION MANAGEMENT

8.2.1 ADVANTAGES AND FIELDS OF APPLICATION IN THE CONSTRUCTION INDUSTRY

Simulating real world processes using computers is now not only applied in physics or mechanics, but also to the analysis and optimisation of processes in production and logistics. Computer science offers modelling techniques that make it possible to predict the execution of manufacturing processes under different boundary conditions.
The planning, monitoring and steering of construction processes is based on the performance and interaction of the resources employed. As shown below, simulation experiments can be used in various contexts.

![Diagram](image_url)

**Fig. 8.4. Use of simulation experiments in construction management**

When scheduling construction processes and planning the necessary resources, the often competing aims of quality, time and cost have to be taken into account. Normally, it is impossible to optimise this triangle towards an overall optimum and it is, therefore, helpful to compare a lot of possible solutions by simulating different scenarios. Another application of simulating construction sequences is the influence of uncertain boundary conditions, such as the weather, on the construction progress. This can provide the decision maker with data that can be used for risk analysis and risk management.

Data has to be generated in a timely manner if the control of construction projects is too successful, which means that efficient tools for predicting the target construction progress of given resources and boundary conditions are necessary. Only this can ensure the execution of target-performance-comparisons that keep up with the changing construction processes in a timely manner, so that prompt steering can be realised if necessary.

### 8.2.2 SIMULATION TECHNIQUES FOR CONSTRUCTION SEQUENCES

The VDI (German Engineers Association) defines simulation as the replication of a system with dynamic processes in an executable model that lends itself to
experiments, so that one can obtain insights which can be applied to reality. A model can be understood as a simplified representation of a real system and both model and real system consist of elements that are related to each other. Simulation models are used to forecast the behaviour of the real system under certain boundary conditions using simulation experiments.

![Real system and simulation model](image)

**Fig. 8.5. Real system and simulation model**

Generally, simulation techniques can be distinguished by three criteria. Firstly, continuous simulation models use real numbers that represent quantities along a continuum, while discrete models for simulation are based on integers, combinations or binary values, for example. Secondly, deterministic models can be differentiated from stochastic models that contain randomness. And thirdly, static, simulations that describe only certain states of a system are different to dynamic simulations, which are based on models that describe the systems behaviour due to changing boundary conditions.

Research in simulating construction sequences focuses on two simulation concepts, constraint-based simulation and agent-based simulation. Both use discrete and dynamic simulation models which can be designed in a deterministic or stochastic manner. The Critical Path Method, which is still used for scheduling, is a helpful tool for identifying critical processes but is not a simulation technique according to the definition given above, because experiments cannot be performed automatically.

The concept of agent-based simulation can be explained as a synthesis of the concepts of ‘simulation’ explained above and the concept of ‘agents’ in computer science. Franklin and Graesser define an autonomous software agent as a system that exists in and apart from its environment. Agents can perceive their environment and interact with it while fulfilling their own purposes. So that it can
reach its aims, an agent proactively makes rational decisions, acts proactively and reacts in a flexible way on changes in the environment. In computer science, agents are not singular entities but always part of a multi-agent system, which means that agents interact with each other and normally need the ability to communicate.

The agent-based simulation approach uses the multi-agent system as a pattern to formulate simulation models. These models consist of an environment representing time and space where passive objects and agents are situated. All objects, agents and the environment are given stated variables while the agents and environment have a behaviour specifying their activities. The following features ensure that multi-agent simulation is a good technique for the simulation of construction sequences:

- Individual workers and machines can be modelled as agents so that their individual performance can be taken into account;
- The complex interaction of workers and machines on construction sites including cooperation and conflicts can be represented;
- Multi-agent system can reproduce the complex decision making and action patterns depending on local and global boundary conditions; and,
- The agent-based modelling approach can represent inhomogeneous space such as a parcel with ways and barriers.

The constraint-based simulation approach often uses discrete-event simulation models. The discrete-event simulation represents a dynamic system through a chronological sequence of events. In a constraint-based model the events are connected by constraints that describe preconditions for the event to occur. Processes are carried out for the purposes of modelling construction sequences, which are normally connected with hard and soft constraints. The hard constraints must be fulfilled before the relevant construction process can be carried out, while soft constraints are appropriate dependencies that should be fulfilled whenever possible.

The constrained-based approach can represent different requirements and boundary conditions and a variety of possible solutions for the construction sequence can, therefore, be simulated and compared. Using discrete-event simulation has the advantage that existing commercial simulation environments can be adapted.
8.2.3 OBSTACLES TO THE APPLICATION OF SIMULATION IN THE CONSTRUCTION INDUSTRY

The potential of the simulation techniques that have been developed in computer science and are already used in the automotive industry and other industries has not yet used in construction management. Simulating construction sequences can improve the planning and controlling of processes on construction sites, but the tools and workflows of simulating processes are not meeting the needs of the construction industry. Moreover, most simulation experts are not aware of the differences between manufacturing processes on an assembly line and on a construction site.

In construction management each product is unique and the construction sequence must be newly defined for each construction process. Thus, in construction management, we deal with one-of-a-kind productions where the time for operations scheduling is tight. It is, therefore, necessary that experts in operations scheduling for construction projects can use the simulation of the construction sequence efficiently and without specific programming knowledge. The construction process models must be adaptable to new projects and their boundary conditions within hours or days.

8.2.4 A WORKFLOW MODEL FOR SIMULATION IN CONSTRUCTION MANAGEMENT

In order to overcome the obstacles for the use of simulation in the construction industry, the needs of construction management have to be taken into account. A workflow model for simulating construction sequences has been developed for this reason. It divides the simulation into two phases which can be carried out by different experts. The first phase is shown in Figure 8.6. and describes the modelling of the construction sequence in a multi-agent model including ergonomic insights. It is important that simulation experts base their work on work-scientific models that are established tools in construction management so that existing knowledge about construction processes is taken into account when creating the simulation model. Simultaneously, an ontology is developed to enable users and their software systems to communicate data and information about construction processes.
Fig. 8.6. First phase of the workflow for simulation in construction management

After finishing the first phase the simulation experts created a model of the construction sequence that can be used by domain experts from construction management to execute simulation experiments. These experiments are based on situations with different boundary conditions and provide data for the detailed operations scheduling and controlling of construction processes. It is thus possible to optimise the processes and analyse their risks as well as to monitor and steer construction processes in a timely manner. The necessary steps of this second phase and the data storage in ontologies are shown in Figure 8.7.

Fig. 8.7. Second phase of the workflow for simulation in construction management

Using the two-phase workflow model for simulation in construction management has shown positive results and proved to be an approach that can improve both
the effectiveness and efficiency of planning and controlling construction processes. Separating the modelling from the simulation experiments ensured the efficient use of simulation in construction management. Furthermore, the data from different scenarios increased the effectiveness of operations scheduling and controlling, by enabling the construction managers to compare the employment of different resources.

8.3 DIGITAL DOCUMENTATION OF CONSTRUCTION PROJECTS

8.3.1 PROCESSING OF CONSTRUCTION INFORMATION

The success of a construction project depends – especially during the realisation phase – on current information. To provide this information in a structured and accessible form, the respective construction information does not only have to be collected (8 SENSOR-AIDED CONSTRUCTION CONTROLLING), but also requires a comprehensive documentation process. This process includes the collection, organisation and use of appropriate data. Effective and efficient tools are needed for the corresponding tasks. Appropriate support can be provided by software systems for the digital processing of the construction information.

8.3.2 ASPECTS OF THE DOCUMENTATION OF CONSTRUCTION PROCESS INFORMATION

Information on construction processes during the realisation phase has various sources and recipients. All of them are more or less directly linked with the production process. Figure 8.8. shows a selection of major aspects for the documentation of construction process information.
First and foremost, the documentation of construction process information must ensure compliance with legal and contractual requirements. Additionally, this data can be used as the basis for preparing or defending claims, to give proof of particular quality standards and to support control and accounting processes. All of these purposes are affected by the availability and the verifiability of appropriate information. Thus, the complete construction process has to be retrospectively reproducible by non-participants.

The central and necessary instrument for the documentation of construction processes is the construction diary, because all reports concerning the building, progress and relevant events of the construction project are recorded in it. Therefore, it is a significant tool for construction supervisors, composes a major part of the construction files and is considered as evidence during construction disputes. Results of obstructions by missing construction drawings, incomplete work of pre-contractors, design modification or inadequate equipment, can be revealed exactly. Furthermore the construction diary also helps to clarify claims under warranty, or issues of occupational safety and health.

If the construction diary is being used appropriately, then it is essential that it documents the construction processes accurately and conclusively. Prompt recording can, therefore, ensure that distinctions are made between causes and effects, and, consequently, the documentation interval must be individually chosen according to the particular kind of construction work.
8.3.3 SOFTWARE TOOLS FOR DOCUMENTATION

Increasingly, software tools supersede conventional documentation methods on construction sites. Currently, various software companies provide appropriate software systems, which establish in construction supervision, and usually these tools represent a software version of the construction diary. Thus, information on construction processes is fed in, processed and stored digitally. The spectrum of applied computer methods ranges from predefined text documents, e.g. Microsoft Word templates, through to systems with complex functions and data structures. Compared with conventional documentation methods, even the advantages of basic software applications are significant for the documentation of construction processes:

- **Efficiency increases:**
  Paper files are expensive to create, store and exchange. In contrast, the storage, reproduction and transfer of digital data are considerably cheaper and faster. Thus, information can be continuously provided to several locations at the same time.

- **Search functionalities have greatly improved:**
  Digital documents can be searched for special terms and characteristics, while a paper file can only be searched according to its index. Thus, also huge data stocks remain clear.

- **Accuracy increases:**
  Software systems support the entering of data methodically by predefined forms, workflow rules and error control procedures. Thus, inaccurate data input is discovered immediately.

8.3.4 RANGE OF A DIGITAL DOCUMENTATION

Comparing software tools for the documentation of construction processes, it becomes apparent that the range of functions varies significantly. Differences can be seen regarding the contents of the documentation as well as regarding the software functionality.

Concerning the contents, at least the construction progress and use of resources have to be documented consistently. In addition, the project’s metadata, such as project name or contact information of project members, can be included. Further data usually depends on the exact kind of project. In fact, road work produces and requires the inclusion of different facts and events than the construction of a skyscraper.

Concerning functionality, software tools particularly provide diverging capabilities for the integration of additional resources and diverging capabilities
for data communication and data processing. Both aspects interact, as interfaces are necessary for integration as well as communication. The characteristics of individual functions, therefore, depend, for the most part, on the software technology which is applied. This chapter only concentrates on the connection of additional resources for digital documentation, while the communication aspects are discussed in chapter 8.4, Project Platforms.

*Figure 8.9.* shows a selection of major construction information which can form part of a digital documentation system.

**Fig. 8.9. Range of Digital Construction Documentation**

Individual aspects of a digital documentation will be described below. This information is partly recorded directly in a construction diary (metadata and daily site reports) and otherwise, only a link is provided (additional resources):

- **General project setup**: This universal project overview sets the exact parameters of the construction project and describes the project’s contractual and technological framework.
- **Contact information**: Project members, such as owners, contractors, public authorities, planners and suppliers are listed with the appropriate contact details.
- **Work in progress**: By documenting works carried out, as well as the start and end of individual works, discrepancies, e.g. insufficient work carried out by a pre-contractor, and measures, e.g. resumption of work on another component, can be revealed.
- **Responsible site engineer**: For a transparency regarding responsibilities, the names of site engineers and supervisors must be logged.
• Contractors on site: Record provides proof of attendant contractors, as well as appropriate records concerning the number and qualification of their employees.
• Supply: For the supply of construction components and material a check on quality may be necessary. If relevant, storage method and place have to be logged. Additionally, the date and time of a delivery can be used to prove the causes of a delay.
• Weather conditions: Weather conditions particularly influence outside works. Dependent on the construction materials applied, extreme temperatures have to be avoided. If necessary, special measures for weather protection should be logged.
• Special instructions: The documentation of special instructions is a proof for changes to the contract and for their legitimisation. Thus, it reduces risks for the site engineers, when a concretisation of construction works is necessary.
• Obstruction notices: Obstruction notices log a given cause of delay. They have to be documented in detail with all of the relevant facts for a subsequent evaluation.
• Visitors: Visits on the construction site have to be documented for insurance reasons. In particular, instructions and safety equipment should be logged.
• Photo documentation: Photo documentation can often record relevant facts more comprehensively than text and it, therefore, increases the cogency of proof.
• Minutes of construction meeting: Minutes provide a central log for the construction communication. Information access and discussion agreements can be accessed by all.
• Construction schedules: The schedules supplement actual data with plan information, which facilitates the comparison of actual and desired performance.
• Drawing lists: Drawing lists log drawing receipts and approvals. Delays caused by missing drawings can be evaluated on this basis.
• Material test results: Results of mandatory quality tests concerning water, soil and building materials prove compliant supervision by site engineers.
• Acceptance protocols: In combination with a list of remaining works, the documentation of acceptance gives a summary of completed works and necessary modifications.
• Delivery notes: Delivery notes support the documentation of material quality and delivery date.
Depending on the kind of construction work involved, specific aspects can be added or omitted. For special events, such as accidents, a separate category should be set up.

### 8.3.5 Principal Requirements of Digital Documentation

Software tools for the digital documentation of construction processes have to fulfil various requirements to support the construction team efficiently. Above all, workflow capabilities, cogency of proof and interface technologies determine the value of such an instrument.

- **Workflow:**
  Software tools for the documentation of construction processes can optimise the workflow of supervisors and site engineers. In order to fulfil this purpose, the software has to guide, support and automate documentation processes as far as possible. The basic functionality of a digital documentation instrument, therefore, consists of efficient capabilities for the software-aided entry, modification and display of data. This includes automatic error detection, search functionalities and report components. In this way, aggregated and systematically structured information can be distributed automatically to relevant project members. Only such a condensed report, generated according to specific documentation procedures, can efficiently support the decision-making process.

- **Cogency of Proof:**
  First and foremost, the purpose of an information collection is the conclusive and reliable documentation of the entire construction process, which means that the cogency of proof must be ensured without printing and signing every single document. Thus, the appropriate data has to be digitally stored in an audit-proof way. The unauthorised entering, manipulating or deletion of data has to be prevented by the system. For this purpose, digital signatures and timestamps, as well as appropriate data formats have to be applied. An optimal preservation of evidence can also be reached by systems for version control, through which, the old version of the data basis is archived every time it is modified. As a consequence, manipulations can be revealed easily and old versions of the data basis can be restored quickly.

- **Interfaces:**
  The significance of concatenation depends on the documentation’s range of content. The more data that is needed for the documentation of the construction processes, the more interfaces will be necessary. On the one
hand, the documentation tools process data, which can be used by other applications and, on the other hand, the documentation also requires data which is available from other sources (schedule, material test results, delivery notes etc.). However, multiple entries of the same information into several software systems must be avoided, as unnecessary work is done and an inconsistent data basis is created.

For the comprehensive digital documentation of construction processes, tools therefore need to have appropriate interfaces. Export and import functions must provide a basis for an exchange of data between different project members and different software tools.

8.3.6 TECHNOLOGIES FOR DOCUMENTATION SOFTWARE

Software tools for the digital documentation of construction process information can be implemented in several software architectures. Figure 8.10. shows the three major alternatives.

Fig. 8.10. Software Architectures for Documentation Systems

The distinguishing characteristic here is the kind of network the software system is working in. Subsequently, the three variants will presently be described:

- Offline Software:
  Offline tools are not connected to a network. Those documentation systems run on single computers and can, therefore, be implemented and
maintained easily. Yet, an exchange of information with other project members is only possible by an export and import of data. Such a local installation is, therefore, mostly used in small construction projects with few project members.

- **Client-Server Software:**
  Tools with a client-server architecture have their data basis on a central server. Yet, the local computer (client) also needs the software required to access this data basis. A piece of multi-user software can thus be applied and every user has the same data basis. Data modification by one user will, therefore, be seen by all the other users immediately. This system is often used in large-scale projects. It can be easily implemented with standard software, such as Microsoft Access, but every change made to the software will result in a necessary update of each client computer.

- **Web-based Software:**
  Web-based tools run their programmes in a browser environment and communicate over the internet with a central server. Thus, users can use their computer without any further software installation. Appropriate systems have advantages especially for wide-spread project teams. The implementation of such systems is sophisticated, but maintenance is easier to carry out. As a result, web-based tools are usually provided by central software companies or within large construction companies.

The short description of the three alternatives points out that each variant has its advantages and disadvantages. For this reason, the choice of a system usually depends on the project volume and the number of project members. Thus, the specific project conditions determine the optimal technology for the documentation system.

### 8.3.7 PROSPECTS

Software tools for the documentation of construction processes are absolutely essential instrument on construction sites, as they provide a central and digital data basis. These benefits optimise methods and use of construction documentation. The application of small devices, such as handheld computers or smart phones, in combination with client-server or web-based systems, in particular, has a tremendous potential.
8.4 PROJECT PLATFORMS

8.4.1 CONSTRUCTION PROJECT ORGANISATION

The construction project organisation is characterised by the uniqueness of its conditions. Working together for only a short period, the heterogeneous project members must succeed in planning and executing the corresponding processes by dividing labour and responsibilities. As a result, the organisation’s structures and workflows are influenced by various complex interfaces. Owners, designers, contractors, public authorities and other relevant parties have to exchange a vast amount of information and make decisions in the context of diverse project positions and diverse project phases.

In most cases, a formal and an informal project organisation can be observed. The formal organisation is well-defined by rules of intra-organisational procedures and structures, while the informal organisation complements these regulations by various dynamic and practical interfaces. Formal structures and procedures depend on the specific contract and are usually created for routine situations. Thus, they are sometimes not able to react appropriately to specific, unexpected construction problems. An informal organisation, therefore, supports the regulated interfaces.

*Figure 8.11.* shows the network of formal and informal connections as recorded during a small construction project. In this project, various informal connections compensate for an obvious bottleneck generated by an overcharged general contractor. On the one hand, information can indeed be passed to the recipient directly through these informal connections. Yet, on the other hand, as an informal exchange of information is often not filed properly, other project members may miss relevant information.
8.4.2 ORGANISATIONAL ASPECTS

Within communication, coordination and cooperation, there are three major organisational aspects, which greatly influence the effectiveness of project organisation. Due to the organisational complexity of construction projects, ensuring that these aspects are put in place is difficult on the one hand, but, on the other hand, an essential requirement:

- Communication can be defined as the collective term for all processes involved in the exchange of signs between and within technical and social systems. Thus, communication represents a foundation for all interaction. It is needed to convey information about necessary input and output of processes.
Coordination can be defined as the collective term for all processes involved in the alignment and allocation of technical or social procedures. Within the complexity of a construction project organisation this aspect is required for an effective division of labour and responsibilities. However, coordination can only be achieved by communication.

Cooperation, as the last stage, can be seen as a combined, target-oriented implementation of several technical or social systems and thus provides a basis for team-work and allows joint efforts to take place. For the cooperation of several systems to be effective, communication, as well as, coordination is needed.

The significance of communication, coordination and cooperation is apparent within all the objectives of a construction project. Without appropriate processes, required information cannot be passed to the respective project members, the project members’ activities cannot be synchronized and cooperation will not be possible. As a consequence, schedule, quality and cost targets will also be missed.

*Figure 8.12.* demonstrates the significance of communication using the example of construction quality. More than 11% of all construction defects could be prevented by appropriate communication within the construction project.

![Fig. 8.12. Causes of Construction Defects (adapted Godehart et al. 1995)](image)

**8.4.3 SUPPORT OF COMPUTER SYSTEMS**

The complexity of construction project organisations has to be controlled by instruments to ensure communication, coordination and cooperation within the
project. Computer systems can support appropriate organisational processes perfectly because of their properties:

- **Connection of various devices by networks:**
  Computer systems are able to connect various devices by networks, thus enabling all members of a project team to be integrated into a specific system.

- **Methods for a digital exchange of data:**
  Computer systems possess methods for a digital transfer of data, which means that all information, which has to be exchanged, can be transferred by a specific system.

- **Methods for a digital storage of data:**
  Computer systems possess the means for the digital storage of data. Thus, all information, which has to be accessible by project members later, can be stored centrally by a specific system.

- **Concatenation of information:**
  Computer systems need concatenated data for processing. Thus, all information, which is entered by the project members into a specific system, can be accessed in a structured way.

In conclusion, computer systems are able to integrate project members, as well as exchange, store and to structure information from project organisation due to their technical properties. This results in the establishment of a strong basis for the development of effective organisational project instruments. Appropriate, network-based tools, which support communication, coordination and cooperation within a project, are referred to as “Project Platforms” (*Figure 8.13.*).

---

**Fig. 8.13. Objectives of a Project Platform**
8.4.4 FUNCTIONS OF A PROJECT PLATFORM

Software tools for the support of construction project organisations vary significantly in terms of their range of functions. A short overview of the most common systems is given below:

- **Mapping of Project Organisation:**
  Project platforms map the structures and processes of the construction project organisation through formal and informal interfaces. As a basis, organisational charts and normative procedures, including responsibilities and tasks, should be accessible by every project member. Additionally, appropriate communication channels have to be provided by the system. In this way, the information exchanged is recorded and can be displayed to other project members involved in the specific process. Potential implementations include chat rooms or forum areas with user account controls.

- **Document Management:**
  Project platforms require comprehensive functions for document management. This includes the structured storage, processing and distribution of all construction documents (construction drawings, schedules, protocols, correspondence, etc.) which will preferably be format independent. The storage of all documents should be possible on a central server. Appropriate methods have to be independent from the operating system and accessible by various devices. For processing, the software must provide search and index methods. Documents, therefore, have to be connectable if navigation within the system is to be improved. Additionally, an automated archiving of documents saves resources and guarantees clarity. Finally, fast download methods are required for the distribution of the documents. Associated mailing lists and access privileges must be generated according to the predefined roles of the project members.

- **Workflow Management:**
  Project platforms provide automated methods for workflow management. All processes can be planned according to tasks, responsibilities and schedules on the systems’ central server. These predefined or ad hoc-generated workflows are used to guide and control communication, coordination and cooperation processes, thus, for example, the preparation and clearance of construction drawings can be mapped exactly. Sequence and processing time are specified in the system. Subsequently, automated monitoring and controlling can be performed by the system. Start and end times, as well as processors and communication channels, are logged. In the case of deviations from a desired workflow,
participating processors are warned. Within such a workflow system, the level of information accessible to each project member can be controlled and checked during the entire project.

Fig. 8.14. Functions of a Project Platform

8.4.5 REQUIREMENTS FOR A PROJECT PLATFORM

Requirements for project platforms mainly concern contractual, legal and technological aspects, which mean that most requirements depend on the project platforms’ varying range of functions. Only some aspects can, therefore, be outlined in this manual:

- **Data Protection:**
  Project platforms must have high security standards to avoid unauthorised access to project data by inter- or intranet attackers.

- **Data Safety:**
  Project platforms require technological backup-systems to provide data which is lost due to manipulations, malfunctions or damages.

- **Audit-proof Processing:**
  Information processed on project platforms must be kept audit-proof to ensure cogency. Appropriate technologies are described in chapter 8.3, Digital Documentation of Construction Projects.

- **Interfaces:**
  Data exchange methods and formats have to be adapted to the project’s requirements. Thus, interfaces are determined by the software products used in the project (CAAD, Scheduling, etc.) and the devices used (laptop, PDA, etc.).
• Modularity:
Functional requirements will change depending on the type of project, which means that modularity is considered useful. As a result, other software, such as special software for digital documentation, project management or project controlling, can also be integrated in modular ways.

• Reusability:
Project Platform systems can only be applied efficiently, if the reusability of recorded data, as well as of the system itself, is possible. Thus, data structure, data formats and the software components must be implemented adaptably.

8.4.6 PROSPECTS

Project platforms have been introduced to the construction market for the management of design documents and workflows. Today, more and more systems are also applied in the construction phase. The aim is the continuous use of one system for communication, coordination and cooperation during all project phases, which would result in the transfer of information between several project phases. For example, data from the design phase of project could also easily be within construction or facility management.

Additionally, in future more functions will be integrated into project platforms. With the help of appropriate interfaces, project platforms can constitute a basis for most construction applications in this development. Software tools for tasks, such as documentation and controlling, will, therefore, provide the project team with additional functions. A project platform will become an integrative platform where various applications can be easily integrated modularly.

In conclusion, the significance of project platforms will increase through an integration of further project phases and software tools. In doing so, the platforms will finally consolidate future construction project organisations to a greater and greater extent. The efficiency of construction projects will benefit directly as a result of this development.
CHAPTER 9

BIM

(F. BINDER)

9.1 BIM TECHNOLOGY

9.1.1 PRINCIPLES OF BIM

A Building Information Model (BIM) is a product model of a building, containing all information regarding the building’s design and the processes during the complete lifecycle. In this way the model acts as an intelligent data source to store information for all disciplines involved. It is built up, maintained and used by key players such as owners, architects, engineers, contractors, surveyors, product manufacturers and public authorities.

By pulling all this information together, BIM supports a better understanding of the project, drives collaboration from the earliest stages and provides the basis for new construction capabilities and changes in the roles and relationships among a project team. It enables various applications, such as accessing information on the properties of materials, visualising design processes, estimating cost consequences of modifications, verification of HVAC / MEP installations and a planning of the facility management even before the project is completed. In optimum form a Building Information Model offers access to all calculations and checks for legislation, norms, cost, schedule and performance.

Regarding the software technology, a BIM consists of two major components. On the one hand a three dimensional, digital representation of the building’s geometry visualises the structure and the design; on the other hand a relational database stores all data, properties, relations and performances. As database and geometry objects are linked, all information stored can be referred to specific building components in the 3D visualisation (Figure 9.1.).
As a consequence of this data structure, the computer-generated building model is characterised by building components that are represented by intelligent, digital objects. Each building component can, therefore, be associated with computable graphics, attributes and parametric rules. The appropriate data describes how objects within the building model behave and this information is needed for analyses and work processes, such as quantity take-off, specification and energy analysis. Furthermore, the database system keeps all data consistent and non-redundant within the BIM. In this way, changes to component data can be represented and coordinated in all views of the model.

**9.1.2 BENEFITS OF BIM**

BIM provides a virtual information model, which can be accessed by all key players during the life cycle of a building, each adding their own additional discipline-specific knowledge and each able to track changes to the single model. The result is a large reduction in the information loss that occurs when trying to share extensive building information among project partners, or between different project stages (Figure 9.2.).
Using a BIM therefore provides more efficiency throughout the entire building lifecycle. It enhances collaboration and professionalises the construction process. Having all the information available, project members can plan their processes faster and more accurately. Thus significant advantages for all project members can be achieved:

- **Owner:**
  An overall impression of the project concepts and objectives can be communicated from the early design stage from the owner to all project members. Visualisations thereby provide an improved understanding and support the decision-making process. Miscommunication is dramatically reduced and the impact of design revisions can be presented extensively. Thus, all project members have a realistic view of the end product and can influence it throughout the process. Improved budgeting and cost estimating capabilities ensure that the project costs at each phase are transparent for the owner.

- **Design Team:**
  Using a single model the BIM workflow greatly supports collaboration within the design team. It creates a consistent set of standards that can be used project-wide by all stakeholders. The cycle time of specific workflows can, consequently, be reduced. In addition, BIM instruments, such as simulation tools or clash detection, help the design team to deliver a sustainable end product. Conflicts are discovered early and the system can inform team members about necessary changes as they arise.

**Fig. 9.2. BIM Dimensions**
• **Contractors:**
  Contractors benefit from an improved tender process early on, as the BIM simplifies procurement by clarifying intended outputs. Cost predictability and subcontracting opportunities are enhanced. Furthermore, the model can be a basis for the constructor’s site and construction process planning. During the construction phase, BIM reduces errors and omissions in construction documents, reduces modifications and improves coordination and communication within the project. It can also be used to control and document the construction schedule, costs and progress.

• **Authorities:**
  BIM enables authorities to check normative requirements directly within the model, which means that the approval process is simplified and accelerated. Communication with the design team can be improved.

• **Manufacturers:**
  Building components can be ordered and manufactured according to the BIM’s specifications. In this way, manufacturers are integrated into the construction process more directly.

• **Facility Managers:**
  Facility management requirements and processes are involved in the early design process by BIM technology to optimise the building appropriately. During the operation phase the BIM can then be used as building documentation and basis for operational planning and control processes. Analytical methods using BIM support the facility management by automatically checking the data with respect to legislation, norms, energy, environmental impact and sustainability. The BIM can so be used to gauge the effective replacement and adaptability of assets to meet new requirements or legislation.

### 9.1.3 WORKING WITH BIM

BIM constitutes an enormous change for all participants in a building’s lifecycle. On the one hand, it enhances professionalism and collaboration. On the other hand, it requires a significant workflow modification for most stakeholders. Role patterns and job functionality, as well as communication methods, change. All parties need the resolve to share information openly in order to work towards a common goal and, consequently, work processes become more transparent and communal.

Managing the necessary new workflows is one of the most challenging tasks which project leaders face when working with BIM. Different modelling tools and processes have to be integrated and model ownership and responsibilities
have to be clarified. It is, therefore, important that the BIM is updated constantly and maintained throughout the construction process in order to create an “as built” model of the building. As a consequence, a BIM is best stored on a special model server. All stakeholders on the project are given access to either read or write data and enrich the shared model. By these means, the model server can be overseen by a dedicated BIM manager who has an exact overview of what was modified when and by whom.

Precise procedures for working with BIM depend on project size, software tools applied and the BIM qualification of the team members. Tasks, therefore, change according to the project and lifecycle phase of the building. A short overview is given below:

- **The conceptual and preparation phase:**
  Owner, consultants and designers have to link and visualise the project’s objectives and ideas in a BIM to allow a project’s feasibility become transparent. Furthermore, a project organisation with detailed BIM workflows, standards, requirements and responsibilities has to be agreed on. The benefit of implementing BIM at this stage is principally the fact that it allows for the establishment of customers’ wishes and demands early on for all project members.

- **Design phase:**
  Based on the conceptual and preparation phase, the BIM is enriched by design, structure and installations by all team members, all of which is completely within a 3D model. Today a 2D drawing or floor drawing is still a valued part of the construction process, but will be harvested from the model as will all the other information. Related data such as cost, schedule and tender information has to be linked with the model. The feasibility of future construction and operation processes has to be verified with appropriate BIM simulations. The model can thus support the communication between owner, designers and contractors about effective solutions and new proposals.

- **Construction phase:**
  The comprehensive reproduction of complex construction processes requires the integration of information from several areas, such as design, work preparation and controlling. The enrichment of the BIM with all kinds of information creates a data source that can be tapped to provide better and more consistent management processes. All stakeholders in the construction process can, therefore, anticipate the effect of changes and optimise their services accordingly.

- **Operational phase:**
  When the construction phase ends an “as built” BIM has to be handed over to the owner or operator. The model can then be integrated into the
management system and used to plan and control maintenance as well as operation conditions of systems, such as heating and ventilation. Furthermore, the facility manager can rely on information from the BIM to design changes, when renovation or replacements are required. No re-measuring is needed and information on construction parts is readily available for re-order and replacement.

- Re-use or demolition phase:
  For revitalisation, modification or demolition projects BIM will be an excellent data basis, when kept up to date during the whole lifecycle of a building. The information must be provided as BIM by owners and facility manager to allow a responsible, fast and cost effective re-use or demolition to take place. In this way, BIM will support sustainability concepts and ensure the re-use of buildings, structures or materials.

9.1.4 TRENDS OF BIM

BIM results from 30 years of development in the area of construction design software. Computer Aided Architectural Design (CAAD, chapter 0) has been used in the construction industry since the 1970s. These 2D drawing programmes were refined according to object-based parametric tools and later to 2D modelling tools in the 1980s. The term “Building Information Modelling” was first used by Robert Aish in 1986 to describe the benefits and technology of building modelling combined with relational databases. With the improved processing power of the PCs, 3D modelling software was finally launched in the 1990s. Today, nearly all CAAD vendors provide 3D systems which focus on supporting and delivering BIM applications. The application of BIM tools will therefore, as has been pointed out, increasingly change design, construction and management processes. Working with BIM will define the role of each project member throughout the building’s life cycle in a new way. Everyone will be able to take advantage of a BIM by being able to access the relevant information directly from the model.

Software publishers, as well as national and international organisations, such as “buildingSMART”, develop and maintain standards for BIM. This is an ongoing venture, but the rapid pace of new developments, the international implementation of standards and the increasing application of appropriate technologies all indicate that BIM is one of the future core technologies in construction software.
9.2 BIM CAD TOOLS

9.2.1 DESCRIPTION OF BIM CAD TOOLS

Today, a large number of software tools exist for generating and working with BIM models, which enables 3D BIM CAD systems to provide a basis for all other applications, such as analysis software, BIM portals and model servers. BIM CAD tools create the three dimensional model with database background, which can later be extended, analysed or integrated by other BIM applications. These model-dependent BIM applications, for example RIB iTWO (see chapter 5.5), can also add further dimensions to the model, such as specifications, cost or schedule. The BIM objects, consequently, are fitted with additional alphanumeric qualities.

The BIM chapter in this manual concentrates subsequently on BIM CAD systems, as they form a basis for the BIM technology. Basic functions of BIM CAD software include drawing capabilities, development of custom parametric objects, an early and accurate visualisation, automatic low-level corrections as well as opportunities for an early collaboration of multiple design disciplines. The system, therefore, has to meet constructive standards, ensure clear user interfaces and, most importantly, support interoperability.

The basis for interoperability is provided by the Industry Foundation Classes (IFC, see chapter 3.2). This open standard ensures data exchange between various applications and stakeholders’ software platforms. Supporting the IFC standard reduces the risk of miscommunication on BIM projects and opens up the data for everyone to share.

9.2.2 SELECTION OF BIM CAD TOOLS

- Allplan (Nemetschek, Version 2011)
  The Allplan product family offers a consistent choice of BIM products for the construction industry. A BIM created with Allplan can be used in various Allplan software solutions, which cover, among others, concrete, steel and prefabricated component structures as well as HVAC design and cost, tender or facility management. With the “Design2Cost” cost estimation method the virtual building model is used for quantity take-off, subsequent cost estimation and generating quotes, or for contract specifications and subsequent invoicing.
Allplan supports 2D and 3D design while constantly keeping an eye on the model. Interactive design control to numerous layout and design tools through to high-end rendering allow for complex constructions. The system provides extensive object libraries which also contain information on drawing and visualisation standards. Modifications are accessible to all, thus reducing the risks of error are reduced.

An interdisciplinary collaboration with smooth and flexible communication among design partners is ensured by an Allplan Workgroup Manager. It facilitates the central administration of projects and standards. The team always works on one and the same data model. Due to an easy to handle rights management, it can be accessed from all Allplan work stations in the office.

Allplan supports more than fifty file formats, including PDF, IFC, DWG and DXF.

• ArchiCAD (Graphisoft, Version 14)
  ArchiCAD is the oldest continuously marketed BIM architectural design tool available today and the only object-model-oriented architectural CAD system running on a Mac platform. It supports a 64-bit architecture on both Windows and Macintosh. Interfaces to Google SketchUp or ArchiFM ensure a BIM-usability throughout the lifecycle of a building. The BIM system has comprehensive design capabilities including the integration of personalized 3D tools and special modelling tools. From the central database of the 3D model data, all the information needed to complete architectural and structural designs -sections and elevations, details, bills of quantities, schedules, renderings, animations and virtual reality scenes- can be extracted. The virtual building approach also allows for changes at any time, while automatically maintaining the integrity of the documents.

ArchiCAD supports the design collaboration between architects and engineers through a Graphisoft BIM server. The server decreases network traffic, allowing team members to work together on BIM models in real time. The same technology makes BIM projects accessible through standard internet connections from anywhere in the world. Specific management tools for project leaders and BIM managers thereby allow for customised user roles and project accesses, which help to control and coordinate large projects. An effective workflow is ensured by model-based version tracking, which allows users to compare IFC model versions, to only import differences and to display design changes with colour codes in the architectural model context. The same feature allows team members to identify changes in the different versions of the
exported BIM, and, in this way, coordination errors can be greatly reduced. ArchiCAD supports a large number of file formats including PDF, IFC, DWG and DGN.

- Bentley Architecture (Bentley, Version V8i)
  Bentley Architecture has been on the market since 2004. The system integrates a broad range of building modelling tools, such as Bentley Structural, Bentley Building Mechanical Systems, Bentley Building Electrical Systems, Bentley Facilities, Bentley Power Civil and Bentley Generative Components.
  The BIM tool shares a common graphics platform with over 200 Bentley applications, which allows them to work together. All models can be created and manipulated in a traditional 2D drawing or an advanced 3D model environment – using the same tools and interface for both. With a full range of advanced solids modelling tools, the creation of virtually any form is possible. In doing so, all building components are kept parametric, allowing dimension-driven creation and modification. Furthermore, the software supports the definition of rules to capture design intent, dimensional constraints and assembly relationships.
  The workflow is completely supported by Bentley Architecture. This includes conceptual design to construction documentation and integrates design, visualisation, drawing production, as well as reporting of quantities and cost. User-definable properties associated with building components are used to query the Building Information Model, to make selective or global changes to the geometry and non-graphical information and to generate accurate quantity and cost reports, schedules and specifications. Using dynamic views, Bentley Architecture automatically coordinates architectural design and construction documentation through all project phases.
  For interoperability, Bentley Architecture can be integrated on a single platform with a collaboration server that manages access to project information across a company network or through the Internet. The server synchronises shared information and can ensure an effective change management.
  Bentley Architecture supports major standards such as PDF, IFC, DGN, DWG and VRML.

- Revit (Autodesk, Version 2011):
  Revit, introduced by Autodesk in 2002, is the market leader for BIM CAD software. The product suite includes Revit Architecture, Revit Structure and Revit MEP. All tools provide native 64-bit support for Microsoft Windows.
The design tools of Revit allow photorealistic realisation of architectural ideas. An excellent object library, appropriate detailing tools, bidirectional drawing support and a well-organised user interface ensure effective model creation in 2D and 3D views. Furthermore, customised detail libraries can be created, shared and tailored to better accommodate specific office standards.

In Revit, all model information is stored in a single database. Thus, as the project develops and evolves, changes can automatically be coordinated. Revisions and alterations to information are updated throughout the model, minimizing errors and omissions. A special interface check scans the model for collisions between elements. Additional tools, such as a calculation of detailed material quantities with material take-off, room volumes for conceptual energy analysis and cost estimation, complete the building information model.

Collaboration within project teams is ensured by a model server, which can share Revit models across wide area networks. The server helps to manage multi-user access and is needed to integrate collections of Revit central models.

Autodesk Revit supports major standards including PDF, IFC, DWG, DWF, gbXML and DXF.
CHAPTER 10

LITERATURE


improving the quality and efficiency of UK construction. DEPARTMENT OF TRADE AND INDUSTRY, ed. London


Chosen legal regulations


Chosen websites

1. www.archibus.com
2. www.centerstonesoft.com
3. www.cafmexplorer.com
4. www.sap.com
5. www.isa.com.pl
6. www.granit-software.pl
7. www.mieszczanin.pl
9. www.2plus2.pl/ada.html
10. www.honeywell.com/sites/pl/
12. hicron.com/sap_re